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About These EnterpriseOne PeopleBooks 
Preface 

EnterpriseOne PeopleBooks provide you with the information that you need to implement and use 
PeopleSoft EnterpriseOne applications. 

This preface discusses: 

• EnterpriseOne application prerequisites 

• Obtaining documentation updates 

• Typographical elements and visual cues 

• Comments and suggestions 

Note 

EnterpriseOne PeopleBooks document only fields that require additional explanation. If a field is not 
documented with the process or task in which it is used, then either it requires no additional 
explanation or it is documented with common elements for the section, chapter, PeopleBook, or 
product line.  

 

EnterpriseOne Application Prerequisites 
To benefit fully from the information that is covered in these books, you should have a basic 
understanding of how to use EnterpriseOne applications.  

See the Foundation Guide.  

You might also want to complete at least one EnterpriseOne introductory training course. 

You should be familiar with navigating the system and adding, updating, and deleting information by 
using EnterpriseOne menus and forms. You should also be comfortable using the World Wide Web 
and the Microsoft Windows or Windows NT graphical user interface. 

These books do not review navigation and other basics. They present the information that you need to 
use the system and implement your EnterpriseOne applications most effectively.  

Obtaining Documentation Updates 
You can find updates and additional documentation for this release, as well as previous releases, on 
the PeopleSoft Customer Connection Website. Through the Documentation section of PeopleSoft 
Customer Connection, you can download files to add to your PeopleBook Library. You can find a 
variety of useful and timely materials, including updates to the full PeopleSoft documentation that is 
delivered on your PeopleBooks CD-ROM. 
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Note 

Before you upgrade, you must check PeopleSoft Customer Connection for updates to the upgrade 
instructions. PeopleSoft continually posts updates as the upgrade process is refined. 

 

See Also 
PeopleSoft Customer Connection Website, http://www.peoplesoft.com/corp/en/login.jsp  

Typographical Conventions and Visual Cues 
This section discusses: 

• Typographical conventions 

• Visual cues 

Typographical Conventions 
The following table contains the typographical conventions that are used in EnterpriseOne 
PeopleBooks: 

Typographical Convention 
or Visual Cue 

Description 

Italics Indicates emphasis, topic titles, and titles of PeopleSoft or other 
book-length publications. Also used in code to indicate variable 
values.  

Key+Key A plus sign (+) between keys means that you must hold down the 
first key while you press the second key. For example, Alt+W 
means hold down the Alt key while you press W. 

Monospace font Indicates a PeopleCode program or other code example. 

“ ” (quotation marks) Indicates an adjective that is used in a way that might not be 
readily understood without the quotation marks, for example "as 
of" date, “as if” currency, "from" date, and "thru" date. 

Cross-references EnterpriseOne PeopleBooks provide cross-references either below 
the heading “See Also” or preceded by the word See. Cross-
references lead to other documentation that is pertinent to the 
immediately preceding documentation. 
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Visual Cues 
EnterpriseOne PeopleBooks contain the following visual cues:  

• Notes 

• Cautions 

Notes  
Notes indicate information that you should pay particular attention to as you work with the 
PeopleSoft system. 

Note 

Example of a note. 

 

Cautions  
Text that is preceded by Caution is crucial and includes information that concerns what you must do 
for the system to function properly. 

Caution 

Example of a caution. 

 

Comments and Suggestions 
Your comments are important to us. We encourage you to tell us what you like, or what you would 
like to see changed about PeopleBooks and other PeopleSoft reference and training materials. Please 
send your suggestions to: 

PeopleSoft Product Documentation Manager, PeopleSoft Inc., 4460 Hacienda Drive, Pleasanton CA 
94588 

Or you can send e-mail comments to doc@peoplesoft.com. 

While we cannot guarantee an answer to every e-mail message, we will pay careful attention to your 
comments and suggestions. 
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PeopleSoft Software Overview 

PeopleSoft software provides a flexible, configurable solution in the face of constantly changing 
technology and enterprise practices. PeopleSoft software is the first network-centric software that 
separates business rules from the underlying technology. As new technologies emerge, PeopleSoft 
software allows you to easily add them to the framework of your enterprise. 

PeopleSoft Software Features  
PeopleSoft software offers the following features:  

• Multiplatform computing. PeopleSoft software has the ability to run on different platforms. 
This versatility allows for easy maintenance of information across a network.  

• Integrated supply chain. PeopleSoft software provides the ability to use the Internet and an 
intranet to allow you to communicate and share information with your employees, customers, 
and suppliers.  

• Interoperability. PeopleSoft software lets you leverage your existing investments in hardware, 
databases, and software, and integrate them with legacy and third-party products.  

• Adaptability. PeopleSoft software adapts easily to different languages, currencies, reporting 
provisions, and technology standards.  

• Usability. PeopleSoft software lets you point and click, drag and drop, and use fill-in-the-
blank forms to easily complete your tasks. 

System Integration  
PeopleSoft software combines enterprise applications with an integrated toolset to tailor those 
applications to the needs of your business.  

EnterpriseOne refers to each group of its software products as an application suite. The application 
suites support manufacturing, financials, distribution or logistics, and human resource operations for 
multisite and multinational organizations. Your business needs determine what application suites are 
installed for your enterprise system. For complex business situations, you might use several 
application suites to achieve a comprehensive solution.  

Each application suite is made up of systems. For example, the Financial Suite contains systems such 
as Enhanced Accounts Receivable, system 03B; Accounts Payable, system 04; General Accounting, 
system 09; Fixed Assets, system 12; and others. Each system consists of applications, forms, reports, 
and database tables that are designed to handle specific business needs. 

Because the functions and features of all the systems are similar and integrated, you are not 
necessarily aware of moving from one system to another when working with various applications. 
The following illustration shows data and logic that is shared among applications such as Sales Order 
Detail File, Customer Ledger, and Account Ledger. The illustration shows how a sales order entry 
application shares customer data, such as balances and total order amounts, with an accounts 
receivable (A/R) application. As orders are taken, the sales order application passes the information to 
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the A/R application, which then posts the entries to the general ledger. Also, the order entry 
application can request credit checks from the A/R application.  

 

 

This guide often refers to Address Book, system 01, to illustrate the foundational concepts of 
PeopleSoft software. Address Book, an online version of a traditional card file, is a database of 
names, addresses, and phone numbers that:  

• Provides easy access to all addresses for searching and reporting purposes  

• Reduces the need for duplication of records  

• Provides security through Business Unit assignment or Search Type authorization  

• Interfaces with other PeopleSoft software systems  

Because it is fundamental to business solutions, Address Book provides a realistic subject for learning 
the foundational concepts of EnterpriseOne software. Many of the tasks that you perform use Address 
Book examples. 
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Address Book (AB) interfaces include, but are not limited to, the following systems:  

 

 

See Also 
� EnterpriseOne Software Systems in the Foundation Guide for a list of systems and their 

associated codes 

Foundation Overview 
The Foundation Guide introduces you to the integrated environment of EnterpriseOne. Through 
overviews, illustrations, procedures, and examples, Foundation describes the operations and functions 
that are common to all applications. Foundation comprises the following topics:  

EnterpriseOne Access  Learn about the different applications that can be used as an entry point 
for accessing EnterpriseOne tools and applications.  

Application User 
Interface  

Learn about the operating environment, including menus, forms, and the 
grid.  

User Overrides  Learn to change the appearance of an application to fit your business 
needs.  

Records  Learn how to locate, add, and work with database records, add objects, 
and format and move around on a record-entry form.  
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Messages and Queues  Learn to use Work Center to send, receive, and work with messages 
from EnterpriseOne users and recipients outside of the EnterpriseOne 
software environment.  

Media Object 
Attachments  

Learn how to attach objects (text, images, OLE objects, and 
EnterpriseOne shortcuts) to rows and forms.  

MailMerge Workbench  Learn about merging EnterpriseOne system records with third-party 
word processing documents for automatic creation of form letters by 
using certain application workflows.  

Interactive Versions for 
Applications  

Learn to modify the behavior of applications through changes to 
processing options and interactive version detail.  

Batch Versions for 
Reports  

Learn how to create, modify, and print your own report versions.  

Processing Options  Learn key functions, types, and how to access and use processing 
options.  

User Defined Codes  Learn how to tailor valid values for a field to meet your business needs. 

Configurable Network 
Computing Foundation  

Learn key concepts and fundamentals about the technical architecture 
that makes EnterpriseOne possible.  
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EnterpriseOne Access  

EnterpriseOne supports Windows client and Web client users through the Solution Explorer and 
PeopleSoft Web Client. Solution Explorer is the Windows-based explorer that provides the ability to 
navigate menus and launch Windows versions of EnterpriseOne. PeopleSoft Web Client is an HTML-
based menu system that provides the ability to navigate EnterpriseOne menus and launch an HTML 
version of EnterpriseOne.  

See Also 
The following topics in the Foundation Guide: 

� Solution Explorer  

� PeopleSoft® Web Client 
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Solution Explorer  

Solution Explorer is a collection of tools and technologies that provide a gateway to EnterpriseOne 
and enable organizations to easily adapt their enterprise software both before and after 
implementation to meet changing business conditions.  

Key attributes that distinguish Solution Explorer from other Enterprise Resource Planning (ERP) 
systems include the following:  

• Ease of navigation. Solution Explorer offers a convenient, Web-browser-based, customizable 
gateway to all features and to any internal or external Web site. You can create and use links 
between and within task views to further speed your navigation and shorten your work time. 
Find It! allows you to search for and quickly find programs that you need.  

• Flexibility. Reusable units of work called tasks are at the core of the Solution Explorer. You 
can use these tasks as building blocks to model and create business and technical processes. 
Processes can be modified without costly changes to the system.  

• Ease of configuration. You set up the system so that it displays only the tasks and processes 
that you need for your daily work. You can enable and disable tasks and create process 
variations to reflect the needs of system users.  

• Ease of use. Solution Explorer allows you to create special tasks called activators, which you 
use to build key business and technical processes without having to hard-code any form 
interconnections. Activators launch the Universal Director, which provides an interface for 
the entire process that you create. In addition, the Universal Director facilitates the passing of 
data between forms, and it presents process steps in an easy-to-read format.  

• Compatibility. Solution Explorer's architecture permits software developers and integration 
partners to produce custom activators that are compatible with both third-party software 
applications and EnterpriseOne.  

• Accountability. Documentation exists for most tasks in Solution Explorer, which eliminates 
guesswork when you encounter a task. You can also create your own documentation for new 
tasks. Documentation means that information about tasks is readily accessible, even as people 
come and go within your organization.  

Solution Explorer allows you to quickly transform your business ideas into actions. Solution Explorer 
not only provides your business with the power to build a highly customized, fully integrated 
enterprise solution; it also allows the system to be smoothly altered as business conditions warrant 
change. 
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Signing On to Solution Explorer 
To sign on to PeopleSoft Solution Explorer, you must enter a user ID and password on the PeopleSoft 
EnterpriseOne Login form. User IDs define the following types of information for each user: 

• Security and permissions 

• Initial menu 

• Language and currency symbol 

• Display preferences 

On the signon form, you also can choose an environment and role in which to work. The system 
administrator sets up your environment and role for you. You might be assigned multiple roles, but 
typically you will need only one environment in which to work. 

► To sign on to Solution Explorer 

Choose the PeopleSoft icon on your desktop. 

1. On PeopleSoft EnterpriseOne Login, complete the following fields and then click OK.  

• User ID 

• Password 

Note 

You might have to click the Options button to view the Environment and Role fields. You 
must complete the User ID and Password fields before you can enter values in the 
Environment and Role fields. 

 

• Environment 

For a list of environments, click the Environment field, and then click the search button 
that appears to the right of the field. The Select Environment form appears. Choose the 
appropriate environment and then click Select. The environment that you choose appears 
in the Environment field on the signon form. 

The environment that you choose will be the default environment each time that you sign 
on to the system. To use a different environment, access the Select Environment form 
again and choose a different environment. Your authorization might allow you to access a 
number of environments; however, only the environments loaded onto the workstation 
that you are using, and to which you have access, appear on the Select Environment form. 

• Role 

For a list of roles, click the Role field, and then click the search button that appears to the 
right of the field. The Role Chooser form appears. Choose the appropriate role and then 
click Select. The role that you choose appears in the Role field on the signon form. 

The role that you choose will be the default environment each time that you sign on to the 
system. 
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2. On PeopleSoft EnterpriseOne Login, click OK.  

The Solution Explorer appears. 

Working with Solution Explorer  
Solution Explorer is the gateway to EnterpriseOne applications, reports, menus, and external objects, 
such as related documents and spreadsheets. You access these items using task views provided by the 
Solution Explorer. Task views contain menus composed of the various items. Different task views 
display only specific items arranged in their menus and based on varying criteria. Depending on what 
you want to do, you choose the task view that best supports your task. The Solution Explorer also 
offers access to the Internet or an intranet through its Web browser.  

Solution Explorer offers the ability to change user and display options, and to open menus by various 
methods.  

Understanding the Solution Explorer Interface  
The overall appearance of the Solution Explorer can vary depending on whether you are using the 
Web browser, working with a task view, or displaying or hiding features. Some features of the 
interface, such as the menu bar, are available at all times. Other features, such as the Toolbar and the 
status bar, remain constant with regard to how you can interact with them, although you have the 
option of turning them on and off.  

Solution Explorer Windows 

Depending on how you interact with the Solution Explorer, it can display several panels of 
information. These panels are referred to as windows. For example, you might display a task view, 
choose to display task properties and documentation, and then use Find It! to open a menu. Your task 
view, the task properties, the menu displayed by Find It!, and the documentation each appear in their 
own window.  

The task view window cannot be closed.  

Solution Explorer Toolbars  

The toolbars provide shortcuts for accessing frequently used commands. Toolbar buttons vary, 
depending on whether you are using the Web browser, a task view, the Find It! utility, and so on. 
Because your system administrator can configure the toolbar, the buttons on the toolbar might vary 
from those described in this section. The toolbar appears at the top of the window, directly beneath 
the window's banner. If more than one window is displayed, each window has its own toolbar, if 
applicable (not all windows have toolbars).  

When you move the cursor over a button, the button is highlighted, and the system provides a brief 
Hover Help description in a box below your cursor.  
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The following list provides information about the functions available on the various toolbars. Keep in 
mind that most toolbars do not provide all of the functions in this list.  

Back 
button  

The Back button displays the previous Web page.  

Edit 
button  

The Edit button allows you to add or change the documentation for a task.  

Find 
button  

The Find button launches the Find It! Program, which allows you to search for items in 
the software based on criteria that you enter.  

Font down 
button  

The Font down button decreases the size of the text that appears in the documentation 
window.  

Font up 
button  

The Font up button increases the size of the text that appears in the documentation 
window.  

Forward 
button  

The Forward button displays the next Web page in the queue.  

Home 
button  

The Home button displays the Web page that your system administrator has configured 
to be your home page.  

Run  
button 

The Run button launches the selected task.  

Link 
button  

The Link button launches the linked task in a second window.  

New 
Search 
button  

The New Search button clears all of the fields in Find It! so that you can perform a new 
search based on different criteria.  

Print 
button  

The Print button is located on the toolbar of the Web browser and the Task 
Documentation windows. Click the Print button to print the current contents of the Web 
browser or Task Documentation window to your default printer.  

Refresh 
button  

The Refresh button updates the information in the window that you are viewing. In the 
Web browser, the Refresh button reloads the current Web page. In a Task view, the 
Refresh button updates the Explorer with any changes made to your menus. In the Task 
Documentation window, the Refresh button updates the documentation window to 
reflect any changes made to the documentation.  

Search 
button  

The Search button accesses a Web site determined by your system administrator.  

Stop 
button  

The Stop button halts the loading of a Web page.  

Views 
button  

The Views button displays the most recently accessed task view. Click the down arrow 
next to the Views button to choose a specific task view.  
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► To display the toolbars 

1. From the View menu, choose Show and then choose Toolbar.  

2. To toggle text descriptions on and off under each button, from the View menu, choose Show 
and then choose Toolbar Text. 

Menu Bar 

Within the Solution Explorer, the word menu is used in two different ways. A menu can be a drop-
down list or a pop-up list of options; this type of menu is common to Windows applications. In the 
Solution Explorer, a menu can also be a tree-structured list of EnterpriseOne tasks, such as 
applications and reports. Menus of this type are available only in task views.  

The menu bar at the top of the Solution Explorer provides pull-down menus that display options for a 
task view, a menu, or an application. Some of the menus that you can access from the menu bar are 
File, Edit, and View.  

To choose menu options, either use your mouse to click an option or use the keyboard. When you 
press the Alt key, certain letters appear underlined in each menu. You can press the Alt key plus the 
key that corresponds to the underlined letter to access the menu. For example, the letter F is 
underlined in the word File on the menu bar so that you can access the File pull-down menu with 
your keyboard by holding down the Alt key and pressing the F key.  

The following list describes each menu option found on the menu bar. Depending on how your 
system administrator has configured your account, your ability to access some menu options might 
vary from what is described here. 

File  Use this option to access printer controls and to exit the system.  
 

Edit  Use this option to create shortcuts and define prompting options when available.  
 

View  Use this option to access the Web browser, turn toolbars on and off, access task views, 
and access a menu for changing user preferences.  

 
Tools  Use this option to access the following:  

• Find It!  
• Work Center  
• Object Management Workbench  
• Report Design  
• Report Versions  
• Event Capture 
• Analyzer 

Applications Use this option to access a list of all EnterpriseOne applications that are currently 
open.  

 
Help  Use this option to access online help.  
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Status Bar  

The Status Bar offers quick information about the meaning of a function, the security for your system, 
and the EnterpriseOne environment in which you are operating. Typically, it appears at the bottom of 
the Solution Explorer window.  

Hover your cursor over the Status Bar components to activate the hover help for each item.  

The following information appears on the Solution Explorer status bar:  

• Error messages  

• A message that contains the status of ongoing processes in the system  

• Your user ID and the environment that you are logged into  

• Your logon role  

► To display the Status Bar 

From the View menu, choose Show and then click Status Bar.  

Fast Path  

Fast Path is a dockable toolbar. You use commands in Fast Path to move quickly among menus and 
applications. A fast path command can be any of the following items:  

• An abbreviation that is either shipped with EnterpriseOne demo data or that you define to suit 
your business environment 

For example, the fast path OMW might take you to the Object Management Workbench 
application so that you can work with EnterpriseOne objects.  

• A task ID  

• A program name  

In Solution Explorer, you can use fast path commands to launch Windows executables, task views, 
EnterpriseOne applications, and so on. If you use Fast Path to open a menu, the Solution Explorer 
switches to a task view (if you were using the Web browser) and displays the menu that you selected 
in a window (the Link Window) to the right of the task view window. To specify a task view, enter its 
Internal Task ID, followed by a colon in front of the menu that you want to launch. For example, 
when you enter 101:RBM021444, the system displays not only the Master Scheduling Inquiries menu 
in the Link Window, but also the End-User Tasks task view in the task view window. To determine 
the Internal Task ID of a task view, click the uppermost item in the task view, and then click the 
Advanced tab in the Task Properties window. To display the Task Properties window, choose Show 
from the View menu, and then click Task Properties.  

To specify a form, enter the application ID followed by a | character, and then enter the form ID. For 
example, when you enter P01012|W01012B, the system displays the Work With Addresses form in 
the Work With Addresses application. You can specify a version of a form to open by adding the 
version number following the form name and the | character, such as P01012|W01012B|ZJDE0003.  
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Note 

Not all objects have fast path commands. Fast Path must be activated in your User Profile for you to 
use it. 

 

► To use Fast Path 

1. If the Fast Path toolbar is not visible, choose Show from the View menu, and then click Fast 
Path.  

2. Type a fast path command in the toolbar and press Enter. 

Favorites Bar  

The Favorites Bar is a dockable toolbar that displays the tasks and folders that you have placed in 
your Favorites. You can launch applications by choosing a task in this toolbar. 

See Also 
� Favorites Task View in the Foundation Guide for more information about setting up favorites 

► To display the Favorites Bar 

From the View menu, choose Show and then click Favorites Bar. 

Changing Your User Options  
To access user option information from Solution Explorer, from the View menu choose User Options. 
The User Default Revisions form appears.  

The following list describes the associated application for each item on the User Default Revisions 
form:  

User Profile 
Revisions  

This option accesses the User Profile Revisions application. Only system 
administrators should change user profiles; however, you can use this option to view 
your current user profile. 

Change 
Password  

This option accesses the User Password Revisions application, which provides a 
means for you to change your own system password. 

Submitted 
Reports  

This option accesses the Work With Servers application, which you can use to check 
the status of a submitted report or job, change your report or job priority, work with 
the report output, and review errors.  

View Local 
Output 

This option accesses the PrintQueue directory on the machine that is running 
EnterpriseOne. This queue contains the Adobe Acrobat Portable Document Format 
(PDF) version of any reports you have run.  

Default 
Printer  

This option accesses the Work With Default Printers application. Only system 
administrators should change default printer settings. Use the Work With Default 
Printers application to add or change a system default printer, or to change the status 
of a default printer.  
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See Also 
� User Profiles in the System Administration Guide for more information about modifying user 

profiles 

� Submitting a Report in the Enterprise Report Writing Guide for more information 

� Working with the Printers Application in the System Administration Guide for more 
information 

► To change your password 

1. On Solution Explorer, choose User Options from the View menu.  

2. On User Default Revisions, click Change Password.  

3. On User Password Revisions, complete the following fields and click OK:  

• Old Password 

• New Password 

• New Password - Verify 

► To view report output  

 

Note 

Before you can view the output of your reports online, you must run a report version. See Batch 
Versions for Reports in the Enterprise Report Writing Guide for information about how to run a 
report.  

 

1. On Solution Explorer, choose User Options from the View menu.  

2. On User Default Revisions, click View Local Output.  

3. On the Open form, choose a file and click Open.  

A PDF version of the report appears. You can also view log files, such as error logs. To do 
so, choose UBE Log Files from the Files of type field. 

Purging Cache 

The cache stores temporary Internet files as well as temporary system information. 

► To purge cache 

1. On Solution Explorer, click the View menu and then choose User Options. 

2. On User Default Revisions, click the drop-down arrow on the Links toolbar. 

3. Choose Form, and then click Purge Cache. 
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Solution Explorer Home Page  
Your system administrator can configure a special page called the Solution Explorer Home Page, 
which is a Web browser that can include EnterpriseOne menus, an intranet with company-related 
links, and data. Typically, you see the Home Page when you first log on to the system.  

► To access the Solution Explorer Home Page 

On Solution Explorer, from the View menu, choose Home Page. 

Accessing the PeopleSoft Web Site 
You can access the PeopleSoft corporate Web site through the Solution Explorer. The PeopleSoft 
Web site allows you quick access to information about PeopleSoft product offerings, services, and 
other company information.  

► To access the PeopleSoft Web site 

On Solution Explorer, from the Help menu, choose PeopleSoft on the Web, and then choose 
PeopleSoft Home Page. 

Opening Menus and Applications in Solution Explorer 
Within the Solution Explorer, the term menu can be used in two different ways. A menu can be a 
drop-down or pop-up list of options, such as those that are common to Windows applications. In 
Solution Explorer, a menu can also be a tree-structured list of various items, such as applications and 
reports. Menus of this type are also called tasks and are available in task views.  

In task views, you navigate through menus to locate and perform tasks such as launching an 
application, processing a report, and so on. The Solution Explorer provides several methods of 
finding and displaying menus.  

Note 

You also can use Fast Path to open menus and applications. See Fast Path in the Foundation Guide 
for more information.  

 

Understanding the Task View Menu Tree Structure 

PeopleSoft system items, such as applications and reports, are grouped in menus that can be accessed 
from task views. When you open a task view, Solution Explorer displays the menus in a tree structure 
in the left pane. If a plus (+) sign appears to the left of a menu item, you can expand that item to show 
the items that have been grouped under it. If a minus (-) sign appears to the left of a menu item, that 
item is expanded as much as possible.  
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You can expand and contract menus in two ways:  

• Use your mouse to click directly on the plus (+) or minus (-) sign.  

• Use your mouse to double-click the text of the menu. For example, if you double-click the 
"Foundation Systems" text, that menu either expands or contracts.  

Launching Applications in a Task View  

Many menu items, also known as tasks, launch an application or submit a report when you activate 
them. To activate a task, perform one of the following actions:  

• Double-click the task's icon or text.  

• Single-click the task and then click the Run button on the toolbar.  

Some tasks allow you to set values, select a version, or define data selection. To set these variables, 
right-click the task, choose Prompt For from the pop-up menu, and then choose the option that you 
want. The system disables options that cannot be set for that task.  

Opening Menus and Applications Using Find It!  

Find It! is a utility that you can use to search for any EnterpriseOne item, including applications, 
menus, and reports. You do not need to know the full name of an item to locate it with Find It! You 
can use Find It! to perform a word search or an advanced search. Use a word search to find tasks 
based on their name or description. Use an advanced search to find items based on their object name, 
object code, date and time of last update, or any combination of these criteria.  

► To use Find It! to perform a word search  

1. From the Tools menu, choose Find It!  

2. Click the Word Search tab.  

3. Enter the name of the item that you want to find in the Search Words field and then click the 
Find It! button on the Toolbar.  

If the item that you want to find is an activator and if you know its type (business or 
technical), you can limit the search by specifying the activator type in the Activator Type 
field.  

4. If you do not know the item's exact name, enter a single word or a string of words to display 
all menus and applications that match. For example, if you enter ADDRESS BOOK, Find It! 
displays menus and applications that contain the words address book, such as the Address 
Book Category Codes menu and the Customer Address Book Revisions application.  

5. On Find It!, double-click the item that you want to launch.  

Double-clicking an application launches the application. Double-clicking a report starts the 
report processing. You also can single-click the task, and then click the Run button. To set 
processing options (when available), right-click the task, choose Prompt For from the pop-up 
menu, and then choose the option that you want.  

Double-clicking a menu launches the task view in which the menu is located. The menu that 
you double-clicked appears in the Link Window to the right of the task view window.  
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► To use Find It! to perform an advanced search  

1. From the Tools menu, choose Find It!  

2. Click the Advanced Search tab.  

3. Complete one or more of the following fields, and then click the Find It! button on the 
Toolbar:  

• Object Name  

• Product Code  

• Last Updated  

4. Double-click the item that you want to launch.  

Double-clicking an application launches the application. Double-clicking a report starts the 
report processing. Depending on its processing options, you might be prompted to choose a 
version of the report or to set other parameters.  

Double-clicking a menu launches the task view in which the menu is located. The menu that 
you double-clicked appears in the Link Window to the right of the task view window.  

Working with Task Views  
With the Solution Explorer, you can access EnterpriseOne menus and applications through different 
task views. Task views in Solution Explorer contain particular kinds of task relationships that 
represent processes that you follow to complete essential jobs in the system. Tasks in a task view 
might launch an application, display a series of child tasks, or link to another task view.  

To launch a particular task view, choose Task Views from the View menu, and then choose the task 
view that you want from the resulting list.  

Note 

Depending on your configuration, some task views might be unavailable to you, or you might be able 
to access views that are not described here. 

 

See Also  
� Task View Setup and other topics in the Solution Explorer Guide for a description of other 

administrative views  

� Opening Menus and Applications in Solution Explorer in the Foundation Guide for 
instructions on manipulating the menus and launching applications in task views  

End-User Tasks Task View  

The End-User Tasks task view contains menus that are based on the role or roles of a particular user. 
For example, a user might be assigned to the role of purchasing clerk. The role-based menu 
associated with this role contains only those menu items associated with making purchases.  

The system administrator sets your roles and the tasks that you can see in this view.  
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► To apply a role  

1. In the Solution Explorer End-User Tasks task view, right-click any task in the task view 
menu, and then choose View By Role from the pop-up menu.  

The View By Role form appears. All of the roles to which you have access appear in the 
detail area.  

2. In the detail area, click the new role that you want to apply, and then click Select. 

EnterpriseOne Menus Task View  

The EnterpriseOne Menus task view contains the suite of EnterpriseOne applications arranged in a 
tree structure.  

Education Task View 

The Education task view displays courses available at PeopleSoft training centers. Training paths and 
course descriptions for each product vertical are also available.  

Favorites Task View  

The tasks that you use most frequently are placed in the Favorites task view, which provides easy 
access to them from one location. You can create favorites to identify your favorite tasks, and then 
you can arrange your favorites as children of an identifying task.  

Items that you place in Favorites appear in your Favorites Bar; thus you do not need to return to the 
Favorites view to access an item. To display the Favorites Bar, choose Show from the View menu 
and then click Favorites Bar.  

You can add existing tasks either by clicking the task and using the Send To Favorites function, or by 
inserting the task directly into your Favorites if you know the name of the task. You also can create 
tasks for your Favorites. For example, if you created your own version of a report, you can create a 
task in your Favorites that enables you to access your report version easily. In addition to creating 
tasks for launching EnterpriseOne objects, you can create placeholder tasks under which you can 
place other tasks. These folder tasks become nodes when you place child tasks under them. 
Placeholder tasks help you organize the tasks in your task view.  

► To add a task or node to Favorites 

1. Right-click the task or node that you want to add, and then choose Send To Favorites from 
the pop-up menu.  

The system adds your selection to your Favorites. 

If you added a node to your favorites, the node appears in the Favorites task view with an 
arrow icon on it. 

2. To access tasks within the node, right-click the node and then click Link from the pop-up 
menu. 

The tasks within the node appear in the link window.  
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► To add a task to Favorites with Insert Existing Task 

1. On your Favorites task view, choose the task under which you want to insert the task that you 
are adding.  

2. Right-click the task that you selected, and then choose Insert Existing Task from the pop-up 
menu.  

3. On Task Relationship Revisions, complete the following fields: 

• Child Task ID 

• Required 

You can enter more than one task in the detail area if you want to add more than one task to 
your Favorites at the same time.  

4. Click OK.  

If you added more than one task to the detail area, all of the tasks that you added will be 
added to your Favorites.  

Note 

If you add a task under a task that has no children, when you click OK the detail area on the 
Task Relationship Revisions form clears and the form remains open. Click Cancel to close 
the form. The tasks that you added appear in the task view menu.  

 

► To create a new task for Favorites  

1. Create the object for which you want to create a task.  

For example, create your own version of a report.  

2. In the Favorites view of the Solution Explorer, choose the task under which you want to add 
the new task.  

3. Right-click the task, and then choose Insert New Task from the pop-up menu.  

4. Complete the steps for creating a new task. 

Note 

See Creating a Task in the Solution Explorer Guide for instructions on how to create a new 
task. 

 

► To create a placeholder task  

1. In the Favorites view of the Solution Explorer, choose the task under which you want to add 
the placeholder task.  

2. Right-click the task that you selected, and then choose Insert New Task from the pop-up 
menu.  

The Task Revisions form appears.  
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3. Enter a name for the placeholder task in the Task Name field.  

4. Click the Common tab and enter a product code in the Product Code field.  

Leave the Activator Field blank. Ensure that the Required option is not turned on and that the 
Active option is turned on.  

5. Click the Executable tab and click the Folder option.  

6. Click OK.  

► To reorganize Favorites  

From the Favorites view, perform either of the following after you add tasks and folders to your 
Favorites:  

• To delete a task from your favorites, right-click the task that you want to delete, and then 
choose Delete Relationship from the pop-up menu. The system confirms that you want to 
delete the relationship. If you delete a parent object, all of its children will be removed from 
your favorites as well. When you delete a relationship in this manner, the system does not 
delete the task from the system; only your Favorites view is affected.  

• To make a task or folder into a child (that is, a subtask or subfolder) of another task or folder, 
drag it onto the task or folder that you want to use as a parent. The Solution Explorer 
modifies the tree structure of your Favorites accordingly.  

Working with Role-Based Task Views  

Your system administrator can create role-based versions of task views that you can use to easily 
access the tasks that you need. Creating a role-based version applies a predefined filter to the menu of 
the task view. For example, if a menu in your task view showed tasks related to both customers and 
suppliers, you can choose to view either of two roles: customer-related tasks or supplier-related tasks.  

Although a task view can have many roles, each role is actually referenced by the parent task in the 
tree under which the tasks are filtered. The parent task in the tree that you select before applying a 
role is known as the root.  

Note 

The role does not permanently override the relationships that you originally see in a task view before 
you apply the role, which is simply an alternate way to view the data. Switching between the original 
view and the role view does not affect the tasks within the view.  

Not all task views are role-based. 

 

► To view a different role in a role-based task view 

1. In a task view of the Solution Explorer, right-click a task, and then choose View By Role 
from the pop-up menu.  

2. On View by Role, choose the role that you want to apply and then click Select.  

The system applies the role to the task view and collapses the parent task.  

3. Expand the parent task to see the tasks available in this role.  
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Working with Task Documentation Window Content  
The documentation window contains information that you choose on tabs that classify the 
documentation type. Much of the task documentation in Solution Explorer comes preloaded; 
however, you can write your own documentation for tasks. To display the task documentation, choose 
Show from the View menu, and then click Task Documentation. 

Note 

Some tasks do not use instruction-type tabs; therefore, some tabs do not appear.  

 

See Also  
� Documenting Tasks in Solution Explorer Guide for information about writing your own 

documentation  

Summary Tab  

The Summary tab provides a comprehensive abstract of the task, including its business purpose, how 
it integrates into your system, and the processes contained within the system. Summary 
documentation might also include examples of how the task is used.  

Detail Tab  

The Detail tab provides instructions about the steps that are required to complete a task. Such 
documentation might also include general comments about a particular step in the instructions and 
specific examples associated with completing the process.  

Before You Begin Tab  

The Before You Begin tab provides documentation about the influence of the task on other processes, 
programs, and systems. It also includes steps that you might be required to complete before you begin 
a task. Before You Begin documentation might also describe possible outcomes when you complete a 
task, such as the consequences of failing to complete a step in the process.  

Notes Tab 

The Notes tab provides explanatory information to a user about a task. For example, if you have 
changed the purchase order process, you might write Notes documentation that explains why you 
made the change.  

Deliverables Tab  

The Deliverables tab provides links to documentation associated with a task. For example, if you use 
a task to create an engagement letter, you might create a link to the engagement letter so that the user 
can see what it looks like in its completed state.  
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Custom Tab  

If you want to develop documentation that does not fit into one of the existing categories, you can 
create custom documentation. This feature meets the PeopleSoft ongoing commitment to adapt the 
system to meet the needs of your business. 

Understanding Task Properties  
When you are in a task view, you can display a window that shows system information about any 
item that you select in the task view window or the Link Window. To display the Task Properties 
window, choose Show from the View menu, and then click Task Properties.  

The Task Properties window has three tabs: Basic, Intermediate, and Advanced. The information in 
the Task Properties window will vary based on the item currently selected. Some of the information 
on the tabs is described below:  

• Activator Type resides on the Basic tab. It is useful if you want to use the Activator task view 
or search by Activator type with the Find It! utility.  

• Version resides on the Intermediate tab.  

• Object Name resides on the Intermediate tab.  

• Links are shown on the Intermediate tab. If an object is linked to another object, you can 
launch the second object with the Link button on the Toolbar.  

• Task ID resides on the Advanced tab. If you know an object's task ID, you can launch it 
directly from the Fast Path toolbar.  

Running the Universal Director  
Some Solution Explorer tasks have a light bulb next to their icons. Launching these tasks 
automatically launches the Universal Director. The Universal Director provides a single interface that 
leads you through the steps of major tasks.  

For example, you might have a task called New Customer that you use to enter new customers into 
the system. If this task is set up as a Universal Director task, the Universal Director might first guide 
you through adding an address book record for the customer, then adding a customer master record, 
and then creating the initial sales order. At each step, the Universal Director launches the appropriate 
application.  

The Universal Director displays a list of steps that are required to complete the task. As you complete 
the steps, the Universal Director marks them as complete. You can choose to move backwards and 
forwards through the list or to skip steps altogether. You can also display the documentation window 
for help with steps, as shown below:  
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The buttons at the bottom of the Universal Director form have the following functions:  

Tree  The Tree button hides or shows the window that displays the steps in the process 
that you are currently performing.  

Documentation The Documentation button hides or shows the documentation window.  

Previous  The Previous button returns you to the previous task in the process.  

Skip  The Skip button allows you to skip the current task and move to the next task in the 
process. Steps that you skip are marked with a red dash in the tree window.  

Next  The Next button allows you to move to the next task in the process. You typically 
use this button in conjunction with the Previous button.  

Cancel  The Cancel button halts the Universal Director and closes the Universal Director 
form.  

► To run the Universal Director  

1. From any task view of the Solution Explorer, choose a task marked with the light bulb icon.  

2. Click the Run button on the Toolbar.  

The system launches the Universal Director.  

3. Proceed through the tasks in the activator, clicking the Next button after you complete each 
task.  
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PeopleSoft Web Client 

PeopleSoft Web Client is an HTML-based menu system that provides the ability to navigate 
EnterpriseOne menus and launch an HTML version of PeopleSoft applications. 
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EnterpriseOne Web Application User Interface 

Most PeopleSoft EnterpriseOne applications are available on the Web. These applications provide the 
same functions as their Windows counterparts, although the interface differs somewhat due to 
differences between the two platforms. 

EnterpriseOne Web-based applications are powered by the JAS server, which a system administrator 
configures when implementing the EnterpriseOne. However, Web and Windows applications both 
reference the same database tables for the most part, so Web and Windows users can use the same 
system simultaneously, and both can see all changes in real time, depending on the constraints of your 
system. Additionally, the JAS server can communicate with pervasive devices, so you can access 
certain EnterpriseOne from such devices as well. 

A user can sign in to the Web client directly, or she can sign in through either the Collaborative Portal 
or Enterprise Portal, depending on how a system administrator configures the system. When signing 
in directly or through the Collaborative Portal, users access EnterpriseOne through EnterpriseOne 
Menu. Users who sign in to the Web client directly see EnterpriseOne Menu as a standalone interface, 
while users who sign in through the Collaborative Portal access EnterpriseOne Menu through a 
portlet. EnterpriseOne Menu is the Web counterpart of the Windows-based Solution Explorer, and it 
provides many of the same features. 

Note 

The standalone version of EnterpriseOne Menu differs slightly from the portlet version. Therefore, 
they are treated as separate entities in this document. 

 

Through the Enterprise Portal, users access EnterpriseOne applications via hyperlinks in the Portal's 
menus. 

Accessing the EnterpriseOne Web Client 
Accessing PeopleSoft EnterpriseOne applications on the Web is similar to accessing files and 
applications on a company network. Typically, either when you start your computer or when you 
want to access company network directories, you must sign in to identify yourself to the system as an 
employee who has the right to access company resources. After you sign in, you can access files and 
applications on the network. Similarly, you must sign in the Web client—the gateway through which 
you access EnterpriseOne—before you can launch EnterpriseOne applications. 

To sign in to the Web client, your computer must have access to your company’s intranet, you must 
have a Web browser installed on your computer, and your system administrator must create an 
account for you. If you are using a pervasive device, however, all you need is an account. When your 
system administrator sets up your account, he or she creates a user ID and assigns you a password. 

Accessing the EnterpriseOne Web Client directly 
Usually, you must enter your ID and password when you launch the Web client. However, your 
system administrator can configure your computer in such a way so that you appear to bypass the 
signin process. For security reasons, however, most system administrators want users to sign in 
manually. 
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When you sign in to the Web client, EnterpriseOne Menu appears. EnterpriseOne Menu allows you to 
access EnterpriseOne applications, reports, and other features. 

Accessing the EnterpriseOne Web Client through the Collaborative Portal 
When you sign in to the Collaborative Portal, the Portal can pass your signin information to 
EnterpriseOne. Therefore, all you must do is bring up a workspace containing the EnterpriseOne 
Menu portlet. The EnterpriseOne Menu portlet allows you to access EnterpriseOne applications, 
reports, and other features. 

Accessing the EnterpriseOne Web Client through the Enterprise Portal 
When you sign in to the Enterprise Portal, the Portal can pass your signin information to 
EnterpriseOne. To access specific EnterpriseOne applications, reports, or features, your system 
administrator must provide you with specific menu options. Choose a menu option to launch a 
specific EnterpriseOne object. 

► To sign in to the EnterpriseOne Web client directly 

Follow this task to sign in to the EnterpriseOne Web client if you do not use a portal. 

1. Launch your Web browser and navigate to your company’s EnterpriseOne Web signin. 

Depending on how your system administrator has configured your system, the Web signin 
might appear when you launch your browser, you might need to click a button or a hyperlink, 
or you might need to navigate to a particular page. If you do not know how to find the 
EnterpriseOne Web signin, contact your system administrator. 

2. Complete the following fields: 

• User ID 

• Password 

3. If your system administrator indicated that you must sign in to a particular environment, click 
Details and complete the following field: 

• Environment 

4. If you have multiple roles and wish to sign in as one of them, click Details and complete the 
following field: 

• Role 

The default value is *ALL, which signs you in as a member of all of your roles. 

5. If you want your computer to remember your settings for the future, choose Remember my 
sign in information. 

Note 

Do not use this option if other people have access to your computer. 

 

6. Click Sign In. 

The EnterpriseOne Menu appears. 
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Using EnterpriseOne Menu (Stand-Alone Version) 
PeopleSoft EnterpriseOne Menu is the Web-based application you run to access PeopleSoft 
EnterpriseOne applications. EnterpriseOne Menu requires the following software: 

• EnterpriseOne, release 8.9.3 

• Netscape 7 or greater or Internet Explorer 5.5 SP2 or greater 

The left portion of EnterpriseOne Menu displays a tree structure that you can use to navigate to the 
specific application or report that you want to launch. The tree can contain objects other than 
applications; for this reason, all objects in the tree are called tasks. Nodes, applications (including 
reports), and shortcuts in the tree are all tasks. Each time you click a node, you expand the tree a level 
and the view of the tree changes. 

Principal sets of tasks are called task views. Your system administrator configures your task view list; 
that is, the initial contents of the tree. The list might start or end with a special task view called 
Favorites. All your other task views appear above or below this one. 

System administrators use PeopleSoft Solution Explorer and EnterpriseOne ERP security applications 
to manage user accounts and to configure EnterpriseOne Menu. 

Prerequisites 
� Task View Setup and related topics in Solution Explorer Guide for more information about 

configuring task views 

� Solution Explorer Security in System Administration Guide for more information about 
configuring Task Explorer functions that are available to end users 

► To navigate in EnterpriseOne Menu 

1. In EnterpriseOne Menu, click a task (that is, a node) in the tree. 

The task node expands to show the tasks beneath it. 

2. Continue to drill into the tree structure until you reach the object you want to launch. 

Hover over a non-node task to see more information about it. The system tells you what kind 
of object the task is (for example, application, report, and so on) and other information, such 
as its number and version. 

Depending on the object type, you might be able to choose a version or to set data selection 
or processing options. Click the triangle to the right of the object and make a choice from the 
resulting drop-down menu. 

3. To launch the object, click it. 

You can launch multiple applications. Depending on how your system administrator has 
configured your system, additional applications launch in the same window or in a different 
window. Either way, the applications you have running appear at the top of the tree under 
Open Applications. 

4. If you have multiple applications open, click the application name under Open Applications 
to bring a specific application to the forefront. 
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► To launch an application or report 

1. In EnterpriseOne Menu, navigate to the application or report you want to launch. 

2. To launch the application or report without defining processing options, version, and so forth, 
click the report or application. 

Applications launch immediately. If you launch a report without choosing a version, the 
system launches Work with Batch Versions so you can choose which version you want to 
run. 

3. To select processing options or version for an application, click the arrow next to the task and 
choose Values or Versions, respectively. 

After you choose the processing options or version, the system launches the application. 
Depending on how your system administrator configured the system, the application launches 
either in the existing window or in a new one. Either way, you can run multiple applications 
simultaneously. All applications you have running are listed in the EnterpriseOne Menu 
toward the top, under Open Applications. You can switch among them by clicking the 
application you want in the list. 

4. To select processing options or version or to designate data selection parameters for a report, 
click the arrow next to the task and choose one of the following options: 

• Values 

• Versions 

• Data Selection 

• Data Selection & Values 

After you set the options, the system might launch Work with Batch Versions so you can 
choose which version you want to run. Then, Version Prompting appears. Choose the 
prompting you want and click Submit to choose a printer and process the report. 

Prerequisites 
� Interactive Versions for Applications in Foundation Guide for more information about 

running PeopleSoft EnterpriseOne applications 

� Batch Versions for Reports in Foundation Guide for more information about running 
EnterpriseOne reports 

� Processing Options in Foundation Guide documentation for more information about 
processing options and how to use them 

Fast Path 
Fast Path is a field that allows you to access a specific task (that is, a folder, application, or report) 
directly. You use commands in Fast Path to move quickly among menus and applications. A Fast 
Path command can be any of the following: 

• An abbreviation that is either shipped with PeopleSoft EnterpriseOne demo data or that you 
define to suit your business environment. For example, the code BV might access the Batch 
Versions application so that you can run a report.  

30 



• A task ID.  

• A program name.  

To use the Fast Path field, enter a Fast Path code and click the button to the right of the field.  

Depending on how your system administrator configured your account, you might not be able to see 
or change your Fast Path security. 

In EnterpriseOne Menu, you can use Fast Path codes to launch task views, PeopleSoft applications, 
and so on. To specify a task view, enter TV: followed by its internal task ID. For example, TV:98 
accesses your Favorites task view.  

You can also use the Fast Path field to access menus. Task views are composed of menus and 
individual tasks. Menus have no special format in EnterpriseOne Menu; they simply provide 
application developers with a convenient method of grouping applications. When you access a menu, 
you actually access a specific place in a task view. To access a menu, enter its ID. For example, G0 
accesses the Foundation Systems menu. You can find a menu’s ID by hovering over it. 

To launch an application, enter the application’s program number. To specify a form in the 
application, enter the application's program number followed by a |, and then enter the form ID. For 
example, when you enter P01012|W01012B, the system displays the Work with Addresses form in 
the Address Book application. You can specify a version of a form to open by adding a | and the 
version number after the form name; for example, P01012|W01012B|ZJDE0003.  

Contact your system administrator for specific internal task, menu, and application IDs. 

Note 

Not all objects have Fast Path commands.  

 

Task Documentation 
Some tasks have documentation associated with them. To see the documentation, click the triangle 
next to the task and choose Documentation from the menu. A task might have multiple pages of 
documentation associated with it. If it does, two or more tabs appear at the top of the documentation 
frame. Click the different tabs to see all the documentation. 

Note 

System administrators must replicate the documentation files to every Web server to make the 
documentation available to all users. 

 

See Also  
� Documenting Tasks in Solution Explorer Guide for information about writing your own 

documentation  
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Favorites Task View 
The Favorites task view is where you can save links to other tasks. If you frequently run a task, you 
can save that task in your favorites list. Then, you can access that task directly from your Favorites 
task view. 

You have your own Favorites task view, and other users in your company have their own Favorites 
task views. No one else can see your Favorites task view or your changes. If you also use PeopleSoft 
Solution Explorer, the Windows version of Task Explorer, then you see the same favorites list in both 
applications, if you sign in to the same environment. 

Depending on how your system administrator configured your account, you might not be able to see 
or change your Favorites task view. 

► To access your Favorites task view 

In PeopleSoft EnterpriseOne Menu, click Favorites. 

► To add a task to your Favorites task view 

1. In PeopleSoft EnterpriseOne Menu, navigate to the task that you want to add to your 
Favorites task view. 

2. Click the arrow next to the task and choose Add To Favorites from the resulting menu. 

Role-Based Task Views 
Your system administrator can create task views that are available to users with specific roles. Roles 
are a way to categorize and group users. Your system administrator assigns you one or more roles 
when creating your account. Role-based task views can provide a convenient and succinct list of 
applications and reports necessary to perform a certain job. 

► To access a role-based task view 

In EnterpriseOne Menu, choose a role from the Roles drop-down menu and click the button to the 
right of the field. 

The tree view changes to show the tasks that are available to the role that you chose. 

Task Profiles 
For each task, you can view profile information about the task itself. To display the profile for a task, 
click the triangle to the right of the task and choose Task Profile.  

The Task Profiles window has three tabs: Basic, Intermediate, and Advanced. The information in the 
window varies based on the item currently selected. Some of the information on the tabs is described 
below:  

• Version resides on the Intermediate tab.  

• Object Name resides on the Intermediate tab.  
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• Task ID resides on the Advanced tab. If you know an object's task ID, you can launch it 
directly from the Fast Path toolbar.  

User Options 
When you click My System Options, the User Default Revisions form appears. The following list 
describes the associated action for each button on the User Default Revisions form: 

Button Description 
User Profile 
Revisions 

Launches the User Profile Revisions program (P0092). Only system administrators 
should change user profiles. 

Change 
Password 

Launches the EnterpriseOne Security program (P98OWSEC), which you use to change 
your password. 

Submitted 
Reports 

Launches the Work With Servers program (P986116), which you can use to review the 
status of a submitted report or job, change your report or job priority, work with the 
report output, and review errors. 

View Local 
Output 

Accesses the PrintQueue directory on the machine that is running EnterpriseOne. 

Default Printer Launches the Printer Application program (P98616). Only system administrators should 
change default printer settings. 

See Also 
� User Profiles in System Administration Guide for information about modifying user profiles 

� To View Report Output in the Foundation Guide for information about accessing the 
PrintQueue directory 

� Submitting a Report in EnterpriseOne Report Writer Guide 

� To change your password in EnterpriseOne Web Client Guide 

� Working with the Printers Application in EnterpriseOne Report Writer Guide for information 
about changing default printer settings 

► To change your password 

1. In PeopleSoft EnterpriseOne Menu, click User Options. 

2. On User Default Revisions, click Change Password. 

3. On User Password Revisions, complete the following fields and click OK: 

• Old Password 

• New Password 

• New Password - Verify 
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► To view report output 

Before you can view the output of your reports online, you must run a report version. 

1. In PeopleSoft EnterpriseOne Menu, click User Options.  

2. On User Default Revisions, click View Local Output.  

3. On the Open form, choose a file and click Open.  

A PDF version of the report appears. You can also view log files, such as error logs. To do 
so, choose UBE Log Files from the Files of Type field. 

See Also 
� Submitting a Report in the EnterpriseOne Report Writer Guide for information about how to 

run a report 

EnterpriseOne Menu Portlet Configuration 
As a system administrator, you must perform the following tasks to set up and maintain 
EnterpriseOne Menu Portlet: 

• Set up Solution Explorer on a Windows workstation 

• Create roles with Solution Explorer 

• Create task views with Solution Explorer 

• Set up security with Security Workbench 

Role-based task views are one of the most powerful features of Solution and EnterpriseOne Menu 
Portlet. In fact, in EnterpriseOne Menu Portlet, all task views are role-based with the exception of 
Favorites. To set up role-based task views, you must first set up roles. Then you can create or modify 
task views tailored to your users’ needs. You use Solution Explorer to set up roles and task views, 
including the Favorites task view. Refer to the Solution Explorer documentation for details about 
setting up roles and task views. 

Security Workbench includes a form for Solution Explorer (and, therefore, EnterpriseOne Menu 
Portlet) security options, although only the Explorer and Favorites options affect EnterpriseOne Menu 
Portlet. You can allow users to view secured task views. You can apply different security 
configurations to roles or to individual users. 

See Also 
� Solution Explorer Security in the System Administration Guide for details about allowing 

users access to Task Explorer task views, the Favorites task view, and Fast Path 

� Setting Up User Roles in the System Administration Guide for details about creating and 
administering roles 

� Task View Setup in the Solution Explorer Guide for details about creating and modifying task 
views 

� Task Set Up in the Solution Explorer Guide for details about creating and modifying tasks to 
include in task views and about applying roles to a task 
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► To configure Task Explorer to reference the correct Explorer tables 

1. Stop the EnterpriseOne instance of WebSphere. 

2. On the Web server, go to \\..\webclient\taskexplorer\. 

The file taskexplorer.properties governs how Task Explorer runs, including which set 
of tables it uses. The default is for Task Explorer to point to the Solution Explorer tables. 

Caution 

Do not modify taskexplorer.properties except as instructed below. 

 

3. Rename taskexplorer.properties to taskexplorer.properties.def. 

4. To point Task Explorer to the OneWorld Menu tables, rename 
taskexplorer.properties.owmenu to taskexplorer.properties. 

5. To point Task Explorer to the Solution Explorer tables, rename 
taskexplorer.properties.activera to taskexplorer.properties. 

6. Start the EnterpriseOne instance of WebSphere. 

Troubleshooting EnterpriseOne Menu Portlet 
If you are an end user and are having problems with EnterpriseOne Menu Portlet, contact your IT 
support professional or your system administrator. 

As a system administrator, if EnterpriseOne Menu Portlet is not appearing, review the following logs: 

• Examine the JAS.log. Ensure that all the drivers have been registered. Look for SQL (or 
equivalent) exceptions to track errors in database connectivity. 

• Uncomment the jdelog.debug section in the jdelog.properties file and examine the 
JASDEBUG.log for errors in API activity. 

• Examine STDOUT.log and STDERR.log. STDOUT.log in particular contains EnterpriseOne 
Menu Portlet-specific logging such as errors related to entry point form lookups. 

• Examine the Collaborative Portal logs (standard out, standard error, and "wps" 
timestamped logs). 

Log location is determined by the JAS.ini file for STDOUT.log and STDERR.log. STDOUT. The 
JAS logging is specified in the jdelog.properties file. Both files are on the EnterpriseOne system. 

The exact names of the Collaborative Portal standard out and standard error logs can vary because 
they are configuration options in the WebSphere Application Server. Example names of these logs are 
"appserver-out.log," "appserver-err.log," and "wps_2004.01.22-10.19.16.log." 
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PeopleSoft Web Applications and Reports 
PeopleSoft provides a variety of applications, reports, and other objects. Typically, you access these 
objects from the Task Explorer. 

► To launch an application or report 

1. In EnterpriseOne Menu, navigate to the application or report you want to launch. 

2. To launch the application or report without defining processing options, version, and so forth, 
click the report or application. 

Applications launch immediately. If you launch a report without choosing a version, the 
system launches Work with Batch Versions so you can choose which version you want to 
run. 

3. To select processing options or version for an application, click the arrow next to the task and 
choose Values or Versions, respectively. 

After you choose the processing options or version, the system launches the application. 
Depending on how your system administrator configured the system, the application launches 
either in the existing window or in a new one. Either way, you can run multiple applications 
simultaneously. All applications you have running are listed in the EnterpriseOne Menu 
toward the top, under Open Applications. You can switch among them by clicking the 
application you want in the list. 

4. To select processing options or version or to designate data selection parameters for a report, 
click the arrow next to the task and choose one of the following options: 

• Values 

• Versions 

• Data Selection 

• Data Selection & Values 

After you set the options, the system might launch Work with Batch Versions so you can 
choose which version you want to run. Then, Version Prompting appears. Choose the 
prompting you want and click Submit to choose a printer and process the report. 

Prerequisites 
� Interactive Versions for Applications in Foundation Guide for more information about 

running PeopleSoft EnterpriseOne applications 

� Batch Versions for Reports in Foundation Guide for more information about running 
EnterpriseOne reports 

� Processing Options in Foundation Guide documentation for more information about 
processing options and how to use them 
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Application Shortcuts 
While you are working in the PeopleSoft Web client, you can e-mail other users a shortcut to the 
application and form that you are looking at. The recipient double-clicks the shortcut in the e-mail to 
access your current position in the software. 

Note 

EnterpriseOne allows you to send shortcuts that launch Windows client or Web client applications. 
Before you send a shortcut, you need to determine whether the recipient of the shortcut is using the 
Windows client or Web client version of EnterpriseOne. However, you can only set up shortcut 
preferences on the Windows client machine. 

 

 

► To send a shortcut to an application form 

1. Launch a Web application and access the form that you want to send. 

2. Click Tools and choose Send Shortcut. 

3. On Send Shortcut, complete the following fields: 

• Address Number / User / Role / Distribution List 

Note 

If you are sending a shortcut to members of a distribution list, you must click the Distribution 
List option and then choose the address book number of the distribution list. If you enter the 
distribution-list address-book number without choosing the Distribution List option, the 
shortcut will be sent only to the distribution-list address-book number and not to the members 
of the distribution list. 

 

• Mail Box 

Choose which mailbox/queue you want the message to be sent to. 

• Subject 

Type the text that you want to appear in the Subject line of the e-mail message. 

4. If you want to include a message with the shortcut, type it in the large field at the bottom of 
the form. 

5. Click OK to send the shortcut.  

The recipient will receive the shortcut via an e-mail in the Work Center or a third-party e-
mail system, depending on the recipient’s e-mail preferences in ERP 8. 
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Web Application Forms 
You work with EnterpriseOne applications using a series of forms. When you launch an application, 
its default form appears. The system displays other forms as required. Each form completely replaces 
the previous one, and you should use the buttons on the form to move through a series of forms 
instead of the back and forward buttons on your browser. 

EnterpriseOne forms are composed of one or more of the following elements: 

• Title bar 

• Button 

• Radio button/Check box 

• Hyperlink 

• Tab 

• Field 

• Detail area 

• Tree control 

Title Bar 
The title bar appears across the top of the application. The title bar shows the name of the application 
on the left and contains three help buttons on the right. These buttons allow you to access application 
version information, online help for the form or application, and online help for individual form 
elements. 

Buttons and Menus 
Buttons reside on the both the toolbar and the title bar. Buttons might also appear in the main body of 
the form. When you click a button, the system performs an action such as closing a form, telling the 
system to process the information that you entered on the form, or launching another program. 

An arrow in the lower-right corner of a button indicates that the button is a menu. When you click the 
button, the system displays the menu. 

Usually, the system does not process the information that you have entered on a form until you click a 
button (such as OK or Submit). 

Following is a list of the most common action buttons. Not all buttons appear on all forms. 

• Select – After choosing a row in the detail area, click Select to perform an action particular to 
that record: open another form with more detailed information, launch a report, and so forth. 

• Find – After completing one or more fields on the form with search criteria, click Find to fill 
in the detail area with the search results. 

• Add – Click Add to add a new row to the table. Typically, a new form appears to facilitate 
your adding the record. 

• Delete – Choose a record in the detail area to delete, and then click Delete to remove it from 
the table. 
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• Copy – Choose a record in the detail area to copy and then click Copy to create a new record 
based on the one that you chose. 

• OK – After completing the fields on a form, click OK to process the information. 

• Cancel – Click Cancel to close a form. If you click Cancel instead of another action button, 
such as OK or Find, the system disregards any data that you entered on the form. 

• Close – Click Close to close a form. If you are on the default form for an application, clicking 
Close closes the application. 

Following is a list of the most common menus. Not all menus appear on all forms. 

• Row – This menu contains options that you can apply to a record in a detail area that you 
have selected. 

• Form – This menu contains jumps to other forms within the application as well as form-
specific options such as viewing attachments to the form. 

• Tools – This menu contains options that are standard to most EnterpriseOne applications, 
such user options, the ability to submit jobs and reports, the ability to export the contents of a 
detail area to a spreadsheet, and so forth. 

Field and Detail Area 
You enter data in fields and detail areas, and the system can display data in fields and detail areas. A 
detail area looks like a table and displays information with a series of columns. Each row represents a 
different record. Fields, on the other hand, display only one piece of data at a time. A disabled 
(grayed-out) field does not allow you to change the data that it displays. Additionally, some fields 
have a down-pointing arrow in them. When you click the arrow, you see a range of options from 
which to choose. 

Sometimes when you click in a field, a button appears to the right of it. The button might look like a 
flashlight, a calculator, or a calendar. This button is called a visual assist. If you click the visual assist, 
the system helps you find and enter a valid value for the field. The flashlight brings up a form on 
which you can search for system information. For example, when you sign in to the system, you 
might have several environments from which to choose. If you click the visual assist and choose an 
environment from the list, you do not need to worry about entering a valid environment and spelling 
it correctly. The calculator visual assist allows you to calculate a value and then enters the result in 
the field. The calendar visual assist allows you to pick a date visually from a calendar and then enters 
it into the field. 

You might not need to enter a value in every field on a form. For example, many forms allow you to 
search for information, and they use the data that you enter in the fields to narrow the search. If you 
do not want to narrow the search based on a specific field, then enter a * in the field. A * is a wildcard 
character that tells the system that all values for that field are valid. 

As you type in a grid or a field, the system attempts to make a match from a list associated with the 
grid or field. This list is comprised of information you have typed in the grid or field previously. You 
can choose a value from the list that the system displays, or you can continue to type the information. 

Tree Control 
A tree control looks like two screens. One side displays a hierarchical structure of objects such as 
files, applications, and so forth. The contents of the other side change depending on the object in the 
hierarchy that you choose. 
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► To get help on a form 

All help buttons appear in the upper-right corner of PeopleSoft Web forms. Hover over the buttons to 
see their names. 

1. To see information about a form such as its ID, the application it belongs to, and the software 
version, click About. 

2. To see general information about how to use the current application, click Help. 

3. To see information about a specific field, click Item Help. 

A question mark appears next to your cursor. 

4. Click in the field for information about it. 

You can click in any number of fields. 

5. When finished, click Item Help again. 

The question mark next to your cursor disappears, and you can continue using the form 
normally. 

Detail Areas 
Many forms in EnterpriseOne software contain detail areas. Detail areas display data. Depending on 
the application, you might be able to add, change, or delete data in the detail area as well. 

When you first launch an application with a detail area, the detail area is empty. You must perform a 
search to fill the detail area. To perform a search, click Find. In many cases, if you click Find without 
providing any search criteria, the system assumes that you want to see all of the data in the underlying 
business view, and it displays the first few rows. Sometimes the system does not allow you to 
perform a search without first specifying some criterion. 

EnterpriseOne provides a variety of methods for defining search criteria. Most detail areas have a row 
of blank fields above the column headings. This row is called the QBE (Query By Example) row. By 
entering data in one or more of the fields in the QBE row before you click Find, you limit the search 
based on what you entered. For example, in an application that lists employee information, if you 
enter Abbot in the field over the Last Name column, the system returns only those employees whose 
last name is Abbot. You can limit searches even further by entering data for other columns. If the 
detail area in this example had a column for city, for instance, you could also enter a city name, and 
then the system would return only those employees whose last name is Abbot and who live in the 
indicated city. 

In addition to the QBE row, many forms also include fields above the detail area. Enter data in one or 
more of these fields to limit the search as noted above. Additionally, some forms also include radio 
buttons or check boxes which can help you limit a search in a particular way. For example, if you 
were looking at sales orders, the form might contain a check box that allows you to exclude 
incomplete orders from the list. 

In the QBE row and in fields, you can usually use a * as a wildcard character. To return to the initial 
example, if you wanted to view all employees whose last name started with the letter M, you would 
enter M* in the Last Name column. Furthermore, many fields include a visual assist: a flashlight, a 
calculator, or a calendar. Click the visual assist to help you find or calculate a valid value for the field. 
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In all cases, search criteria is additive. That is, if you enter search criteria in the QBE row and the 
fields above the detail area, and you select other options, the system returns values based on all of that 
criteria. If a field is inactive (grayed out), then you cannot limit the search based on it. 

Depending on how your system administrator has configured it, the system might load only a few 
rows of data into the detail area at a time. If more data rows exist than currently appear, the system 
displays a row counter and up and down arrows at the top of the detail area. Use the up and down 
arrows to load more data or to return to a previously loaded detail area set. The counter tells you 
where in the list you are. For example, when you first load a detail area, the counter might say 
Records 1–10. When you click the down arrow, the system loads the next ten rows and the counter 
says: Records 11–20. 

To work with a specific row in the detail area, click the radio button or check box to the left of the 
row. The system highlights the row in the detail area to show that you have selected it. Then click 
Row to view the list of options for working with that data, including viewing any attachments to the 
row. If the detail area uses check boxes instead of radio buttons, you can select several rows at once. 
However, when you select multiple rows, you might not be able to choose the same options in the 
Row menu as you do when you select only one row. 

Some detail areas only display data. Others allow you to enter data, but with the aid of a separate 
form. However, smaller detail areas might allow you to enter data directly into the detail area. In this 
last case, you can load data into the detail area manually or by importing the contents of a Microsoft 
Excel spreadsheet. To do so, the range that you specify in the spreadsheet should exactly match the 
columns in the detail area. Most detail areas also allow you to export their contents to a Microsoft 
Excel or Word file as well. 

Finally, you can customize how a detail area looks. You can maximize the detail area so that it takes 
up most of your screen. You can change a column’s color, and you can apply color and formatting to 
a column’s text. You can define which columns to display in what order, which columns to sort on, 
and how wide a column should be. You can create multiple detail area formats for a single form so 
that you can view the data in different ways. 

► To export detail area contents to Microsoft Excel or Word 

1. Launch an application with a detail area, and then use Find to load the detail area with 
records. 

2. Perform one of the following tasks: 

• To export the detail area contents to Excel, click Tools and select Export To Excel. 

• To export the detail area contents to Word, click Tools and select Export To Word. 

3. Using the Export Assistant, specify the range of data that you want to export by clicking the 
first and then the last cell in the range. 

For example, if the detail area has four columns and three rows of data, but you want to 
export only the first three columns and the first two rows, you click the first cell in the first 
row and then the third cell in the second row. 

Use the scroll bars in the detail area to bring cells into view. The system loads only a few 
rows at a time. Use the up and down arrows at the top of the detail area to load more rows or 
to return to a previously loaded row set. 

Click Reset Selection if you clicked in the wrong cell. 
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4. Click Continue. 

The system exports the detail area contents that you selected to the appropriate file type and 
displays it. 

► To import a Microsoft Excel spreadsheet into a detail area 

1. Launch an application with a detail area that allows you to enter data directly. 

2. Click Tools and select Import from Excel. 

3. On Import from Excel Assistant, click Browse and browse to the Excel spreadsheet that you 
want to import. 

4. Complete the following fields: 

• Worksheet to import from 

Enter the name of the worksheet containing the data that you want to import. 

• Starting Cell Col 

Enter the spreadsheet column letter containing the first cell in the range of data that you 
want to import. 

• Starting Cell Row 

Enter the spreadsheet row number containing the first cell in the range of data that you 
want to import. 

• Ending Cell Col 

Enter the spreadsheet column letter containing the last cell in the range of data that you 
want to import. 

• Ending Cell Row 

Enter the spreadsheet row number containing the last cell in the range of data that you 
want to import. 

5. Click Import. 

The system imports the data that you selected. 

► To create a grid format 

If you want to recall the default format, save the original grid format before you save a new format. 
Otherwise, you must remove the new format, exit the application, and then access the application 
again to view the default grid format.  

1. Launch the application for which you want to create a new grid format and click Customize 
Grid.  

2. On Select Grid Format, click Create.  

3. Enter a name for the format in Grid Format Name. 

4. Complete the rest of the options as desired, and click OK. 

5. To use the grid format as the default format for pervasive devices, click the format that you 
created and choose Default for Mobile Device. 
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6. Click Close. 

► To create a grid format for pervasive devices 

1. Using the Web client, launch the application for which you want to create a grid format for 
pervasive devices. 

2. Click Customize Grid and choose the format that you want to use for pervasive devices. 

If you haven’t created the format, do so now. Follow the same steps for creating the format 
that you use for creating a Web-based format. However, keep in mind the limited space and 
color options offered by most pervasive devices when you decide about columns to display, 
column widths, column and text colors, and so forth. 

3. Click Default for Mobile Device and click Close. 

► To apply a grid format 

On any form with a grid, choose a grid format from the drop-down list next to Customize Grid. 

You must create one or more grid formats before you can apply a grid format. 

► To change a grid format 

1. Launch the application containing the grid format that you want to change and click 
Customize Grid. 

2. On Select Grid Format, choose the grid format that you want to change and click Modify. 

3. To change the name of the grid format, enter a new name in the Grid Format Name field. 

4. Change other elements of the grid as desired and click OK. 

5. Click Close. 

► To delete a grid format 

1. On any form with a grid, click Customize Grid. 

2. On Select Grid Format, choose the grid format that you want to delete and click Delete. 

The grid format disappears from the list. 

3. Click Close. 

► To hide or show grid columns 

1. Launch the application containing the grid that you want to change. 

2. Click Customize Grid and either create a new format or select an existing one to modify. 

3. On Customize Grid, scroll to the Display and Order section. 

4. To prevent a column from showing on the grid, choose it in the Display and Order list, and 
then click the left arrow. 

5. To make a column appear on the grid, choose it in the Available Columns list, and then click 
the right arrow. 
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6. Use the up and down arrows to change the order in which the system displays the columns on 
the grid. 

7. When finished, click OK, and then click Close. 

► To rearrange grid columns 

1. Launch the application containing the grid that you want to change. 

2. Click Customize Grid and either create a new format or select an existing one to modify. 

3. On Customize Grid, scroll to the Display and Order section. 

4. In the Display and Order list, click a column name and use the up and down arrows to move 
it up or down in the list. 

The system displays the columns in the list in the order in which they appear from top to 
bottom. In other words, the column at the top of the list appears first on the grid, the column 
second from the top appears second on the grid, and so forth. 

5. Repeat step 4 for any other columns that you want to move. 

6. When finished, click OK, and then click Close. 

► To set grid color and font 

1. Launch the application containing the grid that you want to change. 

2. Click Customize Grid and either create a new format or select an existing one to modify. 

3. On Customize Grid, scroll to the Display and Order section. 

4. Click a column name in the Display and Order list. 

The column name appears in the Selected Column field. 

5. To apply a background color to the column, click a color in the pallet under Column Color. 

The hexadecimal value for the color that you chose appears in the Column Color field. 

6. To apply a color to the text in the column, click a color in the pallet under Text Color. 

The hexadecimal value for the color that you chose appears in the Text Color field. 

7. To apply a font style such as bold or italics to the text in the column, click the styles that you 
want to apply in the Text Options list. 

8. Click Update Style. 

The system updates the Selected Column field to show you how your choices will look. The 
system also places a plus sign next to the column name in the Display and Order list. This 
symbol indicates that user-defined formatting will be applied to the column. 

9. Repeat steps 4–8 to apply formatting to additional columns in the grid. 

10. When finished, click OK, and then click Close. 
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► To change grid column width 

1. Launch the application containing the grid that you want to change. 

2. Click Customize Grid and either create a new format or select an existing one to modify. 

3. On Customize Grid, scroll to the Display and Order section. 

4. Click a column name in the Display and Order list. 

The column name appears in the Selected Column field. 

5. Enter a percentage value in the % Column Width field. 

This value is the percentage of the space that you want the system to allot to the column 
based on the width defined for the data item on which the column is based. You can enter a 
value between 25 and 400. 

6. When finished, click OK, and then click Close. 

► To change the sort sequence of a grid 

1. Launch the application containing the grid that you want to change. 

2. Click Customize Grid and either create a new format or select an existing one to modify. 

3. On Customize Grid, scroll to the Data Sequencing section. 

4. If you want to sort on a column, click the column name in the Available Columns list, and 
then click the right arrow. 

The system moves the column name from the Available Columns list to the Sequenced 
Columns list. 

A column must be included in the grid—that is, its name must appear in the Display and 
Order list—before you can sort on it. 

5. If you do not want to sort on a column, click the column name in the Sequenced Columns list, 
and then click the left arrow. 

The system moves the column name from the Sequenced Columns list to the Available 
Columns list. 

6. To rearrange the order of sort precedence, use the up and down arrows under the Sequenced 
Columns list to rearrange the column names. 

The system first sorts by the column at the top of the list, then by the column second from the 
top, and so forth. 

7. To sort column values in ascending order, click the column name in the Sequenced Columns 
list and click Ascending. 

If you leave the Ascending box blank, the system sorts the column in descending order. 

An A appears next to the column names to be sorted in ascending order, and a D appears next 
to the column names to be sorted in descending order. 

8. When finished, click OK, and then click Close. 
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Media Object Attachments  
EnterpriseOne media object and imaging features allow you to attach information to a program, 
including information that might currently exist as a paper-based document. For example, you can use 
a text attachment to explain special circumstances regarding a journal entry. The media object feature 
allows you to attach the information to EnterpriseOne software programs, forms and rows, and Object 
Librarian objects. The imaging feature, within Media Objects, provides flexibility for creating a more 
efficient method of information storage.  

Use Media Objects to link information to programs, either to individual rows in a grid or to a form. 
The following list describes the types of information that you can attach to a detail area row or to a 
form: 

Text  Media Objects provides a word processor that lets you create a text-only 
attachment. For example, you could use a text attachment to provide specific 
instructions for a form or additional information about a record.  

Image  Images include files such as Windows bitmaps, GIF, and JPG files. These files 
might represent electronically created files as well as scanned images of paper-
based documents. For an image to be available to be attached, your system 
administrator must first add it to an image queue. 

Object Linking 
and Embedding 
(OLE)  

Media objects can be files that conform to the OLE standard. OLE allows you to 
create links between different programs. Using these links, you can create and edit 
an object from one program in a different program. EnterpriseOne software 
provides the links that you need to attach OLE objects.  

You attach OLE media objects at the base form level. Media objects attached at 
this level are attached to a form and not to any data that might appear on the form. 
You can attach media objects to a grid row or a form, but the files themselves 
exist in separate directories. The only file information included with the program 
to which the OLE links is the path to the supporting file.  

You can use only OLE objects that you properly register and install as OLE 
objects through Windows.  

Uniform 
Resource 
Locators 
(URL)/Files  

Media objects can be links to web page URLs or other related files. When a 
developer attaches a URL media object to a control object on a form, the web 
page appears as part of the form. When a user attaches a URL to a form or Object 
Librarian object, the media object acts as a link to the URL. Files can reside in an 
image queue, or you can attach a local or networked file. 

When you attach a media object to a form, the attachment might not be available if you access 
different data on the form. For example, if you attach a media object to a form that contains data for 
order number 2002, this attachment does not appear on the form that appears when you access data 
for order number 3003. The base form is the same for both order numbers, but the data associated 
with the form is specific to each order number. The order number represents the key to the location 
where an attachment is stored.  

If attachments exist for a form, a paper clip icon appears at the right of the status bar when you open 
the form. For an OLE object attached at the base form level, a document icon appears at the right of 
the status bar.  
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When you first load a grid, grid rows do not indicate whether attachments exist for the corresponding 
records. To determine whether attachments exist for any of the records, you must search for the 
attachments. The system searches for attachments only on records currently loaded into the grid. 
When you click the Find button to refresh the records in the grid or to display new records, the form 
resets the attachment’s view status. You must search again to display the attachments for the grid 
records.  

You use the Media Object Viewer to examine media objects already attached to an object and to 
attach new media objects to it. The Media Object Viewer workspace is split into two panels. The left 
panel is the icon panel and the right panel is the viewer panel. Icons for any files previously attached 
to the record appear in the icon panel. To view an attachment, you click its icon, and the system 
displays its contents in the viewer panel. An object can have multiple attachments. 

You can use templates to create a format for a frequently used media object. A template might 
include attachments of its own, such as images. For example, you can create a letterhead and a 
standard form for a memo. You system administrator creates templates. 

See Also 
� Media Object Attachments in the EnterpriseOne Web Client Guide for information on how to 

attach media objects in the Web client 

� Working with Templates in the Foundation Guide for information about how to create text 
templates 

� Processing Media Objects in the Form Design Aid Guide for information about how a 
software developer sets up a form to handle media objects 

� Media Objects and Imaging in the System Administration Guide for information about how a 
system administrator configures EnterpriseOne software to enable media objects 

► To view attachments 

1. Launch an application with a grid and click Find to fill the grid with records. 

2. Click the button with a magnifying glass and a paperclip on it (the button is left of the column 
headings). 

The system marks the rows that have attachments by displaying a paperclip on the buttons on 
the left of the grid. 

Each time you refresh, perform a search, or move back to view a previous record set, you 
must search for attachments again. 

3. Click a button with a paperclip icon to view the attachments for that row. 

4. On Media Object Viewer, click the object in the left column corresponding to the media 
object that you want to view. 

5. When finished, click Cancel. 

► To attach text 

1. Launch an application with a detail area and click Find. 

2. For the row to which you want to add an attachment, click the button left of the grid. 

3. On Media Object Viewer, click Text. 
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4. In the viewer panel, type the desired text. 

You can use the formatting tools at the top of the viewer panel to format your text.  

5. Click Back to return to the application. 

► To attach text using a template 

1. Launch an application with a detail area and click Find. 

2. For the row to which you want to add an attachment, click the button left of the grid. 

3. On Media Object Viewer, click Text. 

The system creates a new, blank text object. 

4. Click Templates. 

5. On Work With Media Object Templates, click Find to load the grid. 

6. Find the template that you want to use and click Select. 

Media Object Viewer appears with the template contents pasted into the viewer panel. 

7. In the viewer panel, type the desired text. 

You can use the formatting tools at the top of the viewer panel to format the text of your note.  

8. To return to the application, click Back. 

► To attach an image 

1. Launch an application with a detail area and click Find. 

2. For the row to which you want to add an attachment, click the button left of the grid. 

3. On Media Object Viewer, click Image. 

4. Choose an image queue from the drop-down list. 

5. Click the image that you want to attach. 

To preview images, click Preview and then click the image. 

6. Click Add. 

7. To return to the application, click Back. 

► To attach a URL or file 

1. Launch an application with a detail area and click Find. 

2. For the row to which you want to add an attachment, click the button left of the grid. 

3. On Media Object Viewer, click URL/File. 

4. To attach a file residing in an image queue, perform the following steps: 

a. Click Select Queue. 

b. Choose an image queue from the drop-down list. 

c. Click the file that you want to attach. 
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To preview files, click Preview and then click the file. 

5. To attach a file residing in another location or a URL, perform the following steps: 

a. Click Select URL/File. 

b. Enter the URL or File name and location or click Browse to browse for the file. 

c. To preview the file, click Preview URL/File. 

6. Click Add. 

7. To return to the application, click Back. 

► To attach an OLE object 

1. Launch an application with a detail area and click Find. 

2. For the row to which you want to add an attachment, click the button left of the grid. 

3. On Media Object Viewer, click OLE. 

4. On Insert Object, to create a new object, choose an object type, and then click OK.  

Selections vary from system to system depending on what the system administrator installs 
on your workstation and on the network.  

5. Create your object.  

6. To attach an existing object, choose Create from File, locate the object on your system, and 
then click OK.  

Depending on whether you create an object or attach a preexisting object, the application 
associated with the object appears in the viewer panel to display either a blank workspace or 
the preexisting object.  

The menu bar displays the menus for the application from which you call the object. For 
example, if you select an Excel document, the menus for Excel appear on the menu bar.  

7. To return to the application, click Back. 

► To remove an attachment 

Note 

When you remove an attachment from an object, you break the connection between the object and the 
media object. The media object itself is not deleted as a result of your removing its attachment to an 
object. 

 

1. Launch an application with a grid and click Find to fill the grid with records. 

2. Click the button to the left of the column headings with a magnifying glass and a paperclip on 
it. 

The system marks those rows that have attachments by displaying a paperclip on the buttons 
on the left of the grid. 

Each time you refresh, perform another search, or move back to view a previous record set, 
you must search for attachments again. 
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3. Click a button with a paperclip icon to view the attachments for that row. 

4. On Media Object Viewer, click the object in the left column corresponding to the media 
object that you want to delete. 

5. Click Delete. 

The icon for the media object disappears. 

6. When finished, click Cancel. 
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Application User Interface  

Features of the application user interface include the following:  

• Visual assists, which display specific values for a given field on an application form  

• Exit bar, which provides icon-based access to areas within the system, such as messaging, 
media objects, and forms related to the application  

• Online help, which provides conceptual overviews and step-by-step procedures for 
completing tasks  

• Form types, which establish how each form functions  

• Grids, which display records  

Understanding the Application User Interface  
The application user interface includes EnterpriseOne application forms. From Task View Explorer, 
you can open application workspaces that provide access to EnterpriseOne applications through the 
use of forms. The application workspace is the area in which all related forms within an application 
appear.  

Within certain applications, you can use the modeless processing feature. Modeless processing refers 
to the ability to move between open forms in an application by choosing the form with a mouse click. 
For example, from Address Book, choose Daily Processing, and then choose Address Book 
Revisions. Address Book Revisions allows access to Work with Addresses. After choosing a record, 
you can open the Phones and Who's Who forms from the Row menu. You can move back and forth 
between these forms by clicking the appropriate form. In addition, tabs appear at the bottom of the 
application workspace. You can activate a form by clicking its tab. Within an application, you can 
move between forms and display information related to the form in order to assist you with your daily 
business needs.  

See Also 
� Working with Modeless Processing in the Foundation Guide 

Menu Bars  
The menu bar that appears on the application workspace corresponds to the active form. Menu bars 
provide pull-down menus to display options for an application. Use your mouse or the keyboard to 
choose menus and options on these menus. Depending on the type of form, the menus and options 
will change.  
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The functions that are available on the menu bar are defined as follows:  

File  From the File menu, you can Select, Find, Add, Copy, and Delete records, Print Screen, 
Print Setup, and Close the form.  

Edit  From the Edit menu, you can Cut, Copy, and Paste information to and from the 
Clipboard and choose to Undo the last action.  

Preferences From the Preferences menu, you can view the Exit Bar, attach external objects, 
customize the display of a form, and change the grid.  

Form  From the Form menu, you can access other forms that relate to your current form.  

Row  From the Row menu, you can access information that is specific to a row chosen in the 
detail area. For example, you can attach and view objects to a chosen record from the 
Row menu.  

Report  From the Report menu, you can access reports associated with the application.  

Window  From the Window menu, you can choose alternate views to display the open forms in 
an application.  

Help  From the Help menu, you can access online help and choose to display any errors, if 
applicable.  

Toolbars  
The toolbar provides you with buttons for executing frequently used commands. When you move 
your cursor over a button, the system provides a brief description in a yellow Hover Help box below 
your cursor and a complete description in the status bar of the form.  

EnterpriseOne software provides standard toolbar features and toolbar display formats for each form. 
However, you can customize the features and the display of the toolbar to suit the functionality for 
each individual form. You must be familiar with the use of the buttons on the toolbar to operate the 
EnterpriseOne system. The functions of the standard toolbar buttons are described as follows:  

Select  Selects one or more records, and opens corresponding forms.  

Find  Displays all the entries from your database that match the search criteria that you 
specify.  

Add  Opens a new form where you can add a new record.  

Copy  From a Browse form, the Copy button copies the entire record. The system copies all 
fields except those that are unique to the existing record into a new record.  

From a Revision form, the Copy button selects the fields for the new form. You must 
enter data in all other fields. You can modify those fields that you copied from the 
existing record onto the new form.  
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Delete  From a Browse or Revision form, the Delete button deletes the entire record.  

Depending upon the application that you are using, the Delete button might also 
remove related information. For example, if you delete an Address Book record, the 
system also deletes the phone numbers for that record.  

See your application user guide for information about deleting child records.  

Close  Closes the form.  

OK  Accepts the data in the current form.  

Cancel  Ignores any additions, revisions, or deletions that you made to the current form, closes 
the form, and moves to the previous form.  

About Displays the Online-Support Information form, which provides you with information 
about the current form, such as the program and form IDs. If you encounter a problem 
with the software, you can log an issue by clicking the Log Issue button, which 
accesses a form that you can complete send electronically to PeopleSoft. On this form, 
you can log information about the particular issue. 

The Links toolbar provides buttons that access other areas in EnterpriseOne software and the Internet. 
The hyper-button displays a down arrow; when you click the down arrow, a drop-down menu 
displays the same options that exist on the menu bar, as well as a Tools menu with a link to other 
features, including the Internet.  

The function of the hyper-button varies from form to form. For example, it could open a data entry 
form or it could open a form that allows you to attach objects to a record.  

The default form that you open when you click the hyper-button changes to the last form that you 
accessed using the down arrow. This feature allows you to set the hyper-button with a link to the form 
that you use most frequently.  

Exit Bars  
The Exit bar is a movable, dockable toolbar that provides quick access to other applications and 
forms within the current application. The Exit bar also accesses an online calculator and calendar, 
messaging, and the Internet, and provides the option to create a shortcut to the form you are viewing. 
To turn the Exit bar on and off, choose Exit Bar from the Preferences menu.  

The following categories appear on the Exit bar:  

• Tools  

• Menus that appear between the Preferences and the Help menu (except for the Window 
menu)  

The Row and Report categories on the exit bar provide the same options as the corresponding Row 
and Report menus on the menu bar. The options for these buttons appear on the Exit bar if the 
corresponding menu bar option is available. The Tools category on the exit bar is not represented on 
the menu bar; however, you can access the Tools menu by clicking the down arrow on the Links 
toolbar and then choosing Tools.  
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The Tools category provides the following standard buttons:  

Calendar  Displays a calendar. On the calendar, use the mouse or keyboard to choose a date, and 
then click OK.  

Calculator  Displays a calculator. On the calculator, use the mouse or keyboard to perform the 
calculations and then click OK.  

Work 
Center  

Accesses the Work Center, which is the application that you use for EnterpriseOne e-
mail messages.  

Internal 
Mail  

Displays the Send Internal Mail form, which you can use to send messages to 
EnterpriseOne software users within your enterprise.  

External 
Mail  

Displays the Send External Mail form (if you previously set up your messaging for 
external mail), which you can use to send messages to people outside of your 
EnterpriseOne software enterprise.  

Internet  Provides a link to the Internet. Click this button to open your Internet browser.  

Create 
Shortcut  

Creates a shortcut on your local machine's desktop of the form that you are viewing. 
For example, if you are in the Work With Addresses form and you click the Create 
Shortcut button, a shortcut that will open the Work With Addresses form appears on 
your desktop. 

Send 
Shortcut  

Displays the Send Internal Mail form with a shortcut attached to the message of the 
form you are viewing. You can then send the shortcut to another EnterpriseOne 
software user in your enterprise.  

See Also 
� Messages and Queues in the Foundation Guide for complete information on messaging and 

the Work Center 

Pop-up Menus  
You can access some information directly on the form using a pop-up menu. When you click the right 
mouse button in certain areas of the form, such as the grid, you can display a menu that provides 
options that are specific to that area of the form. For example, when you customize the grid, you can 
display a pop-up menu that allows you to choose options for changing the features of the grid, such as 
the font and background color. 

Scroll Bar  
A scroll bar appears on the right side or bottom of a form when more information is available than 
will fit into the viewing area of the form. Use this bar to scroll to the additional information. Single-
click the buttons to move up or down one record at a time; click and hold the mouse button down to 
scroll through more than one record.  

Within the scroll bar is the scroll box, which shows the position of information visible in the form. 
Either click and hold the scroll box and move it, or single-click in the areas on either side of the box.  
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Visual Assists  
Visual assists provide you with a predetermined list of selections that are available for a specific field. 
Visual assists also allow you to access supplemental tools available on your forms, such as the Search 
button, Calculator button, and Calendar button. These tools automate the process of inputting 
information into fields. The calculator and the calendar are also available from the Tools menu. 

Search  

The search button is available in appropriate fields on certain forms. It helps you search for specific 
items by providing lists of valid values, such as address numbers and lists of codes that categorize 
your records. This button might be represented by icons.  

For example, suppose one of your job requirements is to perform standard invoice entry. When you 
enter the Standard Invoice Entry form, you are not sure of the customer number. Clicking the 
Customer field causes the visual assist to appear. Clicking the visual assist brings you to a search 
form from which you can search for the customer name.  

Calculator  

The calculator visual assist displays a calculator to use for arithmetic operations.  

Calendar  

The calendar visual assist displays a calendar. You can use the calendar to choose a specific date.  

Status Bars  
EnterpriseOne provides a status bar that appears at the bottom of most ERP forms. Status bars 
provide information about your current location in the software.  

The following information appears on the status bar:  

• Descriptions of menu options  

• Status of record retrieval and a Stop button to end retrieval  

• Error messages  

Online Help 
Online help provides you with information about EnterpriseOne tools, as well as information about 
how to use EnterpriseOne reports and applications to complete a variety of tasks.  

55 



You can access help from the following options on the Help menu:  

Contents  Accesses the EnterpriseOne help system, which contains all of the EnterpriseOne 
guides. You can use the help system to search for a topic throughout all of the 
guides, or search for a specific topic within a particular guide.  

Display Errors  Shows the first error or warning message for a form.  

Next Error  Moves to the subsequent error in a form.  

About 
EnterpriseOne  

Displays information about the menu or form, including program and form ID 
information. If you encounter a problem with the software, you can log an issue by 
clicking the Log Issue button, which accesses a form that you can complete and 
send electronically to EnterpriseOne. Log information about your particular issue 
on the form. 

  

Accessing Field-Level Help  

Use field-level help to see a detailed description about a field within a form. The description defines 
the field and provides valid values and variables, such as field length.  

► To access field-level help  

1. On any application form, place the cursor in the field about which you want information.  

2. Do either of the following:  

• Press F1.  

• Click the right mouse button and, from the menu that appears, choose What's This.  

A pop-up box containing information about the field appears.  

3. Click the form or press any key to remove the pop-up box.  

Error Messages  
If you enter a value that the system does not recognize, the system highlights the field in red and 
displays the following in the status bar:  

• A description of the error  

• The number of errors and warnings for the current form  

If more than one error or warning exists on a form, you can press F7 to move to the next error 
or warning. The description of the error or warning appears on the status bar at the bottom of 
the form. You can also access an error message window to review error messages.  
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► To review error messages  

1. On any form that displays an error, do one of the following:  

• From the Help menu, choose Display Errors 

• Press F8 

• Click the Display Errors button on the toolbar  

• Click the red stop-sign icon at the bottom right of the form  

2. Choose an error in the error message window at the bottom of the form, click the right mouse 
button, and choose Full Description from the pop-up menu.  

The cause of the error and how to resolve it appears.  

3. Click anywhere on the desktop or press any key to close the description.  

4. Click the right mouse button, and then choose Detail to review the error identification number 
and the functions that the error affects.  

5. On Error and Warning Detail, after reviewing the information, click Close to exit the error 
message information.  

6. To close the error message window, click the right mouse button and then choose Close.  

Before you close the error message window, you have the option of activating an audio signal 
that alerts you with an audible beep when an error occurs.  

7. To activate the signal, click the right mouse button and then click Error Beep. 

A check mark appears next to Error Beep on the pop-up window. Click Error Beep again to 
remove the check mark.  

► To change the error message window  

1. On a form with an error message window, click and hold the left mouse button slightly above 
the error message window.  

A box appears around the message window.  

2. Move the message window to the desired location and then release the left mouse button.  

The message window detaches from the ERP form.  

3. Resize the window by placing the cursor over the edge of the message window. When the 
cursor changes to a double arrow, resize the window.  

You can also resize the window while it is still attached to the ERP form. Place the cursor 
over the dark line between the window and the form. When the cursor changes to a double 
arrow, resize the window.  
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Form Types  
Applications use a variety of form types. The characteristics of each form type remain the same, 
regardless of the application in which you access the form.  

Find/Browse Form 

The Find/Browse form provides the entry point to most applications. It contains an optional query-by-
example (QBE) line so that you can search any field in the grid. The standard title for a Find/Browse 
form begins with “Work With” followed by information that is specific to the business task. You 
cannot add or change existing records on a Find/Browse form.  

Find/Browse forms allow you to do the following:  

• Search, view, and choose multiple records in a grid  

• Exit to another form to add, change, or view a record  

Search/Select Form  

Use the Search/Select form to locate a value for a field. The grid displays valid values that are stored 
in a database table. When you choose a value from the grid and click the Select button, that value is 
automatically placed in the field. For example, when you need to enter a user defined code into a 
field, the visual assist appears, allowing you to access a Search/Select form that displays a list of user 
defined codes. You can select an item from the list and place it in the appropriate field. You cannot 
edit the information that appears on this form.  

Header Detail and Headerless Detail Forms  

The Header Detail and Headerless Detail forms include a detail area, the OK button, and the Cancel 
button. You can change multiple records using these forms. The Header Detail form includes 
information from two different business views to provide more depth on the information that appears 
on the form. The Headerless Detail form provides information from only one table. Data that is 
common to all the records in the grid displays at the top of the form. 

Header Detail and Headerless Detail forms allow you to do the following:  

• Display multiple records  

• View records  

• Add records  

• Change records  

• Delete records  

Fix/Inspect Form  

The Fix/Inspect form does not include a detail area. If a record was chosen on a previous form, the 
Fix/Inspect form displays data for that record. If you are adding a record, the Fix/Inspect form is 
empty, except for any default values.  
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Fix/Inspect forms allow you to do the following:  

• View a single record  

• Add a record  

• Change a record  

Parent/Child Form  

The Parent/Child form presents parent/child relationships in an application on one form. The left 
portion of the form presents a list of items. The right portion of the form displays information that 
relates to the selected item in the left portion of the form. The Parent/Child form supports the ability 
to drag and drop items from one area to another. This form includes Select and Close buttons.  

You can resize the display areas according to your personal preferences.  

Message Box  

The message box contains information about processing that occurs when you work with 
EnterpriseOne software. For example, when you delete a record, a Confirm Delete message box 
appears to ask if you are sure that you want to delete the object. The message box might also include 
information about an event that occurs while you work with the system.  

Tab Controls for Forms 
Some forms have tabs. Each tab can display a logical grouping of fields. This grouping occurs within 
those applications that contain many fields that can be logically grouped on tabs. Tabbed groupings 
make finding and completing fields easier. See your application guide for information about tabs 
within a specific application.  

To move among tabs, do one of the following:  

• Single-click a tab header; it will appear in front of the others.  

• Press the left and right arrow keys on your keyboard when the cursor focus is on the tab 
header. You can move the focus to the tab header by tabbing through the last field on that tab. 

• Press the CTRL+Tab keys or the CTRL+Shift+Tab keys. 

Do not confuse these tabs with EnterpriseOne Solution Explorer tabs and the grid format tabs that you 
can create.  

See Also 
� Creating Tabs in the Foundation Guide for information about Solution Explorer tabs 

� Creating Formats in the Foundation Guide for information about formatting grids 
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Working with the Application User Interface  
EnterpriseOne provides features that allow you to personalize your application user interface. 
Additional features, such as the exit bar and an online calculator, simplify the processes necessary to 
complete your daily business requirements.  

Changing the Display of the Toolbar  
You can move the Links toolbar to display more of the toolbar or to display below the main toolbar.  

► To change the display of the toolbar  

1. On a form toolbar, click and hold the left mouse button on Links.  

2. Do one of the following:  

• Move the cursor left or right to display more or less of the links section.  

• Move the cursor down to display the full Links section below the toolbar buttons.  

Customizing Menu Bars and Toolbars  
You can customize the appearance and performance of each form by customizing menu bars and 
toolbars. When you customize your toolbar, the Hint box and the Status Bar Help box provide 
information that describes the help messages that appear on the actual form for a certain button. The 
Buttons box displays the available buttons for each category.  

The following restrictions apply when you customize your menus and toolbars:  

• You cannot add more than one menu or toolbar.  

• Although you can remove menu options and toolbar items at the form level, you cannot 
delete an existing menu or toolbar item from the system.  

• You cannot duplicate an item that already exists on a menu.  

When you see an ampersand (&) on the Customize form, the letter that directly follows the 
ampersand represents the accelerator key for that menu bar command.  

► To customize toolbars  

1. On any form with a toolbar, from the Preferences menu, choose Customize.  

2. On Customize, click the Toolbar tab. 

3. On Customize, choose a category from the Categories list.  

4. Click and drag items from the Buttons box onto the toolbar.  

5. To remove a button from the toolbar, click and drag the button off the toolbar.  

► To customize menu bars  

1. On any form with a menu bar, from the Preferences menu, choose Customize.  

2. On Customize, click the Menubar tab.  
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3. From the Categories list, choose a menu to which you want to add an item.  

The Menu Items list displays the available items and separator bars. The list to the right of the 
form shows the items currently on the menu.  

4. From the Menu Items list, choose the item that you want to add.  

5. In the list box to the right, choose the item below which you want the new item to appear. If 
you do not choose an item, your new item appears at the bottom of the list.  

6. Click the right-pointing arrow button to add your menu item.  

The selected item appears below the highlighted item in the list to the right. An ampersand 
before the letter represents the accelerator key. If you do not choose an item in the list of 
current menu items below which you want your new menu item to appear, the new menu item 
is added to the end of the list of current menu items by default.  

7. To remove a list item, choose the item in the list on the right, and then click the left-pointing 
arrow button.  

8. Click Close and verify that the changes were made. 

Working with Modeless Processing  
In some applications, you can open multiple forms and move among them to exchange information. 
For example, in Address Book, you can open the Phones and Who's Who forms from the Work with 
Addresses form to display all three forms at the same time. You can then verify that the information 
on each of the forms corresponds to the information on the others. The Window menu allows you to 
arrange the open forms.  

► To move between forms  

On a form that supports modeless processing, with multiple forms open, do one of the following:  

• Click a tab at the bottom of the form to bring a form to the front.  

• From the Window menu, choose the name of the form to bring the form to the front.  

• Click a partially hidden form to bring the form to the front of the display.  

► To arrange the forms  

1. On a form that supports modeless processing and with multiple forms open, from the 
Window menu, choose one of the following:  

• Cascade  

• Tile Horizontally  

• Tile Vertically  

2. Move the cursor over the edge of a form until the cursor becomes a double arrow.  

3. Click and hold the left mouse button, and then move the cursor until you achieve the desired 
width.  

61 



Working with the Exit Bar  
You can display the exit bar for an application to provide easy access to other forms in the 
application, other applications, an online calendar and calculator, messaging, and the Internet. 
Initially, the exit bar appears at the left of the parent window, but you can move the bar to the right or 
detach the bar from the form. If you detach the bar, when you leave the form and then return, the exit 
bar appears in its default position at the left of the form. You can also resize the exit bar. The system 
saves your exit bar preferences when you log off.  

Depending on the current form within an application, you can display the Tools bar and any menu 
that appears between the Preferences menu and the Help menu except for the Window menu. Options 
do not appear for the Form bar and the Row bar unless the Form menu or the Row menu appears on 
the menu bar for the active form.  

► To display the exit bar  

In any application, from the Preferences menu, choose Exit Bar.  

► To move the exit bar  

1. In any application with an exit bar, click and hold the border of the exit bar.  

2. Do one of the following:  

• Drag the box to the right side of the form.  

• Drag the box to the left side of the form.  

► To detach the exit bar  

In any application with an exit bar, do one of the following:  

• Double-click the border of the exit bar.  

• Click and hold the border of the exit bar and drag the gray box to the middle of the form.  

► To resize the exit bar  

1. In any application with an exit bar, move the cursor over the right edge of the exit bar until 
the cursor becomes a double-arrow.  

2. Click and drag the border until you achieve the desired width.  

► To open a function or application with the exit bar  

1. In any application with an exit bar, click a bar on the exit bar for the category that you want 
to display, such as Tools.  

2. On the active exit bar for any given button, click the button for the appropriate function or 
application.  
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Working with Visual Assists  
PeopleSoft software provides tools to help you with tasks that you might need to complete. For 
example, you can access an online calculator to place the result of a calculation in a numeric field, or 
you can access an online calendar to enter a specific date. When a record requires you to place a 
specific value in a field, you can use a visual assist to determine the valid values for the field.  

► To use the calculator  

Turn on Num Lock before you use the keyboard with the calculator.  

1. On any form with a numeric field that requires a calculation, click that field.  

2. Click the Calculator button.  

3. On Calculator, use the mouse or the keyboard to perform the calculation. 

If you use the numeric pad on the keyboard, Num Lock must be turned on. 

4. Click OK.  

The system displays the calculated value in the selected field.  

► To use the calendar  

1. On any form with a date field, click that field.  

2. Click the Calendar button.  

3. On the calendar, choose the correct month and year from the drop-down lists.  

4. Click the correct date in the calendar and then click OK.  

The system displays the date in the selected field.  

► To use the visual assist button  

1. When you click a field on a form and the visual assist button appears, click the visual assist 
button.  

One of the following form types appears:  

• A user defined code form  

• A record search form  

2. Choose a line and then click Select.  

The system displays your choice in the selected field on the previous form.  

► To access a visual assist in a header field 

1. In a field that accesses a visual assist, click the right mouse button. 

2. From the pop-up menu, choose Visual Assist. 

The appropriate visual assist appears. 
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► To access a visual assist in a detail field 

1. Click a field that accesses a visual assist, and then click the right mouse button. 

2. From the pop-up menu, choose Cell and then Visual Assist. 

The appropriate visual assist appears. 

Working with the Grid  
The grid includes columns, descriptive column headers, rows, and row headers. In general, each row 
represents one record. To customize the grid you can:  

• Create multiple views of information in which you can change the format of the rows and the 
columns  

• Change the font properties  

• Change the color properties  

• Detach and expand the grid to view more information at the same time  

• Adjust the magnification of the grid  

• Freeze specific columns or rows of information so that they remain in place as you scroll 
through the rest of the information  

After you customize your grid, you can create a format to save your changes based on your user ID. 
Then, the system will load your specific format whenever you log on to the system.  

The system allows you to export the contents of the grid into a Windows-based spreadsheet or word 
processing application. Conversely, you can import data from a spreadsheet into a grid in a 
EnterpriseOne application.  

You can also print the contents of the grid.  

Working with Grid Formats  
You can create grid formats to save the customized changes that you make to sort sequence, fonts, 
colors, and magnification. For example, you can create and save multiple formats to display different 
views of the same grid. A tab appears at the top of each newly created format. If you have multiple 
formats, you can move among views by clicking tabs.  

After you create your formats, you can rename them or delete them from your system. Your custom 
formats load in subsequent sessions on any workstation when you enter your user ID. In addition, you 
can create a chart or graph from the grid format that you create. 
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► To create grid formats  

Note 

To recall the default format, save the original grid format before you save a new format. Otherwise, 
you must remove the new format, exit the application, and then access the application again to view 
the default grid format. 

 

1. On any form with a grid, click the right mouse button in the grid to display a pop-up menu.  

2. From the pop-up menu, choose Format and then New Format.  

3. On Name Format, enter the name of the format. 

You can accept the name the system provides or enter your own.  

4. Choose Grid Format as the format type and then click OK.  

5. Click a tab to display that view of the grid.  

► To rename grid formats  

1. On any form with format tabs for a grid, choose a format tab.  

2. Click the right mouse button in the grid to display a pop-up menu.  

3. From the pop-up menu, choose Format and then Rename Format.  

4. On Rename Format, change the name of the format and then click OK.  

► To delete grid formats  

1. On any form with format tabs for a grid, choose a format tab.  

2. Click the right mouse button in the grid to display a pop-up menu.  

3. From the pop-up menu, choose Format and then Remove Format.  

The system removes the tab for the format that you delete.  

Customizing the Format of the Grid  
Format your grid to customize the sequence of the columns and rows by reordering the columns or by 
sorting the rows differently. For example, you might want to move a column that you use often from 
the end to the beginning. You can also change the size of columns and rows to display more 
information, or determine new sorting criteria to display records in a sequence more appropriate to 
your business needs. You can sort records by any column in the grid. Each format supports a sort 
sequence that is unique to the format.  

The Auto Return feature allows you to designate a column in the grid that sends you to the first cell in 
the next row when you tab out of a cell.  
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► To reorder grid columns  

1. On any form with a grid, click and hold down the left mouse button over the title of the 
column that you want to move.  

The cursor becomes a column with a double-arrow. 

2. Drag the column to the new position.  

3. Release the mouse button.  

The column moves next to the column over which you released the mouse button. 

► To change the sort sequence of a grid  

1. On any form with a grid, click the right mouse button in the grid to display a pop-up menu.  

2. From the pop-up menu, choose Grid and then Sequence.  

3. On Select Grid Row Sort Order, you can choose which columns that you want to use to sort 
your information by doing one of the following:  

• From the Columns Available list, choose a column, and then click the right-arrow button 
at the bottom of the form.  

The column appears in the Columns Sorted list.  

• To sort all of the columns, click the double-right-arrow button at the bottom of the form.  

• To remove a column, from the Columns Sorted list, choose a column and then click the 
left-arrow button (click the double-left-arrow button to remove all of the columns).  

The column appears in the Columns Available list.  

4. To change the sort sequence of the columns, from the Columns Sorted list, choose a column, 
and then click one of the following buttons on the toolbar:  

• Up  

Moves the column up in the sort order one column at a time.  

• Down  

Moves the column down in the sort order one column at a time.  

• Top  

Moves the column to the top of the sort sequence.  

• Bottom  

Moves the column to the bottom of the sort sequence.  

5. To change the order of the records in a column, from the Columns Sorted list, click the A or 
D field next to the column to toggle between the following values:  

• A  

The records appear in ascending order.  
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• D  

The records appear in descending order.  

6. Click OK.  

Your changes appear in the grid.  

► To resize grid columns 

1. On any form with a grid, move the cursor over the right edge of the column that you want to 
size.  

The cursor becomes a double-arrow.  

2. Click and drag the right edge to increase or decrease the width of the column.  

3. Release the mouse button.  

► To resize grid rows 

Note 

You can only size rows that have grid row headers. A row header is the field that can display and 
icon, such as a paperclip for attachments, to the left of the grid. 

 

1. On any form with a grid, move the cursor over the top edge of the row header for the row you 
want to size.  

The cursor becomes a double-arrow.  

2. Click and drag the top edge to increase or decrease the height of the row.  

3. Release the mouse button.  

The following icons can appear in the row header column of a grid to specify additional information: 

Lock  The lock above the first column indicates that you have moved into a protected field. You 
cannot change information in this field  

Paper 
Clip  

The paper clip indicates that a media object exists as an attachment to this record  

The paper clip icon only appears next to a record with attachments when you check for 
attachments  

See Also  
� Attaching Media Objects in the Foundation Guide to add text, images, object linking and 

embedding (OLE) objects, and shortcuts to records  
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► To set up Auto Return for a grid  

Note 

The Auto Return feature allows you to designate a column in the grid that sends you to the first cell in 
the next row when you tab out of a cell. For example, if you enter similar information into a large 
number of grid rows but you do not enter information into every column on the grid, you can arrange 
your columns into a specific order. Then you can set Auto Return on the last column into which you 
enter information so that when you tab out of a cell in that column, you continue entering information 
for the next row. You can set up Auto Return only on an input-capable grid. 

 

1. On any form with an input-capable grid, on the column you want to set as your last column, 
click the right mouse button to display a pop-up menu.  

2. From the pop-up menu, choose Column and then Auto Return.  

A colored line appears at the right edge of the column to mark the Auto Return at that 
column. Whenever you tab out of this column, the cursor moves to the first cell in the next 
row.  

3. To remove Auto Return, repeat the process in the Auto Return column. 

The colored line disappears and Auto Return is no longer set for the grid.  

Customizing the Appearance of the Grid  
You can customize the colors and fonts in the grid. You can do this to highlight specific information 
or to adjust for personal preferences. Also, you can change the magnification of the grid to increase 
the number of rows you can view at the same time or to bring important information into focus.  

► To change fonts for a grid  

Note 

You can change the fonts for individual columns or for the entire grid.  

 

1. On any form with a grid, in the column for which you want to change the font, right-click to 
display a pop-up menu.  

The cursor can be anywhere within the grid if you are changing the font for the entire grid.  

2. From the pop-up menu, do one of the following:  

• Choose Column and then Font to change column fonts.  

• Choose Grid and then Font to change grid fonts.  

The cursor must be on the column title to change the font of the title.  

3. On Font, choose a font and any additional attributes, such as style, size, color, and effects.  

4. Click OK.  
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► To change the background color for a grid 

Note 

You can change the background color for individual columns or for the entire grid.  

 

1. On any form with a grid, in the column for which you want to change the background color, 
right-click to display a pop-up menu.  

The cursor can be anywhere within the grid if you are changing the background color for the 
entire grid.  

2. From the pop-up menu, do one of the following:  

• Choose Column and then Color to change the column colors.  

• Choose Grid and then Color to change the grid colors.  

3. On Color, choose a color and then click OK.  

► To change the magnification of a grid  

1. On any form with a grid, right-click in the grid to display a pop-up menu.  

2. From the pop-up menu, choose Grid and then Zoom.  

3. On Zoom, choose a preset percentage from the Magnification box or complete the following 
field: 

• Custom 

4. Click OK.  

Freezing Columns and Rows  
Freezing allows you to lock some columns and rows into place so that they do not disappear from 
view while you scroll through wide and long lists, respectively. You can also freeze just the column 
title so that no actual records freeze. The system shows the frozen area with a heavy red line.  

► To freeze columns and rows  

Note 

When you freeze a row, all columns and rows above the row and to the left of the column are locked 
in place. A red line marks the frozen area. Also, you can freeze only the columns in the grid by 
performing the following tasks on the column title. However, to freeze any number of rows, you must 
freeze at least one column. 

 

1. On any form with a grid, in the column and row you want to freeze, right-click to display a 
pop-up menu.  

2. From the pop-up menu, choose Column and then Freeze/Unfreeze.  

A red line appears at the right edge of the frozen column and the bottom edge of the frozen 
row.  
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3. To verify the change, scroll to the right and scroll down.  

The frozen columns and rows remain in view.  

► To unfreeze columns and rows  

1. On any form with a grid, click the right mouse button to display a pop-up menu.  

2. From the pop-up menu, choose Column and then Freeze/Unfreeze.  

The red lines disappear.  

3. Test the system by scrolling to the right.  

Previously frozen columns now scroll out of the form.  

Maximizing the Grid  
You can maximize the grid to fill the parent window. The menu bar and toolbar remain visible above 
the grid. Restore the grid to return the form to its default appearance.  

► To maximize the grid  

1. On any form with a grid, click the right mouse button to display a pop-up menu.  

2. From the pop-up menu, choose Grid and then Maximize/Restore.  

The maximized grid expands to fill the parent window.  

3. Maximize or resize the parent window to display more of the grid.  

► To restore the grid  

1. On a form with a maximized grid, click the right mouse button to display a pop-up menu.  

2. From the pop-up menu, choose Grid and then Maximize/Restore.  

The form restores its default settings.  

Your form also restores its default settings when you close the form and then reenter.  

Exporting Data from the Grid  
You can export the contents of the grid into a third-party spreadsheet or word processing application. 
You also have the option to establish a hot link between an input-capable grid and a third-party 
spreadsheet. A hot link allows you to update data in two connected applications simultaneously. 
Thus, when you update data in your EnterpriseOne grid, your third-party spreadsheet data is also 
updated. If the EnterpriseOne grid does not allow you to enter information into it, you cannot 
establish a hot link with it.  

EnterpriseOne might offer a third-party application that you do not have installed on your 
workstation. If you try to access this application to export data, a message box informs you that the 
application is not available on your workstation.  
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► To export data from the grid  

1. On any form with a grid, click the right mouse button to display a pop-up menu.  

2. From the pop-up menu, choose Export and then choose a third-party application from the 
menu.  

If you choose a spreadsheet application, the following Export Assistant form appears.  

 

 

If you choose a word processing application, the following Export Assistant form appears:  

 

 

3. As necessary, complete the following:  

• Establish a "Hot Link" to a third-party spreadsheet if the EnterpriseOne grid is input-
capable. Otherwise, the hot link checkbox is disabled.  

• Export to a New Workbook.  

• Export to an Existing Workbook.  
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• Specify a worksheet name to export to.  

• Specify a spreadsheet cell address field.  

4. On the grid, choose the range of cells to export.  

5. Click Continue to begin the application and export the selected data.  

Importing Data into the Grid  
You can import data from third-party spreadsheet applications into an input-capable EnterpriseOne 
grid. You also have the option to establish a hot link between a third-party spreadsheet and an input-
capable EnterpriseOne grid. A hot link allows you to update data in two connected applications 
simultaneously. Thus, when you update data in your third-party spreadsheet, your EnterpriseOne grid 
is also updated.  

EnterpriseOne might offer a third-party application that you do not have installed on your 
workstation. If you try to access this application to import data, a message box informs you that the 
application is not available on your workstation.  

You must specify a range of cells to import from the third-party application into the grid. The 
convention that you should follow when you specify this range is "Ax:Bx." For example, to import a 
range of cells between cell D3 and cell G6, you need to type "D3:G6."  

► To import data into the grid  

1. On any form with an input-capable grid, click the right mouse button on the grid to display a 
pop-up menu.  

2. From the Import menu, choose a third-party application.  

3. On Open, complete the following:  

• File name  

• Specify a range of cells to import  

• Specify a worksheet name to import from  

4. If necessary, complete the following:  

• Files of type  

• Establish a "Hot Link"  

5. Click Open to send the data to the EnterpriseOne grid.  

Locked cells do not accept imported data.  

Printing the Grid  
You can print the contents of the grid directly to a printer. You can specify whether you want grid 
lines, row headings, or column headings to display. In addition, you can adjust margins for your 
printout.  

72 



► To print the grid  

1. On any form with a grid, click the right mouse button to display a pop-up menu.  

2. From the pop-up menu, choose Grid and then Print.  

3. On Page Setup, in the Titles and GridLines area, click one or more of the following options:  

• Row Headers 

• Column Headers 

• Print Frame 

• Vertical Lines 

• Horizontal Lines 

• Only Black and White  

The Preview area changes to reflect the options that you choose. 

4. In the Page Order area, choose one of the following options:  

• First Rows, then Columns 

• First Columns, then Rows 

5. In the Center on Page area, choose one or both of the following options: 

• vertical 

• horizontal 

6. If necessary, do the following:  

• Turn on the Save settings to profile option to save the settings for future print jobs. 

• Adjust the page margins in the Margins area. 

7. Click OK.  

Creating Charts and Graphs in a Grid  
You can create charts and graphs in the grid of any form to provide a graphical view of your data. By 
selecting different types of data to chart, you can easily view differences and relationships between 
items.  

Prerequisite 
� You must create a custom format for the grid. See Working with Grid Formats in the 

Foundation Guide. 

► To create charts and graphs in a grid  

1. On any grid with an established grid format, click the right mouse button to display a pop-up 
menu.  

2. From the pop-up menu, choose Format and then New Format.  

3. Enter the name for the format.  

4. Choose Graph as the type and then click OK.  
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For each format that you create, a tab appears at the top of the grid. Graph tabs contain a 
graphic icon.  

The Graph Assistant form appears.  

5. On the grid, choose the range of cells that you want to use as data to graph.  

Row data in the first column is always used for labeling the X or Y axis.  

6. On Graph Assistant, click Continue to draw the graph.  

A graph appears.  

Customizing Charts and Graphs in a Grid  
After creating a new chart or graph format, you can customize the new format by changing its type, 
such as changing it from a 3D pie chart to line graph. However, you cannot change text labels that 
contain information directly extracted from a record in the grid. The system copies the information 
from this label directly from the grid record.  

► To customize charts and graphs in a grid  

1. On the graph, right-click to choose one of the following graph types from the menu that 
appears:  

• 3D Bar 

• Vertical Bar 

• Stacked Bar 

• 3D Area 

• Area  

• Strata 

• 3D Pie 

• Pie 

• Line 
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User Overrides  

User Overrides Revision program (P98950) allows you to change the appearance of an application to 
fit the needs of your business. For some user overrides, such as an object linking and embedding 
(OLE) attachment to a form, no consequences exist when you upgrade your software because your 
user overrides are merged into the new release. For other user overrides, such as grid or toolbar 
formats, the system gives you the options of reconciling your user overrides with the new software or 
deleting your user overrides.  

Understanding User Overrides  
A user override changes only the appearance of an application; it does not affect the application's 
functions. You can set overrides by user ID, group ID, or the keyword *PUBLIC. If you set your 
override by user ID, only that user is affected when he or she signs on to any workstation in the 
enterprise. If you set your overrides by group ID, those users who are set up within User Profiles to be 
members of that group are affected. If you set your user overrides by *PUBLIC, all users in the 
enterprise are affected. After you create an override for a group ID or *PUBLIC, each employee 
inherits that override, regardless of the workstation he or she signs on to. Even with group or 
*PUBLIC overrides, each employee can further customize a version to fit individual needs. For 
example, if someone in a department has trouble seeing text on a form, he or she can switch to a 
larger font. This change applies only to the individual, not to the entire group or company.  

The system stores these modifications in the User Overrides Table (F98950). Because the system 
tracks the overrides by your user ID or group ID, the modifications will appear on any workstation 
that you sign on to. User Overrides allow you to make the following modifications:  

• Resequence the grid  

• Change the sort order of rows and columns  

• Freeze columns and rows  

• Move and resize columns and rows  

• Change the magnification and font size  

• Add charts and graphs to an application, and embed third-party products that support OLE 
automation  

The following overrides are local only; they can be considered workstation preferences. The system 
stores these overrides on your workstation; therefore, they are accessible only from that workstation:  

• Sizing of the parent and child windows  

• Changing the parent window  

• Changing fonts on a form  

• Maximizing the form  

• Turning on the exit bar  
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See Also 
� Application User Interface in the Foundation Guide for more information on how to modify 

application user interface 

Search Hierarchy 
During the execution of an application, the system uses a search hierarchy to locate a user override. 
The system searches by user and group for each unique combination of application, form, version, 
and language in the following order:  

User ID  When you access a specific application, the system searches first for an override for the 
application under your user ID.  

Group  If the system does not find an override under your user ID for the application, it then 
searches for it at the group level. For example, if you are in the Accounts Payable group, 
the system searches for an override for that group.  

*PUBLIC If the system does not find an override for the application at the group level, it searches 
for it under *PUBLIC. If no override is found at the *PUBLIC level, the system uses the 
No Overrides default value.  

Cached Override Information  
The first time that a user opens a EnterpriseOne application form, the system reads the User Overrides 
Table (F98950) and creates a disk cache on the workstation. This table contains form-specific 
information such as menus, buttons, and formats. This cache improves network performance because 
multiple database fetches are not required to retrieve individual form elements.  

However, if a system administrator or the user modifies user overrides with the User Overrides 
Revision (P98950) program, the system writes the override information directly to the F98950 table, 
and not to the cached table. Because the system always reads overrides from the cached information, 
any modified user overrides cannot become effective until the user exits and reenters the system, 
causing the cached table to be refreshed.  

For example, assume that you want to modify a journal entry by adding tabs and then associating 
those tabs with your user overrides. You would create the tab and then use the P98950 application to 
associate the tab with your user profile. You would not immediately see any records of the journal 
entry form because the user override is stored in the User Overrides Table, and the system is looking 
at the cached information. This process does not affect your ability to create and use local form 
changes, or workstation preferences, that are not stored in the User Overrides Table.  

If for some reason you have two users who share the same user ID, be aware that the system does not 
share user override records. If both users sign on to the system at about the same time, the first of 
these two users to sign on will see the user overrides; the second user to sign on will not. 
Furthermore, the first user to make an override change during simultaneous sessions takes control of 
the F98950 record, and all other users signed on to the same user ID are locked out.  
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Working with User Overrides  
You can create user overrides for a user ID, group ID, or for *PUBLIC. After you create a user 
override, your user override will be available on any workstation that you sign on to in the enterprise.  

If a form for which you have created user overrides has changed after upgrading your software, the 
system attempts to merge your user overrides with the changed form. You might need to reset your 
user overrides; at the least, you will need to verify that your user overrides are still intact.  

Creating User Overrides  
You can create individual user overrides in which the changes that you make to an application reside 
on an enterprise server and are associated with your user ID. This override is available to you at any 
workstation that you sign on to. To create a group override, you first create an individual override, 
and then you change that override to a group override, thereby making the override available to 
employees within a group or to the entire company (*PUBLIC).  

► To create an individual user override  

1. Choose the application for which you want to create an override (for example, Standard 
Voucher Entry).  

2. Modify the application (for example, rearrange columns or rows on the grid). When you exit 
the application, the preferences that you just set up are stored in User Overrides under your 
user ID.  

► To change an individual user override to a group user override  

1. On the System Administration Tools menu (GH9011), choose User Overrides (P98950). 

2. On Work With User Overrides, locate and choose the individual override record that you 
wish to make available to a group.  

Note 

Be sure that you choose the correct type of override. The two types available are GF for grid 
tab format overrides, and HC for menu and toolbar overrides. For example, to deploy a grid 
tab to other users, you need to choose a GF record; to deploy a changed menu bar or toolbar, 
you need to choose an HC record. On the Work With User Overrides form, scroll to the right 
to see the override type.  

 

3. Click Copy.  

4. On Copy Overrides, enter information in the following fields:  

• User/Role 

Enter either a valid group, which has been set up in User Profiles, or *PUBLIC to copy 
the user override to a group or the entire company.  

If you want to change a EnterpriseOne demo version and want the copied version to use 
the same user overrides as the demo version, do not change the User/Group, but name the 
version to represent your custom version.  
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• Version 

Enter the version name to copy user overrides set up for one version to another version. 
User Overrides does not create versions.  

• Language 

Enter a valid language code to select the user override language for the specified user and 
application.  

5. If you copied and modified the version, delete the individual user record that you copied. 

Deleting this record ensures that when you log on, you are viewing the overrides for the 
group that you are in, not the override that is specific to your user ID.  

Note 

The system creates a record for each form that you modify.  

 

6. Click OK. 

Fixing User Overrides after a Form Change  
When you install a package on your workstation, you might have a discrepancy between the changed 
forms included with the new package and the grid, menu, or toolbar user overrides that you made 
before the installation. For example, a new column might have been added to a grid for which you 
have user overrides. After the package installation, the first time that you access the changed form, 
the system detects the discrepancy between the newly installed form and your existing user overrides. 
The system asks if you want to fix your user overrides to include the new column or delete your user 
overrides altogether. If the system cannot fix the discrepancy between the changed form and your 
user overrides, the system automatically deletes your user overrides.  

The system performs this fix only for grid, menu, or toolbar user overrides because all other user 
overrides, such as an OLE attachment to a form, do not interfere with changes to a form.  

► To fix user overrides after a form change  

The first time that you access a form after a package installation and have a discrepancy between the 
newly installed form and your user overrides, a message box appears. This box prompts you to either 
delete your user overrides for that form or have the system try to fix your user overrides to match the 
changed form.  

On the message box that appears, perform one of the following:  

• To delete your user overrides, click Delete.  

The system deletes your user overrides for that form. You can add your overrides again by 
following the process for creating user overrides.  

• To try to fix your user overrides, click Fix.  

The system tries to merge the changes from the newly installed form with your user overrides 
for that form. If successful, verify that the form works properly with your user overrides. If 
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any errors exist with the grid formats or menu and toolbar customization after the system tries 
to fix the discrepancy, you should delete your user overrides for that form. On the Work With 
User Overrides form, choose your overrides and then click Delete.  

If the system is unable to merge the changes with your user overrides, the system 
automatically deletes your user overrides for that form. You can add your overrides again by 
following the process for creating user overrides.  
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Records  

Databases store information in units called records. Each record might contain more than one item of 
information. For example, Dominique Abbott is an item of information in the EnterpriseOne system. 
When you access Dominique Abbott from the Address Book application, the record that appears 
might also include Dominique’s phone number, address, and other pertinent information. The system 
might save all of this information as one record, or it might save some of this information as a 
primary record and other information as secondary records. These types of relationships exist 
throughout the system.  

Database tables store all system records. Each record must have at least one key that links the record 
to a database table. Keys are unique identifiers that distinguish one record from another. For example, 
Address Book uses Address Number as the key to distinguish each record. Therefore, each Address 
Number must be unique. When creating new records, you must enter information into a key field. If 
you do not enter information into a key field, the system displays an error message. Once you have 
entered information into a key field, you cannot edit that key field later. To change the key field 
information, you need to create a new record.  

The Media Objects feature allows you to add notes, graphics, and other objects to records. For 
example, you can use a note to explain special circumstances surrounding a journal entry. You can 
also attach drawings, animations, and other types of objects to records.  

See Also 
� Media Object Attachments in the Foundation Guide for information about attaching media 

objects to records 

Locating Records  
To locate a record, use the grid on the Find/Browse form. The grid displays one or more records when 
you perform a search. By examining the information displayed in the grid, you can identify the 
records that you want to review, copy, update, or delete. Records that match your selection criteria 
appear in the detail area below the column titles.  

You can locate all associated records from any Find/Browse form by clicking the Find button and 
then scrolling down the list of records. The system loads records one page at a time to improve 
performance. Only the records that you see in the grid have been retrieved; when you scroll down, the 
system retrieves new records. Depending on the number of records and your system resources, 
loading every record might take a long time. However, the system allows you to filter your records by 
narrowing and defining the criteria for your search. The following list provides examples of how to 
define your search criteria:  

• Use the filter fields at the top of the form. For example, you can enter information in a filter 
field to search only for employee records.  

• Use the query-by-example line to search in one or more columns based on criteria such as a 
name and address, or a range of names and numbers.  

• Refine your search in the filter fields and the query-by-example line using a wildcard.  
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Locating Records Using Specific Selection Criteria  
Selection criteria defines your search by specific types of records. For example, you can include 
information in filter fields such as Name Search and Search Type to search only for employees whose 
names begin with the letter A.  

► To locate a record using selection criteria  

For example, from the Daily Processing Menu (G01), choose Address Book Revisions (P01012).  

1. On Work With Addresses, complete the following field:  

• Search Type 

If you do not know the Search Type, use the Search button to view a list of user defined 
codes.  

2. Click the Find button.  

A list of matching records appears.  

See Also  
� Working with Visual Assists in the Foundation Guide for information about the visual assist 

Search button  

Using the Query-by-Example Line  
You can use the query-by-example line to search for records by a grid column. For example, if you 
are searching for a person by name, enter all or part of the name in the query-by-example line directly 
above the Alpha Name column in the grid.  

The information that you enter in the query-by-example line must be a valid value for the column. If 
it is not, the system will not find a match. You cannot enter values in the disabled (grayed-out) 
columns because these columns do not allow searches.  

Some query-by-example lines work differently. On some forms in the Tools setup applications, 
tabbing to the end of a line after filling in one or more fields achieves the same result as clicking the 
Find button.  

► To use the query-by-example line  

On any Find/Browse form, type the characters on which you want to search in the corresponding 
column of the query-by-example line, and then click Find.  

For example, on Address Book Revisions (P01012), type all or part of the name of the individual you 
are searching for in the Alpha Name column of the query-by-example line, and then click Find.  

The record that matches the query criteria appears in the grid.  
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Locating Records Using Wildcards and Operators  
You can use the asterisk (*) as a wildcard character in place of one or more letters. Using the asterisk 
widens your search. For example, you can type abb* in the Alpha Name column of the query-by-
example line to view all records that begin with the letters abb. Or you can type *bb* in the query-by-
example line to retrieve those records that contain the letters bb in the middle of the name.  

In addition, you can search for values in a set using operators. For example, in the Address Number 
column of the query-by-example line, type <87 to specify address numbers that are less than 87. Type 
<b in the Alpha Name column of the query-by-example line to specify names that begin with a.  

The following operators are valid in the query-by-example line:  

<  Less than  

< =  Less than or equal to  

>  Greater than  

> =  Greater than or equal to  

!  Not equal to  

Each time that you enter values in a search, click the Find button to retrieve matching records.  
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Working with Records  
In EnterpriseOne applications, records are often related to one another, and many of these 
relationships depend on one another. You can change primary records by adding, deleting, and saving 
the information located on the secondary records or the primary records themselves. For example, 
you can have a primary or master record that contains an employee's name and address. Additional 
information, such as his or her phone numbers, exists in a secondary record.  

 

 

EnterpriseOne is event-driven, which means that actions such as clicking a button, tabbing to a field, 
or selecting from a menu or list can alter your data. However, changes to the database are not saved 
until you exit a form by clicking OK or pressing Enter. Information that you change on related forms 
is not saved until you enter those changes in the previous form and click OK to accept them.  

When you work with records, you should be aware of the following considerations:  

Primary and 
secondary 
relationships  

When adding records to the database, you add the primary record first and then 
the secondary records. It is important to remember that primary records must 
be in the database before you can add a secondary record to the database.  

Working with 
records  

The process for changing, adding, and deleting records is consistent 
throughout the system. You can make these types of changes to your database 
on the following two types of forms: 

• A single-record form, such as Address Book Revision  
• A multiple-record form, such as Phone Numbers  
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Adding  When adding a record that contains a Next Numbers field, the number is added 
automatically.  

When adding records to a Find/Browse form, click Add and complete the 
blank form that appears. Click OK when completed.  

Any required field that you do not complete will highlight in red when you 
finish adding the record.  

Changing  If a field is protected, such as Address Number on Work With Addresses, you 
cannot change it.  

Copying  When copying a record, the system does not copy all the fields to the new 
record. To make the record unique, the system changes certain fields for the 
new record.  

Deleting  In a Find/Browse form, such as Work With Addresses, choose the row that you 
want to delete and click Delete. The system prompts you with a series of 
confirmation messages for each row that you choose to delete.  

In a multiple-record form, such as Phone Numbers, you must choose the entire 
row in the grid to remove that row.  

You cannot delete a record from a single-record form such as Address Book 
Revision. You can delete only from the grid.  

Depending upon which application you are in, when you delete a parent 
record, the system deletes the information from related forms. See the 
appropriate application guide for information about deleting child records.  

Dates  The system validates dates according to your user profile. You can assign your 
user profile either Windows or EnterpriseOne settings.  

Tabbing out of 
required a field  

When you tab out of a required field, the system validates the field. If it is not 
correct, you get an error message.  

User defined codes  The system validates user defined codes against the user defined code table.  

Account numbers  The system validates account numbers against the account number table.  

  

Choosing a Record  
You choose a record for a variety of reasons. For example, you might need to change an employee's 
address and phone number. You can choose a single record or multiple records from the Find/Browse 
form, and then you can change the information on a Revision form.  

You can choose a record in one of two ways:  

• Click the record and then click the Select button to open the corresponding form.  

• Double-click a record to select it and open the corresponding form.  
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► To choose a record  

1. On any Find/Browse form, locate a record.  

2. Double-click the record to display it on a revision form.  

3. On the revisions form, revise the record and then click OK.  

If you selected more than one record, your second record might appear now. If your second 
record does not appear, click the Next button at the top of the form. Continue to revise as 
needed.  

4. After you finish, be sure to click OK to save your latest revision and then click Cancel to exit.  

See Also  
� Locating Records in the Foundation Guide for information about the different methods for 

finding a record or a set of records 

Adding a Record  
When adding records to the database, you add the primary record first and then add the secondary 
records.  

► To add a record  

1. On a Find/Browse form, click Add to open a blank revision form.  

2. Enter the information for the new record.  

3. Click OK.  

When you add records, the system uses the Next Numbers feature to automatically number Address 
Book records, journal entries, purchase orders, and other documents.  

Changing a Record  
In EnterpriseOne, a Find/Browse form appears when you open most applications. On the 
Find/Browse form, you choose the action that you want to perform. Choosing a button or function 
that you want to perform displays, for example, a Fix/Inspect form on which you can change your 
record.  

As you move from field to field, you view your changes reflected in the form. If you type an invalid 
value in a field, the field highlights in red and an error appears. You must correct the error before you 
click OK. Clicking OK saves your changes in the database.  

You cannot change information on the Find/Browse form itself. The information you have changed 
appears after you choose the appropriate button on the Find/Browse form.  

► To change a record  

1. On a Find/Browse form, choose a record.  

You can double-click a record, or choose a record and then click the Select button.  

2. On the revisions form, revise information as needed.  
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3. Click OK to accept the revisions.  

Deleting a Record  
Occasionally, you might need to remove a record from your database. For example, you might no 
longer use a particular supplier. Depending upon the application, if you delete a primary record the 
system might also delete any secondary records related to the primary record, such as phone numbers. 
See the appropriate application guide for information about deleting child records.  

► To delete a primary record  

1. On a Find/Browse form, choose one or more records.  

2. Click Delete.  

The system prompts you to confirm the deletion.  
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Messages and Queues  

With EnterpriseOne, you can send and receive electronic mail (e-mail) messages through the Work 
Center program (P012501 for Windows, P012503 for Web). The EnterpriseOne e-mail system 
includes messages sent by users and messages sent by a workflow process.  

You can organize your messages by placing them into queues (storage areas for your messages) 
provided by the software or by setting up your own queues. This section explains how to work with 
your messages and with your queues. In addition, you can indicate your work-time location and add 
remarks to your time log.  

Internal and External Messages  
EnterpriseOne sends your e-mail messages in different ways, depending upon whether the message is 
internal or external to the system.  

Internal 
Messages  

Internal messages stay within the EnterpriseOne system. They are read using the 
Work Center. 

External 
Messages  

External messages are sent to third-party e-mail software packages such as 
Microsoft Outlook or Lotus Notes. 

You system administrator configures your user account to receive either internal or external e-mail. 
However, some messages are sent as internal e-mail regardless of this preference; for example, 
notifications of submitted UBE jobs. 

See Also 
� Setting Up External Mail Preferences in the Foundation Guide for information about setting 

up the EnterpriseOne mail preferences for a third-party mail product 

Workflow Messages 
In addition to sending and receiving internal and external messages, you can receive an active 
message, which is a type of message that a system workflow process automatically sends to a 
recipient. 

Active 
Messages  

Workflow processes sometimes generate messages that require you to take action, such 
as approving or rejecting a change to a customer record. A lightning bolt icon identifies 
an active message.  

Active messages contain a shortcut icon that links directly to an application. When you 
click the shortcut icon, the system retrieves the most current information from the 
database, which ensures that you get accurate information even if changes are made 
after an active message is sent to you.  

You can set up a workflow process to send active messages to specific queues. 
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See Also 
� EnterpriseOne Workflow Tools Guide for general information about the workflow system and 

programming workflow processes to send messages 

� The guide for your application for specific information about existing workflow processes 
within a particular application or application suite, such as the credit limit approval process 

Understanding Queues  
Queues are storage areas that allow you to organize messages using the Work Center. For example, 
messages can be organized into queues for priority mail or for submitted jobs. Through a queue, users 
can approve or reject specific tasks in a workflow process. A queue is actually a user defined code, 
and you set up a queue in the same way that you would set up a user defined code.  

Queues Provided with EnterpriseOne 
EnterpriseOne provides the following queues:  

Sent  Messages that you have sent to others.  

Deleted  Messages that you have deleted. After you delete a message, you can view it but you 
cannot move it to another queue.  

The system administrator has the authority to purge deleted messages from the system, 
which is typically done periodically or on a predetermined schedule. You can also 
remove a message from the system by deleting it from your Deleted queue.  

Submitted 
Jobs  

Messages generated by the system for jobs that you have submitted for batch 
processing, such as the General Ledger Post.  

Workflow Queues  
Workflow includes several predefined queues, but you might want to set up a custom queue for 
messages generated by processes that you create. For example, you might want to set up a queue for 
messages generated by a credit limit approval process. This queue would gather any approval or 
rejection messages related to credit limits for customers. A user could then open that queue and act on 
the message contained within it.  

Working with Messages  
Use the Work Center to send and receive internal electronic mail (e-mail) messages within the 
EnterpriseOne system, or to send external messages outside of the system to a third-party e-mail 
software package such as Microsoft Outlook or Lotus Notes. You can also revise messages, reassign 
messages to other users, direct messages to queues, attach shortcuts to messages, print messages, and 
delete messages.  
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Accessing the Work Center 
The Work Center is the hub of e-mail within the EnterpriseOne system. Use the Work Center to 
manage your messages and queues. Access the Work Center in one of the following ways:  

• From the Workflow Management menu (G02), choose Work Center.  

The Work Center form appears.  

• From the Tools exit bar in any application, choose Work Center. You must have the Exit Bar 
preference turned on for this bar to appear.  

• From the hyper-button in any application, click the down arrow on the hyper-button, choose 
Tools, and then Work Center.  

Viewing Messages 
You can view your messages in the Work Center. Messages sent from other users will appear in 
either your Personal In Basket queue or, if you set them up, your Priority Mail and Secondary queues. 
You can also view workflow messages, or active messages, sent by a workflow process.  

Note  

If you cannot view messages, make sure that queue security is set up to allow you to view the 
Address Book number and queue that you want to view.  

 

 

See Also 
� Changing a User's Queue Security in the Foundation Guide for information about queue 

security 

� Redirecting Messages to the Priority or Secondary Queue in the Foundation Guide for more 
information about setting up Priority and Secondary queues 

� Workflow Tools Overview and other topics in the EnterpriseOne Workflow Tools Guide for 
information about workflow messages 

► To view messages  

1. From any application, click the down arrow on the hyper-button and choose Tools, and then 
Work Center.  

2. On Work Center, double-click a queue that contains a message.  

Any messages in that queue appear. New messages appear in bold.  

3. Click the message that you want to view.  

The message appears in the view area on the right side of the Work Center form.  
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Sending Internal Messages  
When you send internal e-mail messages, you send them to other users within EnterpriseOne 
software. You can control the time of delivery for a message by assigning a tickler date to the 
message. A tickler date is a date in the future when the system will automatically send the message. 
Assigning a tickler date is especially helpful if you plan to be out of the office on the day that you 
want others to receive your message, or if you want to remind yourself about upcoming meetings or 
other obligations.  

When you send internal messages, you can also include an attachment. Attachments allow you to 
include files, images, or links that conform to the OLE standard, such as word processing documents 
and spreadsheets.  

You can send messages to one or more recipients. If you are sending a message to multiple recipients, 
you can use a quick list, a predefined distribution list, or a role.  

► To send an internal message to a single recipient 

1. From any application, click the down arrow on the hyper-button, choose Tools, Send, and 
then choose Internal Mail.  

2. On Send Internal Mail, click the Search button in the following field: 

• Send To Address Number / User / Role 

3. On Address Number / User / Role, choose one of the following options to search for a 
recipient by address number or user ID, and then click OK:  

• Address Number 

• User 

4. Highlight the row that contains the recipient and then click Select. 

5. Type the subject of the message in the following field: 

• Subject 

6. Complete the following optional fields, as necessary:  

• Type 

• Mail Box 

• Marketing 

• Lead Source 

• Keep Copy 

• Receipt Notify 

• Address 

• Contact 

• Tickler Date 

• Phone Number 

7. Type your message in the text area at the bottom of the form.  
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8. To include an attachment with your message, right-click the panel with the Text icon.  
9. Choose New, and then one of the following options:  

• Image  
• OLE  
• Shortcut  
• URL/File 

10. Click OK to send the message.  

The system returns you to the previous application. If you choose to keep a copy of a 
message that you send, you can view it in the same queue from which you sent the message.  

See Also  
� Working with Media Objects in the Foundation Guide for information about attaching media 

objects  

� Media Objects and Imaging in the System Administration Guide for complete information 
about media objects  

► To use a quick list to send a message to multiple recipients 

1. From any application, click the down arrow on the hyper-button, choose Tools, choose Send, 
and then choose Internal Mail.  

2. On Send Internal Mail, choose Quick List from the Form menu.  
3. On Quick List, complete either of the following fields for each person you want on the list, 

and then click OK:  

• Alpha Name 

• Address Number 

4. Follow the steps for sending an internal message to a single recipient.  

Note 

You cannot save a quick list.  

 

► To send a message to members of a distribution list  

1. From any application, click the down arrow on the hyper-button, choose Tools, choose Send, 
and then choose Internal Mail.  

2. On Send Internal Mail, click the Search button in the following field: 

• Send To Address Number / User / Role 
3. On Address Number / User / Role, choose the following option to search for a distribution list 

by its address number and then click OK:  

• Address Number 
4. Highlight the row that contains the address number of the distribution list, and then click 

Select. 
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5. Follow the steps for sending an internal message to a single recipient.  

See Also  
� Understanding Distribution Lists in the EnterpriseOne Workflow Tools Guide for complete 

information about distribution lists  

► To send a message to members of a role 

1. From any application, click the down arrow on the hyper-button, choose Tools, choose Send, 
and then choose Internal Mail.  

2. On Send Internal Mail, click the Search button in the following field: 

• Send To Address Number / User / Role 

3. On Address Number / User / Role, choose the following option, and then click OK: 

• Role 

4. Highlight the row that contains the role that you want to use and then click Select. 

5. Follow the steps for sending an internal message to a single recipient.  

Setting Up External Mail Preferences  
Before you can send external e-mail to a third-party e-mail software package such as Microsoft Office 
or Lotus Notes, you must specify your own e-mail address. The system will use this as the “From” e-
mail address for the message that is sent. If your own e-mail address has not been specified the first 
time you try to send external email, the system prompts you for this information. You can also choose 
to set this up at any time using the Update Mail Preference form.  

See Also  
� Setting Up a Third-Party Mail System in the EnterpriseOne Workflow Tools Guide for more 

information about using third-party e-mail systems 

► To set up external mail preferences  

From Workflow Management (G02), choose Employee Queue Manager (P012501 for Windows, 
P012503 for Web).  

1. On Work With Employee Queue Manager, find and click the address number for which you 
want to apply external mail preferences, and then choose Preference from the Row menu.  

2. On Update Mail Preference, complete the following fields, and then click OK:  

• E-mail Preference 

Click the Search button to choose the third-party messaging system that you want to use 
for external messages.  

• E-mail Address 

Type your third-party e-mail address. 
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Sending External Messages  
External messages are messages that you send to non-EnterpriseOne users, as well as people who use 
EnterpriseOne software but use a third-party e-mail system such as Microsoft Outlook, instead of the 
Work Center, to send and receive messages. When you send external messages, you can also include 
an attachment, such as an image, a URL, or a file.  

► To send external messages  

1. From any application, click the down arrow on the hyper-button and choose Tools, choose 
Send, and then choose External Mail.  

2. If the Update Mail Preference form appears, you are not set up to send external messages. 
Complete the following steps:  

a. Click the Search button in the following field to choose the third-party messaging system 
that you are using: 

• E-mail Preference 

b. In the following field, type your e-mail address from the address profile set up in your 
third-party e-mail product: 

• E-mail Address 

c. Click OK. 

3. On Send External Mail, complete the following field:  

• To  

• Subject 

4. The following field is optional:  

• CC  

5. Type your message and then click OK to send the message.  

Working with Shortcuts  
With the EnterpriseOne messaging system, you can send messages that contain a shortcut to a 
EnterpriseOne application. When you send a shortcut, you can preface it with a message for the 
recipient to review and approve. For example, you might want your manager to approve a change that 
you made to a customer record. After sending a shortcut to your manager, he or she can view the 
record immediately by clicking the shortcut icon. When you send a shortcut, the system sends the key 
for that particular record to the recipient. When the recipient clicks the shortcut icon, the system 
opens the application and retrieves the record.  

The EnterpriseOne system uses workflow to automatically send messages with a shortcut to an 
application. These types of messages, called active messages, require that the recipient open the 
shortcut to verify information or approve a transaction.  

Since EnterpriseOne software supports Windows and Web clients, the message can contain a shortcut 
for a Windows application or a Web application. You must set up your e-mail preferences to 
determine whether a shortcut that you open will launch the application in the Windows client or the 
Web client. 
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Setting Up Shortcut Preferences 

You must set up your e-mail preference to specify whether applications that you launch from a 
shortcut will open in the Windows client or Web client.  

► To set up the shortcut preferences 

From Workflow Management (G02), choose Employee Queue Manager (P012501 for Windows, 
P012503 for Web).  

1. On Work With Employee Queue Manager, find and choose the address number for which 
you want to apply a shortcut preference, and then, from the Row menu, choose Preference.  

2. On Update Mail Preference, click the Search button in the following field to specify 
Windows or Web as the application shortcut type: 

• Shortcut Client Type 

3. Click OK. 

► To send a shortcut  

From the application from which you want to create a shortcut, retrieve any records you want the 
recipient to view.  

1. Click the down arrow on the hyper-button and choose Tools, and then Send Shortcut.  

The Send Internal Mail form appears with a shortcut to the application.  

2. On Send Shortcut, complete the following fields:  

• Address Number / User / Role / Distribution List 

• Mail Box (Internal Messages Only) 

• Subject 

3. Type your message.  

4. Click OK to send the message.  

Revising Messages 
You can revise the text of messages in any of your queues. This feature opens up the actual message 
and allows you to change the text or add new text.  

► To revise messages  

From any application, click the down arrow on the hyper-button, choose Tools, and then choose 
Work Center.  

1. On Work Center, choose the message that you want to revise. 

2. From the Row menu, choose Message Revisions.  

94 



3. On the Message Revisions form, change any of the following fields and then click OK:  

• From 

• Contact 

• Subject 

• Phone Number 

• Tickler Date 

• Text area  

Moving a Message to Another Queue  
You can move a message from one queue to another. For example, you might want to move a 
message from your Priority queue to your Personal To Do List queue.  

► To move a message to another queue  

From any application, click the down arrow on the hyper-button, choose Tools, and then choose 
Work Center.  

1. On Work Center, click the All Queues option if the target queue to which you want to move 
the message does not appear.  

2. Click and drag the message to the target queue. 

To move more than one message, hold down the Shift key and click each message, and then 
click and drag one of the messages to the target queue. All highlighted messages move to the 
queue.  

3. To verify the placement of the message, double-click the target queue and view the contents.  

Redirecting Messages to the Priority or Secondary Queue  
You can redirect messages that you receive from an individual to your Priority Mail queue. When you 
do this, the system sends all future messages from that individual directly to your Priority Mail queue. 
Alternatively, you can redirect messages from an individual to your Secondary queue.  

To redirect messages to the Priority Mail or Secondary queue, you must follow these steps and not the 
ones for moving messages. Moving messages only moves individual messages, whereas redirecting 
messages to the Priority Mail or Secondary queue affects all messages from that user until you 
remove the designation.  

Although you can move a message to the Archived or Deleted queue, the system does not redirect 
future messages from the sender to that queue. You must manually move the sender's message to the 
Archived or Deleted queue each time.  

You can redirect messages from more than one person to your Priority Mail and Secondary queues. 
You can also prevent messages from being delivered to a specific queue.  
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► To redirect messages to the Priority Mail or Secondary queue  

From any application, click the down arrow on the hyper-button, choose Tools, and then choose 
Work Center.  

1. On Work Center, choose the message that you want to redirect to your Priority Mail or 
Secondary queue.  

2. From the Row menu, choose one of the following options:  

• Priority  

• Secondary  

3. Double-click the target queue to verify the placement of your message.  

Any further messages that you receive from this sender will arrive in the queue that you 
selected. Repeat these steps for redirecting other users' messages.  

Canceling the Delivery of Messages 
If you decide that you no longer want the system to automatically redirect messages from an 
individual to a Priority Mail queue, you can cancel the automatic delivery of messages to your 
Priority Mail or Secondary queue.  

► To cancel the delivery of messages to a specific queue  

From any application, click the down arrow on the hyper-button, choose Tools, and then choose 
Work Center.  

1. On Work Center, choose a message from the user for which you want to cancel automatic 
delivery.  

2. From the Row menu, choose Remove.  

3. Move any other messages from this particular sender out of the Priority Mail or Secondary 
queue. 

As long as you keep any messages in your Priority Mail or Secondary queue from the sender 
whom you removed, future messages from that sender will appear in that queue.  

Reassigning Messages  
The messaging system allows you to reassign a message to another user after the message is sent to 
the original recipient. This process changes whose queue the message appears in. For example, if you 
originally sent a message to Jim, you can reassign that message to Betty. The message will now be in 
Betty's queue and will not be in Jim's queue. You can also reassign messages that you receive.  

You can only reassign messages in other users' queues if your queue security allows.  
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► To reassign messages  

From any application, click the down arrow on the hyper-button, choose Tools, and then choose 
Work Center.  

1. On Work Center, choose the message that you want to reassign, and then, from the Row 
menu, choose Reassign.  

2. On Assign Message, complete the following fields and click OK:  

• Address Number / User / Role 

• Queue Designator 

Deleting Messages  
You cannot recover a message after you move it to the Deleted queue. It remains in your Deleted 
queue until your system administrator purges messages, which is typically done on a periodic or 
predetermined schedule. Alternatively, you can remove a message from the system by deleting it 
from your Deleted queue.  

► To delete a message 

1. Drag the message to the Deleted queue. Alternatively, choose the message and click Delete.  

2. To choose more than one message, hold down the Shift key and click each message.  

Printing Messages  
You might find that you want a printed copy of a message for your records. You can do either of the 
following:  

• Print a message  

You can print a message from any of your queues.  

• Print a report that lists all messages within a queue  

This report includes a summary for each message. The two types of message reports are:  

• Message Center - Summary  
• Message Center - Detail  

These reports show the sender and recipient of the message, as well as the subject of the 
message. The detail report shows the content of each message.  

► To print a message  

From any application, click the down arrow on the hyper-button, choose Tools, and then choose 
Work Center.  

1. On Work Center, choose the message that you want to print.  

2. From the Row menu, choose Print.  

3. On Printer Selection, click OK. 
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► To print a report that lists all messages in a queue  

From any application, click the down arrow on the hyper-button, choose Tools, and then choose 
Work Center.  

1. On Work Center, choose the message queue that you want to print.  

2. From the Form menu, choose Print.  

3. On Work with Batch Versions - Available Versions, choose the version and submit the 
report.  

Working with Queues  
Queues are a way to group related messages together in the Work Center. This topic describes how to 
manage your queues by creating new ones or adding security. As with a message, you can also add a 
shortcut to a queue.  

You set up queues in the system as user defined codes. The following task describes how to create 
queues or modify existing queues.  

► To set up a queue  

From Workflow User Defined Codes (G02411), choose Employee Task Queues.  

1. On Work With User Defined Codes, click Add.  

2. On User Defined Codes, complete the following fields in an empty row on the grid and click 
OK:  

• Codes 

Enter a unique number for the queue.  

• Description 1 

Enter a name for the queue. 

• Description 2 

• Special Handling 

• Hard Coded 

Enter N in this field.  

Specifying the Queues that a User Can View  
You can change the security status for a user or group of users within a queue. You can either give a 
user authority to monitor every queue within a group, or you can deny users access to certain queues.  

You can add security by user, distribution list, or role. For example, you might want to set up security 
so that a manager can monitor all messages within certain queues. Or you might set up security by 
distribution list or role so that users within the group have authority to monitor certain queues.  
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If you want to give only a few people within a distribution list or a role access to certain queues, you 
enter the distribution list or the role, and then enter the users' address book numbers to define which 
queues those users in the group can access.  

► To specify the queues a user can view  

From Workflow Management Setup (G0241), choose Queue Security.  

1. On Work With Workflow Message Security, click Add.  

2. On Workflow Message Security Revisions, complete the following fields:  

• User 

• Group/Role 

3. Specify the queues that a user can view by completing the following field and clicking OK:  

• Authority Y/N 

Changing a User's Queue Security  
You can deny a user access to queues or allow the user to view all of the messages within certain 
queues available to the group.  

If you choose the Public Security option, all users will have access to queues that you specify. For 
example, if you choose the Public Security option and give authority to the Collection Management 
queue, all users in the system will be able to view all messages in that queue.  

► To change a user's queue security  

From Workflow Management Setup (G0241), choose Queue Security.  

1. On Work With Workflow Message Security, find and choose the user's record, and click 
Add.  

2. On Workflow Message Security Revisions, complete the following fields and click OK:  

• Public Security 

When you choose this option, the system protects the User and Group fields because you 
are specifying that you want to give authority for specific queues to all users in the 
system.  

• Authority Y/N 

If you complete the user field, the system protects the Public Security field.  
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Logging Time and Adding Remarks  
The Work Center allows you to inform others of your whereabouts. You can specify when you are in 
or out of the office by using the Check In and Check Out options. You can add remarks to your check 
out to provide detailed information about where you are. You can view this information from the 
Time Log form.  

Checking In and Out  
Checking in and out informs others of your whereabouts. When you check out, you can also enter a 
remark, return date, and return time. If you do not enter a remark, the system supplies the word home. 
If you do not enter a return date, the system enters the next business day. The check in and check out 
information that appears on the Time Log form is discussed later in this topic.  

► To check in and out  

From the Workflow Management menu (G02), choose Employee Queue Manager.  

1. On Work With Employee Queue Manager, locate and choose your record. 

2. From the Row menu, choose one of the following menu options:  

• Check In  

• Check Out  

Each time you choose Check In or Check Out, the system updates your status, which you can 
view from the Time Log.  

Entering Remarks  
You can enter a remark to provide more information about your whereabouts, your schedule, and so 
on. For example, you might enter a remark indicating that you are in a meeting, on vacation, or can be 
reached at a particular phone number. You can update an existing remark.  

► To enter remarks  

From the Workflow Management menu (G02), choose Employee Queue Manager.  

1. On Work With Employee Queue Manager, locate and choose your record. 

2. From the Row menu, choose Remark.  

3. On the Check In/Out and Update Remark form, turn on the Update Remark option.  

4. Enter your remark in the following field:  

• Remark 

5. The following fields in the Return area are optional; complete them if necessary:  

• Return Time  

• Return Date  
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6. Click OK. 

7. To view your remark, click Find on Work With Employee Queue Manager.  

Viewing Time Logs  
You can view the times when you or other employees check in and out, and you can view any 
remarks.  

► To view time logs  

From the Workflow Management menu (G02), choose Employee Queue Manager.  

1. On Work with Employee Queue Manager, choose the employee record time log that you 
want to view.  

2. From the Row menu, choose Time Log.  
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Media Object Attachments  

EnterpriseOne software media objects and imaging features allow you to attach useful information to 
an application, including information that might currently exist as a paper-based document. The 
media objects feature allows you to attach the information to EnterpriseOne software applications, 
forms and rows, and Object Librarian objects. The imaging feature within media objects gives you 
the flexibility to create an efficient method of information storage.  

Use media objects to link information to applications, either to individual rows in a grid or to a form. 
The following list describes the types of information that you can attach to a grid row or form: 

Text  Media objects provides a word processor that lets you create a text-only 
attachment. For example, you could use a text attachment to provide specific 
instructions for a form or additional information about a record.  

Image  Images include files such as Windows bitmaps, Graphics Interchange Format 
(GIF) files, and Joint Photographic Experts Group (JPG) files. These files might 
represent electronically created files as well as scanned images of paper-based 
documents.  

Object Linking 
and Embedding 
(OLE)  

Media objects can be files that conform to the OLE standard. OLE allows you to 
create links among different programs. Using these links, you can create and edit 
an object from one program through a different program. EnterpriseOne software 
provides the links that you need to attach OLE objects.  

You attach OLE media objects at the base form level. Media objects attached at 
this level are attached to a form and not to any data that might appear in the form. 
You can attach media objects to a grid row or a form, but the files themselves 
exist in separate directories. The only file information included with the 
application to which the OLE links is the path to the supporting file.  

You can only use OLE objects that you properly register and install as OLE 
objects through Windows.  

JDE shortcuts  A JDE shortcut is a link that opens a EnterpriseOne software application. Within 
media objects, you can only attach EnterpriseOne software shortcuts; you cannot 
attach shortcuts to third-party applications.  

Uniform 
Resource 
Locators 
(URL)/files  

Media objects can be links to Web page URLs or other related files. When a 
developer attaches a URL media object to a control object on a form, the Web 
page appears as part of the form. When a user attaches a URL to a form or Object 
Librarian object, the media object acts as a link to the URL.  

System administrators can set up templates that might include their own attachments, such as images 
and shortcuts. For example, you can create a letterhead and a standard form for a memo. Also, you 
might create a shortcut, to be included in the template, that provides access to an application that uses 
data specific to the information that you add to the template.  

See Also 
� Media Objects and Imaging in the System Administration Guide for system administration 

information 
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Working with Media Objects  
You can use the Media Objects feature to add text, graphics, and other objects to forms and records. 
For example, you can use a text attachment to explain special circumstances surrounding a journal 
entry. Or you can attach drawings, animations, and other types of objects to forms and records. A 
pop-up menu provides access to established templates for attachments and an option to set the 
properties for the Media Objects form.  

When you attach a media object to a form, the attachment might not be available if you access 
different data on the form. For example, if you attach a media object to a detail form that contains 
data for Order Number 2002, this attachment does not appear on the detail form that appears when 
you access data for Order Number 3003. The base form, which in this case is a detail form, is the 
same for both Order Numbers, but the data associated with the form is specific to each Order 
Number. The Order Number represents the key to the location where an attachment is stored.  

EnterpriseOne software supports Object Linking and Embedding (OLE). OLE allows you to create 
links among different programs. Using these links, you can save an object from one program into a 
different program. The system provides the links that you need to attach OLE objects. You can attach 
OLE objects as media objects and at the base form level. When you attach an object at the base level 
of the form, you attach the object to the form and not to any data that might appear in the form.  

If attachments exist for a form, a paper clip icon appears at the right of the status bar when you open 
the form. For an OLE object attached at the base form level, a document icon appears at the right of 
the status bar.  

When a form first opens, grid rows do not indicate whether attachments exist for the corresponding 
records. You can perform a search on every record that the system loads onto your workstation or you 
can search each record to determine whether attachments exist for records.  

The Text feature includes a word processor that lets you create, view, edit, and delete notes. When 
you create a text attachment, you can also set up templates. You can use templates to create a format 
for a frequently used media object.  

Checking for Attachments  
To find out whether an attachment exists for a record, you must first perform a search on the record. 
You can perform this search on one record or on a number of records simultaneously. The system 
only searches for attachments on records that you load onto your workstation. For example, when you 
initially click the Find button to locate a number of records, only the records that appear in the grid 
exist on your workstation. Use the page buttons to view more records.  

When you click the Find button to refresh the records in the grid or to display new records, the form 
resets the attachments view status. You must click the find attachments button again to display the 
attachments for the grid records.  

► To check for all attachments  

On a form with the attachments feature available, click the Checking for Attachments icon to the 
left of the row of column titles. This icon looks like a paper clip overlapping a magnifying glass.  

A paper clip icon appears in the row header for each loaded record with an attachment.  
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► To check for attachments for a single row or a range of rows  

1. On a form with the attachments feature available, hold the cursor over the row header for the 
grid row.  

If an attachment exists for the row, a paper clip icon appears in the row header.  

2. Move the cursor up or down in the row header column to search for attachments for adjacent 
rows.  

Attaching Media Objects  
Use the Attachments feature to attach text, photos, drawings, spreadsheets, video images, sounds, and 
application shortcuts to forms and grid rows. For example, you might attach the image of an invoice 
to a data entry record, attach a legal document to a record that describes a contractual agreement, or 
attach text that describes a process on a form. The attachments feature is not available on all forms.  

Note 

You cannot create attachments until an administrator has established and mapped media object 
queues as described in Media Objects and Imaging in the System Administration Guide.  

 

When you enter text, you can format the paragraphs and run a spell check. EnterpriseOne software 
also supports object linking and embedding (OLE).  

► To attach text  

1. On a form where attachments are available, do one of the following:  

• To attach text to a form, from the Form menu, choose Attachments.  

If attachments exist for the form, click the paper clip icon to the right of the status bar.  

• To attach text to a grid row, choose the row and then, from the Row menu, choose 
Attachments.  

The Media Objects workspace is split into two panels. The left panel is the icon panel and the 
right panel is the viewer panel. Icons for any files previously attached to the record appear in 
the icon panel.  

2. Do one of the following:  

• From the File menu, choose New, and then Text.  

• In the icon panel, click the right mouse button, choose New, and then choose Text from 
the pop-up menu.  

3. In the viewer panel, type the desired text.  

4. When you finish, from the File menu, choose Save and Exit.  

You can use the formatting tools at the top of the viewer panel to format the text of your note.  
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► To attach an image  

1. On a form where attachments are available, do one of the following:  

• To attach an image to a form, from the Form menu, choose Attachments.  

If attachments exist for the form, click the paper clip icon to the right of the status bar.  

• To attach an image to a grid row, choose the row and then, from the Row menu, choose 
Attachments.  

2. On Media Objects, do one of the following:  

• From the File menu, choose New and then Image.  

• In the icon panel, click the right mouse button, choose New, and then choose Image from 
the pop-up menu.  

3. Complete the following options:  

• Queue Name  

• Files of Type  

The Preview option contains a default checkmark to display a sample of the selected image. 
Toggle this option to display or hide the preview image.  

4. Choose an image, and then click OK.  

If the system supports the graphic format, the image appears in the viewer panel.  

5. When you finish, from the File menu, choose Save and Exit.  

► To attach an OLE object  

1. On a form where attachments are available, do one of the following:  

• To attach an OLE object to a form, from the Form menu, choose Attachments.  

If attachments exist for the form, click the paper clip icon to the right of the status bar.  

• To attach an OLE object to a grid row, choose the row and then, from the Row menu, 
choose Attachments.  

2. On Media Objects, do one of the following:  

• From the File menu, choose New and then OLE.  

• In the icon panel, click the right mouse button, choose New, and then choose OLE from 
the pop-up menu.  

3. On Insert Object, to create a new object, choose an object type and click OK.  

Selections vary from system to system depending on what the system administrator installs 
on your workstation and on the network.  

4. Create your object.  

5. To attach an existing object, choose Create from File, locate the object on your system, and 
then click OK.  
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Depending on whether you create an object or attach an existing object, the application 
associated with the object displays in the viewer panel either a blank workspace or the 
existing object.  

The menu bar displays the menus for the application from which you call the object. For 
example, if you select an Excel document, the Excel menus display on the menu bar.  

6. On Media Objects, edit the object in the viewer panel as necessary.  

7. When you finish, from the File menu, choose Save and Exit.  

► To attach a shortcut  

Include a shortcut to provide access directly from a record to an associated application.  

1. On a form where attachments are available, do one of the following:  

• To attach a shortcut to a form, from the Form menu, choose Attachments.  

If attachments exist for the form, click the paper clip icon to the right of the status bar.  

• To attach a shortcut to a grid row, choose the row and then, from the Row menu, choose 
Attachments.  

2. On Media Objects, do one of the following:  

• From the File menu, choose New and then Shortcut.  

• In the icon panel, click the right mouse button, choose New, and then choose Shortcut 
from the pop-up menu.  

3. On Open, browse through your files, choose the appropriate shortcut, and click Open.  

Your shortcut appears in the viewer panel.  

4. When you finish, from the File menu, choose Save and Exit.  

► To attach a URL or file  

Attach a URL to provide access to a Web page or a file on a disk. You can also attach file types that 
cannot be attached as images or OLE files, such as bitmaps.  

1. On a form where attachments are available, do one of the following:  

• To attach a URL or file to a form, from the Form menu, choose Attachments.  

If attachments exist for the form, click the paper clip icon to the right of the status bar.  

• To attach a URL or file to a grid row, choose the row and then, from the Row menu, 
choose Attachments.  

2. On Media Objects, do one of the following:  

• From the File menu, choose New and then URL/File.  

• In the icon panel, click the right mouse button, choose New, and then choose URL/File 
from the pop-up menu.  

3. On Add URL/File, browse your files or queues, choose the appropriate URL or file, and click 
Open. You can also type a URL in the field. 
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4. Click OK. 

5. When you finish, from the File menu, choose Save and Exit.  

Searching for Media Objects 

Note 

You can only search for media objects that already have codes defined for them and that your system 
administrator has made available to all users in the system.  

► To search for a media object  

1. On a form where attachments are available, do one of the following:  

If attachments exist for the form, click the paper clip icon to the right of the status bar.  

• To search for a media object to attach to a grid row, choose the row, and then from the 
Row menu, choose Attachments.  

Your URL or file appears in the viewer panel. If you are attaching a URL, a download dialog 
box appears. You can either verify that the URL is active or you can click Cancel. 

You can search for a specific media object in the system by using information such as creation date, 
alternate keys, or user defined codes.  

 

• To search for a media object to attach to a form, from the Form menu, choose 
Attachments.  

2. On Media Objects, do one of the following:  

• From the File menu, choose New and then Search.  

• In the icon panel, click the right mouse button, choose New, and then Search from the 
pop-up menu.  

3. On Media Object Search, complete the following field and click Find.  

• Type 

Enter the type of media object attachment for which you are searching. You can use the 
Query by Example line to limit your search.  

Only attachments with defined metadata appear.  

4. Choose an attachment and click Select.  

Your media object appears in the viewer panel.  

5. When you finish, from the File menu, choose Save and Exit.  
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Renaming Attachments 
 

When you add an attachment, the system displays its filename under its icon in the icon panel. You 
can rename the icon to make it more meaningful to other users if you want.  

► To rename an attachment icon  

1. On Media Objects, choose an icon and do one of the following:  

• From the File menu, choose Rename.  

• In the icon panel, click the right mouse button and choose Rename from the pop-up 
menu.  

2. Type a new name for the icon and then click anywhere on the form.  

Deleting Media Objects  
When you no longer need an attachment, use the Delete feature on Media Objects to remove the 
object. When you delete text, the text is permanently erased. When you delete images and OLE 
objects, you remove the attachment of the file to the record. The system continues to store a file for 
the object.  

► To delete an object  

1. On a form where attachments are available, do one of the following:  

• To delete an attachment to a form, from the Form menu, choose Attachments.  

If attachments exist for the form, click the paper clip icon to the right of the status bar.  

• To delete an attachment to a grid row, choose a row with a paper clip icon, and then, 
from the Row menu, choose Attachments.  

2. On Media Objects, choose the appropriate icon in the icon panel and then choose Delete from 
the File menu.  

3. On Confirm Media Object Delete, click Yes to confirm the deletion. 

The icon disappears from the icon panel.  

4. When you finish, from the File menu, choose Save and Exit.  

Working with Templates  
On Media Objects, you can access the Work With Media Objects Templates form. On this form, you 
can attach, create, modify, and delete templates to help you format your text attachments.  
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► To create a template  

1. On a form where attachments are available, choose the row from which you want to attach a 
template, and then choose Attachments from the Row menu.  

2. On Media Objects, in the icon panel, click the right mouse button and choose Templates from 
the pop-up menu.  

3. On Media Objects Template, click Add.  

4. On Media Object Template Revisions, complete the following fields, and then enter your 
template information into the workspace:  

• Template Name  

• Description  

5. Click Add. 

► To attach a template  

1. On a form where attachments are available, choose the row to which you want to attach a 
template, and then choose Attachments from the Row menu.  

2. On Media Objects, in the icon panel, click the right mouse button and choose Templates from 
the pop-up menu.  

3. On Work With Media Object Templates, click Find.  

You can use the query-by-example line to refine your search.  

4. To preview the template, double-click the paper clip icon in the row header.  

5. Choose the grid row for the template that you want to attach, and then click Select.  

6. The template appears in the workspace on Media Objects.  

► To modify a template  

1. On a form where attachments are available, choose the row from which you want to modify a 
template, and then choose Attachments from the Row menu.  

2. On Media Objects, in the icon panel, click the right mouse button and then choose Templates 
from the pop-up menu.  

3. On Work With Media Object Templates, click Find.  

You can use the Query by Example line to refine your search.  

4. Choose the grid row for the template that you want to modify and then click Select.  

5. On Media Objects, modify the template as necessary and then from the File menu, choose 
Save and Exit.  

► To delete a template  

1. On a form where attachments are available, choose the row from which you want to delete a 
template, and then choose Attachments from the Row menu.  

2. On Media Objects, in the icon panel, click the right mouse button and then choose Templates 
from the pop-up menu.  
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3. On Work With Media Object Templates, click Find.  

You can use the Query By Example line to refine your search.  

4. Choose the grid row for the template that you want to delete, click Delete, and then on 
Confirm Delete, click OK.  

► To delete a template on Media Objects  

1. On a form where attachments are available, choose the row from which you want to delete a 
template, and then choose Attachments from the Row menu.  

2. On Media Objects, in the icon panel, choose the text icon for the template, and then choose 
Delete from the File menu.  

3. On Confirm Media Object Delete, click Yes. 

The template and the text icon disappear.  

Working with the Properties of Media Objects  
The pop-up menu that appears when you click the right mouse button in the icon panel on Media 
Objects provides you with the option to view and, for some objects, to change the properties of an 
object. Each object has unique properties.  

In addition, you can define metadata for an object. Metadata contains information about the object, 
such as a description of the object, who created it, and when it was created. Other users can search for 
the object based on this information.  

► To set Media Objects properties  

1. On Media Objects, in the icon panel, click the right mouse button and then choose Properties. 

The form or row must contain an attachment in order to access the Media Objects properties. 

2. On Properties, review the following on the Key Information tab:  

• Technical information about the key for the form  

3. Click the Flags tab and review the following information:  

• Allow Text Items  

• Allow Image Item 

• Allow OLE Items  

• Allow RTF Text  

• Show Text Item On Open  

• Read Only  
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► To set text properties  

1. On Media Objects, in the icon panel, click the right mouse button over a text icon, and then 
choose Properties from the pop-up menu.  

2. On the text properties form, review the following fields on User Audit Information:  

• Created by  

• Date Created  

• Time Created  

• Updated By  

• Date Updated  

• Time Updated  

3. Click the Printing Information tab and then do the following, if necessary:  

• Click the Check to print before report item option  

• Complete the Effective From field  

• Complete the Effective To field  

► To set image properties  

1. On Media Objects, in the icon panel, click the right mouse button over an image icon, and 
then choose Properties from the pop-up menu.  

2. On the Image Properties tab, review the following fields:  

• File Name  

• Queue Name  

• Queue Path  

3. To give the image a title, complete the following field:  

• Description  

► To view OLE properties  

1. On Media Objects, in the icon panel, click the right mouse button over an OLE object icon, 
and then choose Properties from the pop-up menu.  

2. On the OLE Object Properties tab, review the following fields:  

• File Name  

• Queue Name  

• Queue Path  
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► To set shortcut properties  

1. On Media Objects, in the icon panel, click the right mouse button over a shortcut icon, and 
then choose Properties from the pop-up menu.  

2. On the JDEShortcut Control Properties form, review the following fields on the General tab:  

• Menu Name  

• Selection  

• Icon File  

• Icon Index  

3. Do the following, if necessary:  

• Click the Colors tab to set the color for the shortcut hypertext.  

• Click the Fonts tab to set font properties such as size, family, bold, italics, underline, and 
strikeout.  

Adding Metadata to Media Objects 
The system allows you to add information to media objects in the form of metadata. Metadata can 
include items such as author, creation date, and language of the media object attachment. 

Before you can add metadata, you must enable the metadata fields for the media object in the Media 
Object Category Constants program (P00167). 

► To enable metadata fields for media objects 

From the GH9016 menu, choose Media Object Constants (P00167). 

1. On Work With Media Object Category Constants, find the media object that you want to 
enable.  

The system will enable the metadata fields for all the media objects that are associated with 
the media object that you choose. 

2. Highlight the media object and then click Select. 

3. On the General tab of Media Object Category Constants Revisions, click the check boxes 
next to the available metadata field options to enable those metadata fields in the media 
object. 

4. Click OK. 

► To view and define metadata  

1. On any form with an attachment, in the Media Objects icon panel, right-click an object icon, 
and then choose Characterize Object from the pop-up menu.  

2. On the Media Object Category Revisions form, click the General tab, and then complete the 
available fields for the media object. 

3. Click OK.  
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Attaching OLE Objects at the Base Form Level  
At the base level of a standard form, you can attach OLE objects using the OLE Objects button on the 
Links toolbar. Menu bars and toolbars appear on all standard forms. When you attach an OLE object 
at the base level of a form, rather than associating the attachment with a record, the OLE object 
attaches only to the form. No matter what record appears on the form, the OLE object that you attach 
using the OLE Objects button will always appear when you open the form.  

► To attach OLE objects at the base form level  

1. On any standard form, do one of the following: 

• From the Links toolbar, choose Preferences, and then OLE Objects.  

• From the Preferences menu, choose OLE Objects.  

• If attachments exist for the form, click the document icon to the right of the status bar.  

2. On the Choose Queue form, choose the appropriate queue. 

Note 

If you do not know the queue in which the object you want to attach exists, ask your system 
administrator.  

 

3. On the OLE Objects form, do one of the following:  

• From the File menu, choose Add Object.  

• In the icon panel, click the right mouse button and then choose Add Object.  

4. On Insert Object, to create a new object, choose the type of object that you want to create and 
then click OK.  

Selections vary from system to system depending on what the system administrator installs 
on your workstation and on the network.  

5. Create your object.  

6. To attach an existing object, choose Create from File, locate the object on your system, and 
then click OK.  

Depending on whether you create an object or attach an existing object, the application 
associated with the object displays either a blank workspace or the existing object in the 
viewer panel.  

The menu bar displays the menus for the application from which you call the object. For 
example, if you choose an Excel document, Excel menus display on the menu bar.  

7. Edit the object in the viewer panel.  

8. To return to the main form, click the X button on the OLE Objects form in the application 
workspace.  
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► To delete OLE objects at the base form level  

1. On any standard form, do one of the following:  

• From the Links toolbar, choose Preferences and then choose OLE Objects.  

• From the Preferences menu, choose OLE Objects.  

• Click the document icon to the right of the status bar.  

2. On the OLE Objects form, choose the object and do one of the following:  

• From the File menu, choose Delete Object.  

• In the icon panel, click the right mouse button and choose Delete Object.  

3. On Confirm Media Object Delete, click Yes. 

4. To return to the main form, click the X button on the OLE Objects form in the application 
workspace.  
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MailMerge Workbench  

MailMerge Workbench merges Microsoft Word 6.0 (or higher) word processing documents with 
EnterpriseOne system records to automatically print business documents, such as form letters. Some 
application suites, such as Human Resource Management, use these documents within their normal 
workflow process. See your application guides to determine which applications use mail-merge 
documents. In these applications, the system automatically prints the mail-merge documents as part 
of the workflow process, and no user intervention is needed.  

You can use the Maintain MailMerge Documents application to add or change text in the business 
documents included with EnterpriseOne software to create new documents and to delete documents.  

EnterpriseOne software allows you to create HTML versions of mail-merge documents to send to 
Web client users. After you add text and fields to the mail-merge document, you can copy it to an 
HTML version so that you can send mail-merge letters to Web client users. When a mail-merge letter 
is generated, the system displays the letter in the Web Mail Merge program (P05WEBMM). 

Modifying Mail-Merge Documents  
Use the Maintain Web MailMerge Documents program (P980014W) to change the description of a 
mail-merge document and the Microsoft Word file associated with the mail-merge document. You 
can change the description of a mail-merge document, but you cannot change the name of the 
document or its data structure. You can add, change, or delete any text or mail-merge fields in the 
Microsoft Word file.  

When you modify a mail-merge document, the system gives you the option to save the document as 
HTML to generate letters for Web client users. 

► To modify a mail-merge document  

Note 

You must have Microsoft Word 6.0 (or higher) on your local workstation to make changes to the 
content of a mail-merge document.  

 

On HRM Setup (G05B4), choose MailMerge Workbench Setup (P980014W). 

1. On Work With Web Mail Merge Templates, click Find.  

A list of available mail-merge documents appears in the detail area.  

2. Choose a document and click Select.  

3. On Mail Merge Web Document Details, you can modify the description of the mail-merge 
document in the following field:  

• Description 

Enter a text description of the mail-merge document.  

115 



Note 

You cannot modify the document name, queue name, or the data structure. If you want to 
modify any of these attributes, you must add a new mail-merge document. See Adding Mail-
Merge Documents in the Foundation Guide.  

 

4. Click OK. 

5. On Work With Web Mail Merge Templates, choose the document and then, from the Row 
menu, choose EditDoc.  

The document displays as a media object with Microsoft Word as the editor.  

6. On Mail Merge Web Template, change the text of your document using Microsoft Word 
formatting controls and tools.  

7. Change mail-merge fields in your document. To insert a new field, choose a field from the 
Insert Merge Field drop-down list on the Microsoft Word toolbar. 

You can delete fields as you would delete any other text.  

8. To copy and paste the document to an HTML version, highlight and copy the contents of the 
document and then click Edit HTML on the toolbar. 

A Microsoft Word document appears. 

9. Paste the contents into the Word document.  

10. From the File menu, choose Save as Web Page, and then close Word. 

11. On Mail Merge Web Template, click OK.  

See Also 
� Microsoft® Word documentation for information about how to use Microsoft® Word 

Adding MailMerge Documents  
Several predefined mail-merge documents come installed with EnterpriseOne software. These 
documents should be sufficient for many of your applications. However, if you need to add your own 
documents, you will need to use Maintain Web MailMerge Documents in conjunction with creating 
or changing the business function that links the mail-merge document with the workflow process of 
the application, such as Human Resource Management. You will also need to understand and use 
EnterpriseOne software data structures.  

Caution 

Only system administrators or information technology (IT) personnel should add mail-merge 
documents because it involves EnterpriseOne software business functions and data structures. For 
information about business functions and data structures, see the Development Tools Guide. 
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► To add mail-merge documents  

1. On HRM Setup (G05B4), choose MailMerge Workbench Setup (P980014).  

2. On Work With Web Mail Merge Templates, click Add.  

3. On Mail Merge Web Document Details, complete the following fields, and then click OK:  

• Document Name 

Enter a name for your mail-merge document. It must be no more than 10 characters in 
length. 

• Description 

Enter a text description for your mail-merge document. 

• Queue Name 

Enter OLEQUE into this field, which is a path location already set up for you in the 
system. This location is where your mail-merge documents are stored. If you use a queue 
other than OLEQUE, you should set it up on a central server so that others in the 
enterprise can access your mail-merge documents. The path information for OLEQUE is 
stored in the Media Object Queues (F98MOQUE) table.  

• Data Structure Name 

Enter the name of the data structure that you want to use with your mail-merge document. 
The data structure contains all of the possible fields that you can use in your mail-merge 
document.  

The Header Record Delimiters form appears. Use this form to specify what text symbol the 
system should recognize as the delimiter between fields in the header file. MailMerge uses 
the header file to identify the fields that you used in your mail-merge document. The system 
automatically creates the header file. 

4. On Header Record Delimiters, enter the following (the pipe character) into the Field 
delimiter:  

• |  

The Data Record Delimiters form appears. Use this form to specify what text symbol the 
system should recognize as the delimiter between data in the data file. The data file contains 
the system record information that merges with your mail-merge document when it prints. 
The system automatically creates the data file.  

5. On Data Record Delimiters, enter the pipe character (|) into the Field delimiter field and click 
OK.  

A new Microsoft Word document appears in the Mail Merge Web Template form.  

6. Type the text of your document using Microsoft Word formatting controls and tools.  

7. Enter mail-merge fields into your document. 

From the Microsoft Word toolbar, on the Insert Merge Field menu, choose a field. You can 
enter fields as you type the text of your document.  
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The data structure that you designated for your document determines which fields are 
available.  

8. To copy and paste the document to an HTML version, highlight and copy the contents of the 
document and then click Edit HTML on the toolbar. 

A Microsoft Word document appears. 

9. Paste the contents into the Word document.  

10. From the File menu, choose Save as Web Page, and then close Word. 

11. On Mail Merge Web Template, click OK.  

For this new mail-merge document to work within your application's workflow, you must change the 
business function associated with the document.  

Note 

See Business Functions in the Development Tools Guide for information about changing business 
functions. 

 

Deleting MailMerge Documents  
Use MailMerge Workbench Setup to delete mail-merge documents.  

Caution 

Before you delete a mail-merge document, make sure it is not set up to print with the workflow 
process of an application. 

 

 

► To delete mail-merge documents  

On HRM Setup (G05B4), choose MailMerge Workbench Setup (P980014).  

1. On Work With Web Mail Merge Templates, click Find.  

A list of available mail-merge documents appears in the detail area.  

2. On Work With Web Mail Merge Templates, choose the document and click Delete.  

A message box appears to verify that you want to delete the chosen document.  

3. Click OK.  
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Interactive Versions for Applications  

In EnterpriseOne software, a version is a user-defined set of specifications. These specifications help 
to control how interactive applications run. Interactive versions are associated with applications 
(usually as a menu selection) and always run on a workstation.  

Interactive versions for applications contain processing options with different sets of data for each 
version. These processing options are passed to the application when it runs.  

Versions allow you to modify the behavior of applications because they exist independently of the 
application. Typically, administrators control the creation, modification, and location of the actual 
version tables. When you upgrade EnterpriseOne software applications to a new release level, you 
can apply the existing versions to the new applications.  

When a user starts an interactive application, the user might have the option to choose from a list of 
versions. A user only has this option if the application designer attached processing options to the 
application. If the system administrator sets the application for blind execution during menu design, 
when the user starts the application, the application uses the default version without providing a list of 
versions. Depending on how you assign security to your EnterpriseOne software applications, end 
users can choose or create different versions based on business requirements.  

For example, on the System Administration Tools menu (GH9011), the Interactive Versions option 
(P983051) does not have processing options attached, so a version does not exist for the application. 
However, the Work With Servers application (P986116) has processing options attached so that the 
system administrator must attach a version for the application. Otherwise, the application will not 
open successfully. For each interactive application, the system administrator can set up multiple 
versions that contain different specifications for each version, such as different levels of security.  

How Processing Options Affect Versions  
The processing options that you define in versions are a set of parameters that alter how an 
application runs. They are similar to initialization (.ini) files and command-line arguments for a 
traditional executable. These processing options let you specify the options that you want when you 
open an application. For example, you can specify the appearance of a form, show or hide a field, 
change the default status for order activity rules, and set default information to appear in a field.  

The following examples illustrate how processing options allow you to set up run-time overrides for 
applications:  

• Change the functionality of an application. For example, you can set up processing options to 
turn on or turn off logic in order holds. You also can specify whether you want to 
automatically print pick slips after you enter an order.  

• Change default values. For example, in Sales Order Entry you can set up processing options 
to set default values for document type values (such as Sales Order or Sales Quote) or line 
type (such as stock or nonstock item).  

• Control the display of forms. For example, you can set processing options to hide or show a 
cost field, a price field, or a commission field.  

Not all EnterpriseOne applications have processing options. If the Prompt For Values option on the 
Edit menu is grayed out, either no processing options are associated with the application or the 
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system administrator has disabled the processing options. To use versions with an application, you 
must first attach processing options to the interactive application. 

The system administrator can secure a version for an application. In this case, the Prompt For Version 
option on the Edit menu appears grayed out. When a user opens a secured version of an application 
from the Work With Interactive Versions application, a security message appears to alert the user that 
she or he does not have access to the version.  

How Interactive and Batch Versions Differ  
Interactive versions have processing options and user overrides. Batch versions have processing 
options, data selection and sequencing, and template overrides. You do not check in and check out 
interactive versions, whereas batch versions have local specifications that must be checked in and 
checked out.  

See Also  
� Security in the System Administration Guide for more information about securing processing 

options and versions  

Working with Interactive Versions  
When you work with interactive versions, you change processing options, version detail, and copy or 
create versions. Interactive versions must be associated with a menu selection through the Solution 
Explorer so that the system can run the version.  

In Solution Explorer, you can display the available versions of an interactive application by choosing 
Prompt for Version from the Edit menu or by choosing the Interactive Versions (P983501) menu 
selection. Filter the versions that you want to display to show all versions or only your versions. To 
filter the version display, choose the Display option from the Form menu.  

See Also  
� Creating Reports of Processing Options in the Foundation Guide for information about 

creating reports that show the processing option text and values for specified interactive and 
batch versions  

Working with Version Detail for Interactive Versions  
You use version detail to change the title of a version, determine how the user is prompted for 
processing options, or specify a security level. You can also review information such as the date the 
version was last modified and the user who performed the modification.  

Note 

Depending on your security level and the level of security for the version, you might not be able to 
change the version detail information.  
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► To work with version detail for interactive versions  

1. On System Administration Tools (GH9011), choose Interactive Versions (P983051)  

2. On Work With Interactive Versions, enter an application ID in the Interactive Application 
field and click Find. 

For example, to locate a version for the Sales Order Entry application, enter P4210.  

3. In the grid, choose a version with which to work.  

4. From the Row menu, choose Version Detail.  

5. On Version Detail, you can modify the following information:  

• Version Title 

Enter information that describes the use of a version in this field.  

• Prompting 

The value that you enter determines whether the processing options for the version are 
disabled, run with blind execution, or chosen by the user at run time. 

• Security 

The value that you enter in this field determines the security for the version, ranging from 
no security to full security. This security is based on the user and is not related to the 
application security. Depending upon your security level and the level of security for the 
version, you might not be able to work with version detail.  

• Client Platform 

The value that you enter determines whether the version will be available for Windows 
client users, Web client users, or both. The default is set for both Windows client and 
Web client. 

6. Review the additional information that appears on the form, as needed.  

Copying an Interactive Version  
You can copy an existing version and then tailor its information to fit your needs. The copied version 
inherits the processing option values of the existing version.  

When you copy a version, you should add security to the new version. Security settings range from 
none (anyone has the authority to modify or run the version) to full (only the person who last 
modified the version can modify and run the version).  

Note 

Depending on your security level and the level of security for the version, you might not be able to 
copy the version. 
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► To copy an interactive version  

1. On System Administration Tools (GH9011), choose Interactive Versions (P983051).  

2. On Work With Interactive Versions, enter an application ID in the Interactive Application 
field and click Find. 

For example, enter P01012 to locate a version for the Address Book application.  

3. In the grid, choose a version with which to work.  

4. Click Copy.  

5. On Version Copy, complete the following information and then click OK:  

• New Version 

Enter a unique identifier for this version of the application in this field.  

• Version Title 

Enter information that describes the use of a version in this field.  

• Security 

The value that you enter in this field determines the security for the version, ranging from 
no security to total security.  

6. On Interactive Version Design, click one of the following options: 

• Revise Version 

Click this option to access the Version Detail form and modify this version. 

Note 

See Working with Version Detail for Interactive Versions in the Foundation Guide for more 
information about modifying versions. 

 

• Processing Options 

Click this option to change the processing options for the version. 

• Run 

Click this option to run the version. 

7. Click OK when you are finished modifying the interactive version. 

Creating (Adding) an Interactive Version  
You can create (add) a new interactive version that is not based on an existing version. When you 
create an interactive version, you should add security to the new version. Security settings range from 
none (anyone has the authority to modify or run the version) to full (only the person who last 
modified the version can modify and run the version).   
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► To create (add) an interactive version  

1. On System Administration Tools (GH9011), choose Interactive Versions (P983051).  

2. On Work With Interactive Versions, enter an application ID in the Interactive Application 
field and click Add. 

For example, to add a version for the Sales Order Entry application, enter P4210.  

3. Click Add to create a new version.  

4. On Version Add, complete the following fields:  

• Version 

Enter a unique identifier for this version of the application in this field.  

• Version Title 

Enter information that describes the use of a version in this field.  

• Prompting Options 

The value that you enter in this field determines how the version assigns processing 
options, such as no processing options or blind execution, or prompts the user to choose 
options at runtime.  

Blank is not a valid value when you add a version. All versions for interactive 
applications must have processing options attached.  

• Security 

The value that you enter in this field determines the security for the version, ranging from 
no security to full security.  

5. On Interactive Version Design, click one of the following options: 

• Revise Version 

Click this option to access the Version Detail form and modify this version. 

Note 

See Working with Version Detail for Interactive Versions in the Foundation Guide for more 
information about modifying versions. 

 

• Processing Options 

Click this option to change the processing options for the version. 

• Run 

Click this option to run the version. 

6. Click OK when you are finished adding the interactive version. 
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See Also  
� Menu Design in the System Administration Guide for information about how to add a version 

to a menu selection  

� Interactive Version Processing Options in the Foundation Guide 
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Batch Versions for Reports  

In EnterpriseOne, a batch version is a user-defined set of specifications. These specifications control 
how batch processes run. Typically, batch versions are associated with reports or batch processes, and 
run as batch jobs on a EnterpriseOne enterprise server.  

Batch versions for reports are a predefined set of specifications contained in a file that is separate 
from the base report or batch specifications. These specifications control the logical functions and the 
appearance of the report. The version contains the processing instructions, which are a complete set of 
preselected processing options and additional characteristics specific to report design. Depending on 
how you assign security to your EnterpriseOne applications, end users can choose or create different 
versions based on business requirements.  

Versions are a powerful and convenient way to modify the behavior of reports. Typically, 
administrators control the creation, modification, and location of the initial batch version files. When 
you upgrade EnterpriseOne or a specific application to a new release level, you can apply the existing 
batch versions without additional modification.  

When you start a batch application (that is, when you submit a batch job) you must use a batch 
version. Depending on how the report was designed, you might have the option to override 
processing option values for the version. You also might be able to perform data sequencing and data 
selection, override default locations, or override the basic layout of the base report.  

For example, suppose you have a report that prints the same financial information to two different 
audiences: an American subsidiary and a French subsidiary. You can create an American version, 
which shows financial information in dollars for a specific time period and formats the report for 
American-sized paper. You also can create a French version, which shows the financial information 
in Euros for a different time period and formats the report for European-sized paper. For the French 
subsidiary, you also could display additional information on the report by adding data items in the 
French version.  

Characteristics of Batch Versions  
A batch version is defined by the following characteristics:  

• Data sequencing at the version level. For example, you can sort checks by date or by check 
number, you can sort address book records by employee or customer, or you can sort records 
alphabetically.  

• Data selection at the version level. For example, you can specify which records to fetch, such 
as Business Unit 10-30 and 70, or all Address Book records with Category 1=North.  

• Additions or overrides in the version at the section level. At the section level, report designers 
can use batch versions to add or override functionality using the report template. These 
section-level overrides differ from the version-level overrides in that they apply only to 
individual sections. At the section level, the report designer can override section layout, data 
selection, data sequencing, event rules, and database output. You cannot delete functionality 
if it exists in the base report.  

• A specific set of processing option values. For example, you can set a processing option value 
to run G/L Post to print a different account number format on the report.  
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For batch versions, processing options do the following:  

• Change functionality. For example, you can set a processing option to purge records to a 
history file after a report runs.  

• Change input parameters. For example, you can set a processing option to specify which 
category code to use when processing a report.  

• Define data. For example, you can set a processing option to define the fiscal year for 
which you want to run a report. You can also define the number of aging days in an 
Accounts Receivable aging report.  

Batch Versions Created Using the Web Client  
If you use a Web client, you can create a new batch version of a report using the Add or Copy options 
on the Web client Work With Batch Versions - Available Versions form. The system indicates that 
these new batch versions are Web Only. To change the data selection, sequencing, or processing 
options of a Web Only version, choose the Data Selection, Data Sequencing, or Processing Options 
option from the Row menu. 

To run a Web Only version in an environment other than the Web client, use Object Management 
Workbench to check the version out, and then check it in using the standard client. Object 
Management Workbench automatically converts the Web Only version to work on a standard client. 

To permanently remove the Web Only flag, so that it becomes a standard version, generate the batch 
version using the eGenerator tool after converting the version.  Since there must be specifications on 
the machine where the eGenerator tool is run, either run the conversion process on the same machine 
that runs the eGenerator tool, or use a “Get” within Object Management Workbench to bring the 
specification to the client running the eGenerator tool. 

You cannot copy a batch version with a Web Only indicator. 

See Also 
� Generating EnterpriseOne Serialized Objects in the Web Server Installation Guide for 

instructions on using eGenerator 

Working with Batch Versions  
For batch versions, EnterpriseOne uses the same process as the Object Management Workbench to 
check in, check out, and erase checkouts for versions. You use Object Management Workbench to 
control the movement of versions between the workstation and the server. Batch versions are 
submitted directly from the batch application.  

Just like base report specifications, when you create a batch version, the specification records for that 
version exist only on your workstation. To make the version available to other users, you must check 
the version into the server. When you check in a version, EnterpriseOne copies the version's 
specification records to the central objects data source (server) according to the path code of your 
current environment.  

After you check in your version, you can still make specific changes to the version without checking 
it out. For example, when you make changes to the processing options, these changes are effective 
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immediately, even if you have not checked in your local version. This is because a version's 
processing options are stored directly as a field in the version record that is stored in the server 
Versions List table (F983051).  

When you check a batch version into the central objects data source (server), anyone who installs and 
runs the version will be ensured of having the updated version. A version cannot be checked out by 
more than one user. The Version Detail form displays the user that has checked out a version.  

You can create a new batch version that is not based on an existing version. For example, you might 
create a new version because you do not want to use the layout or data selection of the existing 
version. When you create a new version, you use the specifications provided by the base report.  

If you make changes to the base (template) report, EnterpriseOne automatically "pushes" any changes 
to all of the versions that exist for that base report, unless you created a version that contains 
overrides.  

If you copy a version, the copied version inherits the same data selection and data sequencing as the 
existing version.  

See Also 
� Changing the Design of a Batch Version in the EnterpriseOne Report Writing Guide for 

information about overrides  

Running a Batch Version  
If batch versions are associated with a form, you can access them for viewing and printing from the 
form's Reports menu. Base reports and versions of those reports are available on menus as icons.  

In most cases, you submit batch versions to an enterprise server, which can more efficiently handle 
the processing. The EnterpriseOne environment that you log on to specifies where your batch 
versions will run, although you can override this location when you submit a batch version. When 
you submit your batch job to the server, you can preview the report and use the Work With Servers 
program (P986116) to monitor the progress of your job in the queue.  

When you submit a report to the enterprise server, if the report specifications do not currently reside 
on your workstation, the central objects data source (server) first performs JITI (just-in-time 
installation) to transfer the specifications to your workstation. After the JITI, your workstation 
continues with the submission of the report to the enterprise server, and EnterpriseOne transfers the 
local version specifications (any changes you made to the version) to the enterprise server.  

If a batch version is flagged as Web Only, and you are running the batch version on a fat client you 
must convert it into a flat client version before you can run it. To convert the web only batch version, 
use Object Management Workbench to check the batch version in, then check it out. 

See Also  
� Submitting a Report in the EnterpriseOne Report Writing Guide for complete information 

about running a batch version  

� The Work with Servers Program in the Configuration Planning and Setup: System 
Administration Guide for information about the Work With Servers form 
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Accessing the Work With Batch Versions Form  
You can access the Work With Batch Versions - Available Versions form, which is the entry point to 
managing batch versions, in one of several ways.  

► To access the Work With Batch Versions form  

Open PeopleSoft Solution Explorer. 

From the Report Writer (GH9111) menu, choose Batch Versions (P98305).  

The Work With Batch Versions – Available Versions form appears.  

Related Tasks 

Other methods of accessing the Work With Batch Versions form include: 

• From any menu with a batch application, choose the batch application and then, from the Edit 
menu, choose Prompt for Versions.  

• From any menu with a batch application, right-click the batch application and then, from the 
pull-down menu that appears, choose Prompt for Versions. If no versions are associated with 
the batch application, you must copy or add a version and run that version as explained in this 
section.  

• On the Menu bar, choose Tools and then Batch Versions. 

Changing the Design of a Batch Version  
To change the specifications for a version, you do not need to change the base report template; 
instead, you can override the report specifications at the version level. The changes you make to the 
report specifications for the version do not affect any other version associated with the base report 
template. However, if you change the specifications at the report template level, those changes will 
not be pushed down to the version if an override has been applied to that specification type.  

When you change the specifications at the version level, you should include a description of your 
modifications in the Version Detail field on the Version Detail form. The description should include 
any differences between the base report specifications and the version specifications.  

The following can be changed in a report version:  

• Section Layout  

• Section Data Selection  

• Section Event Rules  

• Section Database Output  

• Section Sort Sequence  
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Note 

If you are using the Web client, you can only make run-time changes to a version if the version is not 
flagged as Web Only. Run-time changes do not persist.  

 

See Also 
� Working with Version Detail for Batch Versions in the EnterpriseOne Report Writing Guide 

Prerequisites 
� Override specifications only at the version level. To copy or create a version to override, see 

Copying a Batch Version or Creating a Batch Version in the EnterpriseOne Report Writing 
Guide. 

� Check out the version before you access Report Design to create a version override; see 
Checking Out or Checking In a Batch Version in the EnterpriseOne Report Writing Guide. 

� Close the Report Design tool if it is open on your computer. 

► To change the design of a batch version  

Use the Batch Versions program (P98305) to locate and run versions of reports. In addition, you can 
modify version detail information, data selection, and data sequencing.  

From the System Administration Tools menu (GH9011), choose Batch Versions. 

1. On Work With Batch Versions - Available Versions, complete the following field: 

• Batch Application 

For example, to locate a version for the One Line Per Address program, type R014021.  

2. Click Find to locate the versions available on your workstation.  

When you click Find, the Read Only Report field displays whether the report template is for 
an update report (Y) or a non update report (N). A read only report can read the database, but 
cannot update the database. 

3. For alternate lists of versions in the EnterpriseOne environment, choose Display from the 
Form menu, and then choose one of the following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for the versions you created  

• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

You can delete any version (depending upon your application and user security) unless you 
are on a web client. If you are on a web client, you can only delete the versions that have a 
Web Only flag. If you try to delete a version that is not on your machine, a warning message 
appears.  

4. In the detail area, choose a version with which you want to work.  
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5. From the Row menu, choose Advanced.  

Note 

Before you can complete the following steps, you must have already checked out a version of 
the report.  

 

6. On Advanced Operations, choose Design Version from the Row menu.  

Report Design opens with the report specifications for the version.  

7. On Report Design, click in a section and then choose Override Version Specifications from 
the Section menu.  

You cannot make any changes to a section until you access the Override Version 
Specifications form and choose what you want to change.  

Any overrides you make to a section are valid only for that section. You need to override 
additional sections individually.  

8. Choose any of the following overrides, and then click OK:  

Note 

Remember that if you override any version specifications, those specifications are not 
updated if you then make changes to those specifications in the base report template. For 
example, if you turn on the Section Data Selection override and make changes to the version's 
data selection, and then later you change the data selection of the report template, the report 
template data selection changes will not be pushed to the version.  

 

• Section Layout  

Select this override if you need to change section properties or to delete a column, add a 
new column, move a column, or change column headings on a report version.  

• Section Data Selection  

Select this override if you need to have report versions that utilize specific data selection, 
such as a version for customer information only and a version for employee information 
only.  

• Section Event Rules  

Select this override if you need a report version that utilizes a specific event rule, such as 
a version for employee information with a calculated percentage raise amount, date title, 
or Balance Auditor.  

• Section Database Output  

Select this override if you need a report version that prints to a specific location other 
than the default printer location. If you want other sections, such as the page header, to 
also print to this location, you need to override the specifications to each of those sections 
as well.  
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• Section Sort Sequence  

Select this override if you need a report version that is sorted differently than the base 
report. For example, you can have a version sort by name rather than by address number.  

9. The changes you make affect only the version on your local workstation. To make these 
changes available to the enterprise, you must now check in the version. If you do not check in 
the version, verify that you erase your checkout so that others can check out this version.  

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Checking Out or Checking In a Batch Version for information about checking batch version 
in and out 

� Erasing the Check-Out Record of a Version for information about erasing version check-out 
records 

Changing Processing Options for Batch Versions  
You can change the processing option settings for an existing batch version to suit your needs. For 
example, you can change the processing option values that direct the system to show or hide a field or 
you can change order activity rules. Not all batch versions have processing options associated with 
them; for example, a list of addresses might not require special prompting.  

Processing option changes are stored for each UBE run. Unlike other changes to versions, changes to 
processing option values do not require you to check in or check out the version. Anyone who uses 
that version after you make the change will not be affected by the new processing option values.  

If you are using a Web client, you can change the processing options of Web Only versions both at 
run time and within the version specifications. If the version is not marked Web Only, you can only 
change the processing options at run time. Run-time changes are not persistent. 

Note  

You should not modify EnterpriseOne demo versions, which contain ZJDE or XJDE prefixes. You 
should either copy these versions or create new versions to change any values, including the version 
number, version title, prompting options, security, and processing options.  

 

Prerequisite 
� If you access processing options from the Row menu of the Work With Batch Versions form, 

you must check out the version to your machine. See Checking Out or Checking In a Batch 
Version in the EnterpriseOne Report Writing Guide.  

► To change processing options for batch versions  

From the System Administration Tools menu (GH9011), choose Batch Versions (P98305).  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field. 

For example, to locate a version for the One Line Per Address report, type R014021.  
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2. Click Find to locate the versions available on your workstation.  

Alternatively, on Work With Batch Versions - Available Versions, from the Form menu, 
choose Display and then click one of the following:  

• Available Versions 

All versions available on your workstation are shown.  

• My Versions 

Only the versions you created are shown.  

• All Versions 

All versions that exist for the batch application are shown. When you view All Versions, 
you can work only with versions that appear in black text.  

3. In the detail area, choose the version with which you want to work.  

The Work With Batch Versions form shows only the versions available to your workstation, 
including any versions you create locally. Versions created on another machine must first be 
checked in to the central objects data source (server) before they appear on this form.  

4. From the Row menu, choose Processing Options.  

If processing options do not exist for this version, or if you have been secured from changing 
processing options, a message box appears informing you of this; otherwise, the Processing 
Options form appears for the application. On this form, you can define the values that control 
how your report processes.  

You can also access the Processing Options form in the following ways:  

• Choose a batch application, and then choose Prompt for Values from the Edit menu on 
PeopleSoft Solution Explorer.  

• Right-click the batch application name in PeopleSoft Solution Explorer, and then choose 
Prompt for Values from the pull-down menu that appears.  

5. Click each tab to view and change information on that tab.  

If multiple tabs exist and you cannot see all of them, left and right arrow buttons appear on 
the form. Click the arrow buttons to view the other tabs. You can also resize the Processing 
Options form by pointing to the edge of the form and dragging, or use the scroll bar to view 
additional processing options on a tab.  

6. Change the processing option values as appropriate, and then click OK.  

Accessing Data Selection and Sequencing for Batch 
Versions  

With batch versions, you can choose certain data values to narrow the range of your report. For 
example, you can choose to view only customers from New York. You can also sequence how you 
want your data presented in the report. For example, you can place your search type field first, 
followed by your address number and then the employee name.  
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You can select and sequence your data from one of two places, either from the Work With Batch 
Versions form, as explained here, or from the Version Prompting form.  

If you are using a Web client, you can change the data selection and sequencing for Web Only 
versions both at run time and within the batch specifications. You can only change data selection and 
sequencing in non-Web Only versions at run time.  Run-time changes are not persistent. 

See Also 
� Submitting a Report in the EnterpriseOne Report Writing Guide for information on 

submitting a report 

Prerequisite 
� If you access data selection and sequencing from the Row menu of the Work With Batch 

Versions form, you must check out the version to your machine. See Checking Out or 
Checking In a Batch Version in the EnterpriseOne Report Writing Guide.  

► To access data selection and sequencing for batch versions  

From the System Administration Tools menu (GH9011), choose Batch Versions (P98305).  

1. On Work With Batch Versions – Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

Alternatively, on Work With Batch Versions - Available Versions, from the Form menu, 
choose Display and then click one of the following:  

• Available Versions 

All versions available on your workstation are shown. 

• My Versions 

Only the versions you created are shown. 

• All Versions 

All versions that exist for the batch application are shown. When you view All Versions, 
you can work only with versions that appear in black text. 

3. In the detail area, choose a version with which you want to work. The version must be 
checked out.  

4. From the Row menu, choose one of the following:  

• Data Selection  

The Data Selection form appears.  

• Data Sequencing  

The Selection Data Sequencing form appears.  
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When you are working with table conversion batch applications, EnterpriseOne grays out 
the Data Selection and Data Sequencing menu items because they do not apply to table 
conversions.  

5. To make these changes available to the enterprise, check in the version. 

The changes that you make affect only the version on your local workstation. If you do not 
check in the version, ensure that you erase your check out so that others can check out this 
version.  

See Also 
See the following topics in the EnterpriseOne Report Writing Guide: 

� Checking Out or Checking In a Batch Version for information on checking batch versions in 
and out 

� Erasing the Check-Out Record of a Version for information on erasing a versions check-out 
record 

Creating Reports of Processing Options  
This task explains how to create reports about processing options for interactive and batch application 
versions. This report shows the tab, text, and value of any processing option attached to an 
application's version (not all versions have processing options).  

Caution 

Run this process only locally (on your workstation).  

 

► To create reports of processing options  

From the System Administration Tools (GH9011), choose Batch Versions or choose Interactive 
Versions.  

1. On Work With Batch Versions – Available Versions, type an application ID in the Batch 
Application field or the Interactive Application field. For example, to locate a version for the 
General Journal by Batch report, type R09301 into the Batch Application field.  

2. Click Find to locate the versions available on your workstation.  

3. Do one of the following:  

• Choose a version and then choose Processing Options from the Row menu to view the 
version's default values.  

• Choose a version and then choose Print Options from the Row menu.  

• Without choosing a version, choose Print Options from the Form menu.  

4. On Report Output Destination, choose one of the following options:  

• On Screen 

• To Printer 

• Export to CSV 

134 



5. Choose the following option, if needed, and complete the associated field: 

• OSA Interface Name 

6. Click OK. 

The system processes the report.  

Accessing Properties for Table Conversion Versions  
This task is only for table conversion batch applications. You can access the version's properties from 
the Table Conversion Prompting form. You can also access properties directly from the Work With 
Batch Versions - Available Versions form.  

See Also 
� Submitting a Table Conversion in the Table Conversion Guide for an explanation of the 

Table Conversion Prompting form 

► To access properties for table conversion versions  

From the System Administration Tools menu (GH9011), choose Batch Versions.  

1. On Work With Batch Versions – Available Versions, type a table conversion application ID 
in the Batch Application field.  

2. Click Find to locate the versions available on your workstation.  

For alternate lists of versions, from the Form menu, choose Display, then choose one of the 
following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for just the versions you created  

• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

3. In the detail area, choose a version with which you want to work. The version must be 
checked out.  

4. From the Row menu, click Properties. This menu selection is enabled only for table 
conversions.  

The system displays the Properties form.  

5. The changes you make will affect only the version on your local workstation. To make these 
changes available to the enterprise, you must now check in the version. If you do not check in 
the version, make sure you erase your check out so that others can check out this version.  

See Also 
� Submitting a Table Conversion in the Table Conversion Guide for information about 

changing table conversion properties 
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See the following topics in the EnterpriseOne Report Writing Guide: 

� Checking Out or Checking In a Batch Version for information about checking in the version 

� Erasing the Check-Out Record of a Version for information about erasing a check-out record 

Working with Version Detail for Batch Versions  
Use version detail to review information about a version, such as its title, the prompting options 
associated with it, or the security level. You can also specify whether to print a cover page on a 
report.  

Prerequisite 
� Check out the version before you work with version detail. See Checking Out or Checking In 

a Batch Version in the EnterpriseOne Report Writing Guide. 

► To work with version detail for batch versions  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions – Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

For alternate lists of versions, choose Display from the Form menu, and then choose one of 
the following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for just the versions you created  

• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

3. Choose a version in the detail area with which you want to work. The version must be 
checked out.  

4. From the Row menu, choose Version Detail.  

The system displays the Version Detail form on which you can change information such as 
the title of the version, how the version uses processing options, and the security level for the 
version. You can also review background information about the report.  

5. On Version Detail, modify or complete the following information:  

• Version Title 

• Prompting 

This option appears only if processing options are attached to the associated report 
template.  
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• Security 

• Version Detail 

• Print Cover Page 

• Job Queue 

If you leave the Job Queue field blank, EnterpriseOne reads the setting in the jde.ini on 
the enterprise server. If you submit the job to an iSeries, EnterpriseOne looks to your user 
profile to determine the job queue.  

• Client Platform 

6. Review the additional information that appears on the form as needed.  

7. Click OK.  

8. Check in this version to make it available to the enterprise.  

See Also 
� Checking Out or Checking In a Batch Version in the EnterpriseOne Report Writing Guide 

Copying a Batch Version  
You can copy an existing version, if it is not a Web Only version, and then tailor its information to fit 
your needs. The copied version inherits all the report template properties of the original version, 
including any overrides. If you are using a web client and copy a version, the new version you create 
is flagged Web Only. You cannot copy a Web Only version. 

When you copy a batch version, you should add security to the new version. Security settings range 
from none, which means anyone has the authority to modify or run a version, to full security, in 
which only the person who last modified the version can modify and run the version. Version security 
is separate from Security Workbench, which allows you to set security for different EnterpriseOne 
objects, such as applications.  

See Also 
� Security in the System Administration Guide for information about Security Workbench 

► To copy a batch version  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

For alternate lists of versions, choose Display from the Form menu, and then choose one of 
the following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for just the versions you created  
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• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

3. In the detail area, choose a version with which to work.  

4. Click Copy on the toolbar.  

5. On Version Copy, complete the following fields:  

• New Version 

• Security 

• Version Title 

6. Click OK.  

The Batch Version Design form appears. On this form, you can select Revise Version to edit 
version information or you can select Run to run the new version. 

7. On Batch Version Design, click OK to save your version.  

When you click OK to copy a report version, if the version specifications do not currently 
reside on your workstation, the central objects data source (server) performs JITI (Just-in-
time Installation) to transfer the specifications to your workstation.  

8. Check in the new version to make this version available to the enterprise.  

See Also 
� Checking Out or Checking In a Batch Version in the EnterpriseOne Report Writing Guide 

Creating a Batch Version  
You can create a new batch version that is based solely on the specification of the report template. 
Unlike copying a version, when you create a new batch version, the new version does not inherit any 
overrides.  

If you are using a web client to create a new batch version, the new version is flagged Web Only.  

When you create a batch version, you should add security to the new version. Security settings range 
from none, which means anyone has the authority to modify or run the version, to full security, in 
which only the person who last modified the version can modify and run the version. Refer to the 
Security field description for more information. Version security is separate from Security 
Workbench, which allows you to set security for different EnterpriseOne objects, such as 
applications.  

See Also 
� Security in the System Administration Guide for information about Security Workbench 

� Batch Versions Created Using the Web Client in the EnterpriseOne Report Writing Guide for 
information about Web-only versions 
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► To create a batch version  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type the batch application upon which 
you want to base the new batch version in the following field: 

• Batch Application 

2. Click Add to create a new version.  

3. On Version Add, complete the following fields:  

• Version 

• Version Title 

• Prompting Options 

If the batch application on which you base your version does not have any processing 
options attached, EnterpriseOne leaves the Prompting Options field inactive. You can 
attach processing options only to a batch application template in Report Design.  

• Security 

• Job Queue 

• Version Detail 

4. Choose the following option, if necessary:  

• Print Cover Page 

5. Click OK to save your version. 

6. Check in the new version to make this version available to the enterprise. 

See Also 
� Checking Out or Checking In a Batch Version in the EnterpriseOne Report Writing Guide 

Checking Out or Checking In a Batch Version  
To modify a report version using Report Design or to set data selection and sequencing using the 
options from the Row menu, you must first check out the report version. The check-out procedure 
copies the specification records from the central objects location to your workstation. This is based on 
your path code. Only versions in that central objects path code will be visible. You cannot access 
Report Design until you check out the version. A version cannot be checked out by more than one 
user at a time.  

If you have checked out a version but are not going to make changes to it, erase the check-out record 
so others can check out that version. You need to check out a version to make changes that are 
overrides to the base (template) report. You do not need to check out a version if you make the 
following changes at the time you run the version: data selection, data sequencing, override location, 
or processing option values. However, if you make changes to data selection or data sequencing from 
the Work With Batch Versions - Available Versions form, you must check out and check in the 
version to save those changes and make them available to the enterprise.  
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Before you check in a version, make sure that you want to make permanent changes. When you check 
in a version, the system copies the report specifications back to the central objects location. These 
new specifications override the previous specifications for that version. The report specifications on 
your workstation remain intact.  

To convert a Web Only version to run on a client other than a web client, you must check the version 
in and then check it out again. To permanently remove the Web Only indicator, generate the batch 
version using the eGenerator tool after converting the version. 

You can check batch versions in or out with the Object Management Workbench program (P98220) 
or with the Batch Versions program (P98305) as described in the next task.  

See Also 
� Generating EnterpriseOne Serialized Objects in the Web Server Installation Guide for 

information on eGenerator 

► To check out or check in a batch version  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field, and then click Find. For example, to locate a version for the One Line Per 
Address report, type R014021.  

2. In the detail area, choose a version with which to work.  

3. From the Row menu, choose Advanced.  

The Advanced Operations form appears. On this form, you can check in and check out 
versions, and erase the check out for a version, and enter design for the version.  

4. On Advanced Operations, choose a version to check out or to check in.  

5. From the Row menu, choose either Check Out Version or Check In Version.  

6. Click OK.  

Erasing the Check-Out Record of a Version  
Batch versions can be checked out by only one person at a time. Erasing the check out record allows 
another user to check out the version. After you have erased a check-out, you cannot check in that 
version. However, the report specifications on your workstation remain intact.  

The Erase Check-Out procedure changes the status of the server-based record of version check-in and 
check-out. When you erase a check-out of a version, EnterpriseOne updates the Checked Out field in 
the Versions List table (F983051) from a Y to an N. EnterpriseOne also updates the version's 
Location field in the Versions List table. This value is changed from the location of the workstation 
that checked out the version to the machine name of the central object's server.  

You can erase the check-out of batch versions using the Object Management Workbench program 
(P98220) or the Batch Versions program (P98305) as described in the next task.  
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► To erase the check-out record of a version  

From the Report Writer menu (GH9111), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field and click Find. For example, to locate a version for the One Line Per 
Address report, type R014021.  

2. In the detail area, choose a version with which to work.  

3. From the Row menu, choose Advanced.  

The Advanced Operations form appears. On this form, you can check in and check out 
versions and reports, erase the check out for a version, and enter the design for the version.  

4. On Advanced Operations, choose the checked-out record that you want to erase.  

5. From the Row menu, choose Erase Check Out.  

Changing Processing Options for the Batch Versions 
(P98305) Application 

This task explains how to change the processing options for the Batch Versions program (P98305).  

Processing option changes are stored for each UBE run. Unlike other changes to versions, changes to 
processing option values do not require you to check in or check out the version. Anyone who uses 
that version after you make the change will not be affected by the new processing option values.  

See Also  
� Changing Processing Options for Batch Versions in the EnterpriseOne Report Writing Guide 

for general instructions about changing processing options for batch versions 

► To change Batch Versions (P98305) processing options  

From the System Administration Tools menu (GH9011), right-click Batch Versions, choose 
Prompt For, and then choose Values.  

1. On Processing Options, complete the following fields:  

• Confirmation Box  

Enter a Y or 1 to enable, or enter N or 0 to disable the overwrite/delete local 
specifications confirmation box. If you enable the confirmation box, it appears when 
EnterpriseOne is about to overwrite or delete specifications on your local machine. For 
example, when enabled, the confirmation box appears when you check out a batch 
version.  

• Schedule Job  

Enter a 0 (or leave the field blank) to not allow users to schedule when their batch 
versions run, meaning their batch version runs as soon as they submit it; enter a 1 to give 
the users the option of scheduling their batch versions; enter a 2 to force the users to 
always schedule their batch versions.  

2. Click OK. 
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See Also 
� Scheduling Jobs in the System Administration Guide for complete information about how to 

schedule batch versions 

Moving Batch Version Specifications to an Enterprise Server  
You can move batch version specifications to an enterprise server without actually running the batch 
version. You need to do this only when you have modified a batch version that is called by another 
batch version. After you modify the version, use this option to move its specifications to the same 
location as the batch version that calls it. This procedure ensures that the batch version calls the 
updated specifications, rather than obsolete specifications.  

► To move batch version specifications to an enterprise server  

From the System Administration Tools menu (GH9011), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, complete the following field, if 
necessary:  

• Batch Application 

2. Click Find to display a list of versions based on the batch application you entered in the Batch 
Application field.  

3. Choose the report version you want to submit, and then click Select.  

4. On Version Prompting, choose Advanced from the Form menu.  

5. On Advanced Version Prompting, choose the following options and click OK:  

• Submit Version Specifications Only 

Turn this option on to move batch version specifications to an enterprise server that you 
specify.  

• Override Location 

Turn this option on to access the JDE Data Sources form, which you use to specify the 
location of the enterprise server to which you want to move the batch version 
specifications.  

6. On Version Prompting, click Submit. 

7. On JDE Data Sources, choose the enterprise server to which you want to move the batch 
version specifications, and then click Select.  

The batch version that you indicated will not run, but EnterpriseOne moves the batch version 
specifications to the enterprise server that you specified. You can use the Work With Servers form to 
monitor the progress of your job on the queue.  

See Also 
� Working with Servers in the System Administration Guide for information about the Work 

With Servers form 
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Overriding Version Specifications 
Usually when you run a report version, the version specifications override the report template 
specifications. Occasionally you may want the report template specifications to override the versions 
specifications.  

An example of when you would want to override the version specifications with the report template is 
when you have changed the report template and want that change pushed down to the version level.  
If you did not override the version specifications, the system would ignore the change at the version 
level. 

Caution 

If a version contains information that is not displayed in the report template, this information will not 
be displayed if you override the version specifications. 

 

► To override version specifications 

From the Report Writer menu (GH9111), choose Batch Versions. 

1. On Work with Batch Versions, enter the number of the report in the following field: 

• Batch Application 

2. Highlight the report version you wish to view. 

3. From the Row exit, select Advanced. 

4. On Advanced Operations, choose Design Version from the Row menu. 

5. On Report Design under the Version tab, select the section of the report for which you wish 
to override version specifications. 

6. From the Section menu, choose Override Version Specifications. 

Depending on the type of section you selected, the appropriate Section form appears. 

7. Select from the following options and click OK: 

• Section Layout 

• Section Data Selection 

• Section Event Rules 

• Section Database Output 

• Section Sort Sequence 

Template specifications now override version specifications. 
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Accessing BrowsER for a Report or Version  
BrowsER is an application you can use to view event rules and design layout for your reports and 
versions. BrowsER displays the structure of sections within a batch application. The sections are 
displayed in a hierarchical structure, with events and event rules for each section. You can enable or 
disable one or more event rules without extensive work in the design tools. This is useful for 
debugging specific event rules.  

See Also 
� BrowsER in the Development Tools Guide for complete information about using BrowsER 

► To access BrowsER for a report or version  

From the System Administration Tools menu (GH9011), choose Batch Versions.  

1. On Work With Batch Versions - Available Versions, type an application ID in the Batch 
Application field. For example, to locate a version for the One Line Per Address report, type 
R014021.  

2. Click Find to locate the versions available on your workstation.  

For alternate lists of versions, choose Display from the Form menu, and then choose one of 
the following:  

• Available Versions - for the versions available on your workstation  

• My Versions - for just the versions you created  

• All Versions - for any version that exists for the batch application  

When you view all versions, you can work only with versions that appear with black text.  

3. In the detail area, choose a version with which you want to work.  

4. From the Row menu, choose Advanced.  

The Advanced Operations form appears. On this form, you can design report specifications 
for the version, check in and check out versions and reports, and erase the check out for a 
version.  

5. On Advanced Operations, choose either Report BrowsER or Version BrowsER from the 
Form menu.  

If you select Report BrowsER, you can enable or disable event rules for the report. If you 
select Version BrowsER, you can enable or disable event rules for a specific version of the 
report. When you are working with table conversion batch applications, EnterpriseOne grays 
out the Version BrowsER button because it does not apply to table conversions.  
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Processing Options  

A processing option is a parameter in which you enter a value to control how an interactive or batch 
program runs.  

You use processing options to instruct the system to perform functions to meet your specific business 
needs. If a program contains processing options, you set the required and optional processing options 
for the program during setup or before you run or submit a program.  

You can create different versions of each program if your business needs require specific processing 
for different processes. You can then set these unique processing options differently in multiple 
versions of the same application. Changes to processing options immediately affect that version for 
every user. Anyone who uses that version after you make the change uses the new processing option 
values. You can also use processing options to access a version of another program.  

Caution 

XJDE versions are considered owned by PeopleSoft. During an upgrade, the system might overwrite 
these versions. You should use these versions only as templates for your own versions.  

ZJDE versions are used for default purposes, and are typically interactive applications or versions 
called from another application. You usually attach these versions to a menu. You can set these 
processing options. When called from a menu, interactive applications with a version are called with a 
blind execution based on predetermined processing option values.  

 

Processing Option Functions  
Use processing options to do the following:  

• Set up default values  

• Customize an application for different companies or even different users  

• Control the format of forms and reports 

• Control page breaks and the location where totaling occurs for reports  

Processing options appear in the system as a tabbed form. Tabs organize the processing options by 
purpose and function. Each processing option tab contains the following:  

• A standard or unique tab name  

• Processing option titles  

• Lists of valid values  

• Online help (enhanced processing options)  

You access the online help using the F1 key or by right-clicking and choosing What's This? 
from the menu. The glossary text describes the function of the processing option and the 
actions or consequences of using the valid values.  
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Types of Processing Options  
Processing options can be of two types: enhanced and nonenhanced.  

Enhanced processing options provide detailed user information. For example, the user can look at the 
field name and valid values on the tab and quickly determine how to use the processing option; or the 
user can access online help by pressing F1 on the processing option for a detailed explanation. These 
processing options have been enhanced to EnterpriseOne standards. Enhanced processing option 
forms have a number, a brief title, and, if applicable, a concise list of valid values. These processing 
options have online help attached to them. 

Nonenhanced processing options provide only a brief description in paragraph form. Sometimes these 
fields have no title; instead, they are numbered, and each number is followed by a brief explanation, 
in paragraph form, of relevant information (usually valid values). The processing option numbers 
sometimes span all tabs. The fields typically have data items attached but do not follow the same 
naming conventions as enhanced processing options  

Example: Processing Options 
The following is an example of Enhanced Processing Options:  
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The following is an example of Nonenhanced Processing Options:  

 

Working with Processing Options  
You can work with processing options in the following two ways: 

• From a menu  

• From a version list  

How Processing Options Work From a Menu 

You can access processing options for an object either from the menu bar or by right-clicking the 
object. In either case, one of the options is Prompt For. The Prompt For submenu contains the 
following options, when available:  

Values  Choose this option to specify processing option values.  

Version  Choose this option to choose which version of the object to run. Depending on how 
the version was designed, you might be prompted to enter processing option values 
after you select the version, or you might be able to modify them from the Row 
menu.  

Data 
Selection  

Choose this option to specify which data to use.  

Data 
Selection and 
Values  

Choose this option to specify which data to use and then to specify processing option 
values.  
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If you choose to run processing options from a menu, the processing details defined at the 
menu level take precedence. Not all objects allow you to select from all four of these options.  

See Also  
� Working With Version Detail for Interactive Versions in the Foundation Guide 

Interactive Version Processing Options  
The processing options that you define in interactive versions are a set of parameters that alter how an 
application runs. They are similar to initialization (.ini) files and command-line arguments for a 
traditional executable. These processing options let you specify the options that you want when you 
open an application. For example, you can specify how a form appears, show or hide a field, change 
the default status for order activity rules, and set default information to appear in a field.  

Not all EnterpriseOne software applications have processing options. If the Prompt For Values option 
on the Edit menu is grayed out, either no processing options are associated with the application or the 
system administrator has secured a version for the application. When you open a secured version 
from the Interactive Versions application, a security message appears to inform you that you do not 
have access to the version.  

You must set processing options for an interactive application before you use versions with the 
application.  

Using processing options, you set up interactive programs to suit your business requirements. For 
interactive versions, processing options do the following:  

• Change functions. For example, you can set a processing option to turn on or off order holds. 
You can also specify whether you want to automatically print pick slips after you enter an 
order that is based on a processing option value.  

• Change default values. For example, you can set the processing options to set defaults for 
document types (such as quote orders or purchase orders) or line types (such as stock or 
nonstock items).  

• Control the display of forms. For example, you can set the processing options to hide or show 
a cost field, a price field, or a commission field.  

► To manually launch processing options for interactive versions  

1. From a Solution Explorer task view, click the application for which you want to set 
processing options.  

2. Right-click the application and choose Prompt For Values from the menu.  

3. On Processing Options, enter appropriate values where applicable and click OK.  
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Batch Version Processing Options  
You can change the processing options for an existing batch version to suit your business 
requirements. For example, you can change processing option values that specify a range of dates for 
a report. However, not all batch versions have processing options associated with them. For example, 
a list of addresses might not require special prompting.  

For batch versions, processing options do the following:  

• Change functionality. For example, you can set a processing option to move records to a 
history file after a report runs.  

• Change input parameters. For example, you can set a processing option to specify which 
category code to use when processing a report.  

• Define data. For example, you can set a processing option to define the fiscal year for which 
you want to run a report. You can also define the employee information included in a report.  

► To manually launch processing options for batch versions  

1. From a Solution Explorer task view, choose a report or other batch application for which you 
want to set processing options.  

2. On Work With Batch Versions - Available Versions, find and click a version of the report or 
other batch application.  

3. On Work With Batch Versions - Available Versions, choose Processing Options from the 
Row menu.  

4. On Processing Options, enter appropriate values where applicable and click OK.  

Using Processing Options for Master Business Functions  
The purpose of a master business function (MBF) is to provide a central location for standard 
business rules about entering documents such as vouchers, invoices, and journal entries.  

The MBF is composed of processing options that are shared by some programs. For example, the 
following journal entry programs use the processing options for the journal entry MBF:  

• Journal Entries (P0911)  

• Journal Entries with VAT (P09106)  

• Journal Entry Batch Processor (R09110Z)  

• Store and Forward JE Batch Processor (R09110ZS)  

• Recurring Journal Entry Compute & Print (R09302)  

• Indexed Comp Compute and Print Report(R093021)  

• Variable Numerator Compute and Print (R093022)  
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► To review versions and processing options for a master business function 

From the System Administration Tools menu (GH9011), choose Interactive Versions.  

1. On Work With Interactive Versions, type the application number in the Interactive 
Application field and click Find. For example, type P0900049.  

2. Choose a version.  

3. To review the processing option settings for the version, choose Processing Options from the 
Row menu. 

See Also  
� Processing Options in the Development Tools Guide  

� Related application documentation for specific master business function information 
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User Defined Codes  

Most EnterpriseOne forms contain fields. Some fields allow you to enter any value, and some require 
you to choose from a list of valid values. A user defined code (UDC) is one value in a set of values 
that is assigned as valid for a field. You can use UDCs to categorize your data and make sure that 
users provide consistent input on forms. Because users can choose only values from the list, UDCs 
simplify, standardize, and validate the data that is contained in fields.  

From any EnterpriseOne application, you can identify fields that have UDCs attached to them by 
using the visual assist button that appears when you tab into or click in a field. If you do not know the 
value to enter in a field with a user defined code attached to it, click the visual assist button, which 
accesses the Select User Define Code form. This form displays all valid values contained in the user 
defined code tables for this field. You can then choose the valid value to use.  

EnterpriseOne provides predefined UDCs, but many of the UDCs that you will use are unique to your 
enterprise, and your needs are likely to change. Therefore, the system lets you change, add, and delete 
UDCs to meet the needs of your enterprise. When you upgrade EnterpriseOne software, your 
customized UDCs will remain.  

See Also 
The following topics in the Foundation Guide:  

� UDCs, UDC Types, and Category Codes  

� Example: User Defined Codes in Address Book  

� Customizing UDCs and UDC Types  

� Consequences of Customizing UDCs  

� UDC Tables  

UDCs, UDC Types, and Category Codes  
A UDC is one value in a set of values that you have assigned as valid for a field. A UDC is made up 
of two parts. The first part is the code, which consists of the characters that you enter in a field. The 
second part is the description, which is text that describes what the code means. For example, on the 
Work With Addresses form, you can enter A in the Search Type field to designate an Applicant; this 
code becomes part of the data stored with the record.  

A UDC type is the complete set of UDCs that are allowed as values for a field. A UDC type is made 
up of a code type, which is its two-character name, and a description. Examples of UDC types are ST 
- Search Type and UM - Unit of Measure. UDC types are sometimes referred to as UDC lists.  

Each UDC type is associated with a EnterpriseOne product code. You can identify any set of UDCs 
by its product code and its code type. For example, the Address Book (product code 01) list of search 
types (code type ST) is referred to as UDC 01/ST.  
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The following figure illustrates the structure of user defined code tables:  

 

 

Throughout the system, you will see references to category codes. Category codes are UDC types that 
EnterpriseOne provides for you to customize according to your needs. You can change the code type 
and the description, and you can redefine the UDCs as appropriate for your purposes. For example, 
you might see a UDC type called Category Code 01. You can change its description and define the 
UDCs within it to suit your business needs.  

Example: User Defined Codes in Address Book  
EnterpriseOne systems use UDCs. For example, Address Book uses a field called Search Type to 
classify the entries in the address book. When you click the visual assist button in the Search Type 
field on the Work With Addresses form, a list of the search types appears. These search types are 
UDCs. Some of the search types include the following:  

• A - Applicants  

• C - Customers  

• V - Suppliers  

• E - Employees  

You can use these UDCs to classify your address book entries, and you can add or change UDCs to 
accommodate your needs. For example, if you need to categorize some of your address book entries 
as students, you can add a UDC to the list, such as S - Students.  

UDCs are also used to supply values for the following:  

• State and province codes  

• Units of measure  

• Document types  

• Languages  

When you click the visual assist for a field and the system displays the Select User Defined Code 
form, you know that you are working with UDCs.  
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Customizing UDCs and UDC Types  
EnterpriseOne provides many UDC types that contain predefined UDCs. Some of the UDCs are hard-
coded, which means that certain applications depend on specific values, so you should not change 
these UDCs. However, if a UDC is not hard-coded, you can change it to suit your business needs.  

You can change, add, and delete UDCs in the following ways:  

• Change the code or the description of a UDC in an existing UDC type. For example, in UDC 
01/ST, a medical institution might change the UDC for C - Customers to P - Patients to more 
accurately describe the category.  

• Add UDCs to an existing UDC type. For example, in the Search Type list, you might add a 
UDC for S - Students.  

• Delete UDCs from a UDC type. For example, if you want to prevent users from choosing a 
UDC, you can delete it from the UDC type.  

You can also change, add, and delete UDC types in the following ways:  

• Change the code type or the description of an existing UDC type, which is useful if you want 
to customize one of the generic category code lists for your needs.  

• Create a new UDC type and add UDCs to it. For example, an educational institution might 
create a UDC type called MA - Major Field of Study to classify its students, and it might 
define the following UDCs:  

• LA - Liberal Arts  

• MA - Mathematics  

• CS - Computer Science  

• EN - Engineering  

• MD - Medicine  

• Delete a UDC type.  

Consequences of Customizing UDCs  
Because UDCs can significantly affect the integrity of your data, you should customize them only as 
part of a coordinated plan within your enterprise. When you add or change a UDC, you are affecting 
the set of values against which the system validates the data entry. However, you are not affecting the 
actual content of any existing data records. By changing UDCs within a working production 
environment, you might affect the integrity of your data.  

For example, you use Address Book to enter address book records, and you use search types to 
classify those records. Suppose that you choose a search type of C - Customers to classify some of the 
records that you enter. Later, you decide to change that UDC from C - Customers to P - Patients. Any 
address book records that you entered with the original UDC value of C will still contain that value. 
When Address Book displays these records, you will see an error in the Search Type field because C 
is no longer a valid value.  
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UDC Tables  
You use the User Defined Codes program (P0004A) to create and customize UDCs and UDC types. 
The program stores UDC information in the following tables:  

• User Defined Code Types (F0004)  

• User Defined Codes (F0005)  

Customizing User Defined Codes  
Many of the UDCs that you need to use are unique to your enterprise, and your needs are likely to 
change. Therefore, you can change, add, and delete UDCs. UDCs allow you to customize 
EnterpriseOne software to meet your needs without having to write complex programs or modify the 
system code. When you upgrade EnterpriseOne software, your customized UDCs remain.  

Changing a User Defined Code  
A UDC is made up of two parts. The first part is the code, which consists of the characters that you 
enter in a field. The second part is the description, which is text that describes what the code means. 
You can change both the code and the description. For example, the UDC list of search types contains 
the code C, which designates Customers. A medical facility might change this code and description to 
P for Patients.  

► To change a user defined code  

From a System Setup menu for your product, choose the appropriate program for changing 
UDCs, or enter UDC in the Fast Path field.  

1. On Work With User Defined Codes, complete the following fields and click Find:  

• Product Code 

• User Defined Codes 
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For example, to display the list of Address Book search types, which is UDC 01/ST, type 
01 in the Product Code field and ST in the User Defined Codes field.  

 

 

2. Choose the code that you want to modify and click Select.  

3. On User Defined Codes, change any of the following fields and click OK:  

• Codes 

• Description 01 

• Description 02 

• Special Handling 

• Hard Coded 

Adding a User Defined Code  
Add a UDC to a UDC type when none of the existing codes is appropriate for your needs. For 
example, if you need to identify the entries in the address book that are your business partners, you 
can add a search type B - Business Partners to UDC 01/ST.  

Prerequisite 
� Every UDC belongs to a UDC type. Verify that a UDC type exists where you will add the 

UDC. To create a new UDC type, see Adding a User Defined Code Type in the Foundation 
Guide.  
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► To add a user defined code  

From a System Setup menu for your product, choose the appropriate program for changing 
UDCs.  

1. On Work With User Defined Codes, complete the following fields and click Find:  

• Product Code 

• User Defined Codes 

Enter the UDC type for which you want to add the UDC.  

2. On Work With User Defined Codes, click Add.  

3. On User Defined Codes, scroll to the last empty row of the detail area.  

Caution 

Be sure to add each new code on the last detail row so that you do not inadvertently overwrite 
a blank code, which might appear in the first detail row. A blank code might have only a 
period in the Description field.  

 

4. Complete the following fields and click OK:  

• Codes 

To allow a blank as a valid value, leave this field blank.  

• Description 1 

To allow a blank as a valid value, type any character (such as a period) in the last space in 
this field.  

• Special Handling 

• Hard Coded 
 

Deleting a User Defined Code  
You can delete UDCs from a UDC type, but do so with caution. Only delete UDCs as part of a 
coordinated plan within your enterprise. For example, you might delete the F - Facilities UDC from 
the list of search types if you do not want users to choose that UDC.  

If you delete a UDC, the system deletes only the code from the UDC type. UDC values in existing 
records are not deleted.  

Caution 

Do not delete hard-coded UDCs because EnterpriseOne applications might depend on them. Hard-
coded UDCs have the value Y in the Hard Coded field on the Work With User Defined Codes form.  
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► To delete a user defined code  

From a System Setup menu for your product, choose the appropriate program for changing 
UDCs; or enter UDC in the Fast Path field.  

1. On Work With User Defined Codes, complete the following fields and click Find:  

• Product Code 

• User Defined Codes 

2. On Work With User Defined Codes, choose the UDC from the detail area that you want to 
delete and click Delete.  

Caution 

Ensure that you want to delete this UDC. The only way to replace a deleted UDC is to add it 
again.  

 

3. Click OK to confirm that you want to delete the UDC.  

Customizing User Defined Code Types  
A UDC type is the complete set of UDCs that is allowed for a field. A UDC type is made up of a code 
type, which is its two-character name, and a description. Examples of UDC types are search types and 
units of measure. UDC types are sometimes referred to as UDC lists.  

Each UDC type is associated with a EnterpriseOne product code. You can identify any set of UDCs 
by its product code and its code type. For example, the Address Book (product code 01) list of search 
types (code type ST) is referred to as UDC 01/ST.  

Changing a User Defined Code Type  
You can change the code type and the description of an existing UDC type to meet your needs. 
Typically, you would change only the description so that it provides a meaningful description of the 
UDCs within the UDC type. For example, to classify your customers according to how much 
business they provide, you can change the description for Category Code 01 to Customer Volume. 
Then, you can customize the individual UDCs within that UDC type to describe the following 
classifications for your customers:  

• H - High-volume customer  

• M - Medium-volume customer  

• L - Low-volume customer  

You can change the code type, but you should do so with caution. If you change a code type, you 
could invalidate any existing records that use the original code type.  

You can also follow this procedure to see a complete list of UDC types for a product code.  
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► To change a user defined code type  

From a System Setup menu for your product, choose the appropriate program for changing 
UDCs; or enter UDC in the Fast Path field.  

1. On Work With User Defined Codes, choose Code Types from the Form menu.  

2. On Work With User Defined Code Types, complete the following field and click Find:  

• Product Code 

The system displays the UDC types that exist for that product code.  

3. Choose the UDC type that you want to change and click Select.  

4. On User Defined Code Types, change the values in any of the following fields and click OK:  

• Code Types 

Caution 

EnterpriseOne suggests that you do not change code types. If you change a code type, 
you might invalidate existing records that use the original code type.  

 

• Description 

• Code Length 

• 2nd Line (Y/N) 

• Numeric (Y/N) 

Adding a User Defined Code Type 
Add a UDC type when you need to categorize your data using UDCs and when none of the existing 
UDC types is appropriate. For example, an educational institution might add a UDC type called 
“Major” to categorize its students by any of the following fields of study:  

• LA - Liberal Arts  

• MA - Mathematics  

• CS - Computer Science  

• EN - Engineering  

• MD - Medicine  

Note  

When you add a UDC type, you also must modify the EnterpriseOne applications that use the UDC 
type. See Creating UDC Edit Controls in the Form Design Aid Guide for more information about 
associating a UDC type with a field.  
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Because modifying a EnterpriseOne application might require significant effort, whenever possible, 
you should change an existing UDC type (such as a category code) instead of adding a new UDC 
type. See Changing a User Defined Code Type in the Foundation Guide.  

 

► To add a user defined code type  

From a System Setup menu for your product, choose the appropriate program for changing 
UDCs; or enter UDC in the Fast Path field.  

1. On Work With User Defined Codes, choose Code Types from the Form menu.  

2. On Work With User Defined Code Types, complete the following field and click Find:  

• Product Code 

3. Click Add.  

4. On User Defined Code Types, scroll to the last empty row of the detail area.  

5. Complete the following fields and click OK:  

• Code Types 

• Description 

• Code Length 

• 2nd Line (Y/N) 

• Numeric (Y/N) 

Deleting a User Defined Code Type  
You can delete a UDC type, but you should do so with caution. EnterpriseOne applications and the 
integrity of the data within your database might depend on the existence of UDCs and UDC types. 
Only delete UDC types as part of a coordinated plan within your enterprise.  

Caution 

Do not delete UDC types that contain hard-coded UDCs because EnterpriseOne applications might 
depend on them. Hard-coded UDCs have the value Y in the Hard Coded field on the Work With User 
Defined Codes form.  

 

Prerequisite 
� Delete all individual UDCs from the UDC type. For information about deleting UDCs, see 

Deleting a User Defined Code in the Foundation Guide.  

► To delete a user defined code type  

From a System Setup menu for your product, choose the appropriate program for changing 
UDCs; or enter UDC in the Fast Path field.  

1. On Work With User Defined Codes, choose Code Types from the Form menu.  
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2. On Work With User Defined Code Types, complete the following field and click Find:  

• Product Code 

3. On Work With User Defined Code Types, choose the code type that you want to delete and 
click Delete.  

Caution 

Ensure that you want to delete this code type. The only way to replace a deleted UDC type is 
to add it again.  

 

4. Click OK to confirm that you want to delete the code type.  

Translating User Defined Codes into Alternate 
Languages  

Multinational enterprises can translate the descriptions for both UDCs and UDC types into alternate 
languages. The system displays the descriptions in the language designated by the user's language 
preference. For example, you can provide a translated description for the following UDC:  

• Code: E  

• English Description: Employees  

• Spanish Description: Empleados  

In this way, users can choose the same UDCs, regardless of their language preference.  

The User Defined Code Alternate Descriptions program (P0004D) stores the translated descriptions 
in the following tables:  

• User Defined Codes - Alternate Language Descriptions (F0004D)  

• User Defined Codes - Alternate Language Descriptions (F0005D)  

► To translate UDC type descriptions into alternate languages  

From a System Setup menu for your product, choose the appropriate program for changing UDCs; or 
enter UDC in the Fast Path field.  

1. On Work With User Defined Codes, choose Code Types from the Form menu.  

2. On Work With User Defined Code Types, complete the following field and click Find:  

• Product Code 

3. Choose the UDC type that you want to translate and then choose Language from the Row 
menu.  
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4. On UDC Alternate Languages, enter information in a blank row for the following fields and 
click OK:  

• L 

• Description 

Type the translated description into this field.  

► To translate UDC descriptions into alternate languages  

From a System Setup menu for your product, choose the appropriate program for changing 
UDCs; or enter UDC in the Fast Path field.  

1. On Work With User Defined Codes, complete the following fields and click Find:  

• Product Code 

• User Defined Codes 

2. Choose the code that you want to translate and then choose Language from the Row menu.  

3. On UDC Value Alternate Descriptions, enter information in a blank row for the following 
fields and click OK:  

• L 

• Description 

Type the translated description into this field.  
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Configurable Network Computing Foundation 

Configurable Network Computing (CNC) is the technical architecture for EnterpriseOne software. 
CNC allows highly configurable, distributed applications to run on a variety of platforms without 
users or analysts needing to know which platforms or which databases are involved in any given task. 
CNC insulates the business solution from the underlying technology. Enterprises can grow and adopt 
new technologies without rewriting applications. 

EnterpriseOne software comprises the following components:  

Design Tools EnterpriseOne software provides a unified set of tools to create all interactive 
applications, batch applications, and reports.  

Applications EnterpriseOne software provides the interactive and batch applications that 
perform your business needs. For example, Purchase Order Entry and 
General Ledger Post are applications.  

EnterpriseOne 
Software Foundation 
Code 

EnterpriseOne software provides underlying core processing that both 
interactive and batch applications depend on in order to run.  

EnterpriseOne 
Software 
Middleware 

EnterpriseOne software provides middleware that insulates your applications 
from the underlying database, operating system, hardware, messaging 
systems, and telecommunications protocols. Middleware insulates your 
business solution from the platform technology.  

See Also 
� Configurable Network Computing Implementation and other topics in the Configurable 

Network Computing Implementation Guide 

� Overview of Package Management and other topics in the Package Management Guide  

� Understanding Object Management Workbench Configuration and other topics in the System 
Administration Guide  

� Overview to Server and Workstation Administration and other topics in the Server and 
Workstation Administration Guide 

Advantages of Configurable Network Computing 
The EnterpriseOne Configurable Network Computing architecture provides the following advantages:  

• Network-centric software  

• Flexible, leveraged technology  

• Worldwide business support  

• Custom solutions without consequences  
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Network-centric Software  
Network-centric software allows you to create a uniform interface that supports a multiple-platform 
network. This compatibility across platforms provides:  

• Immediate availability of enhancements to all supported applications. Changes to the 
following items are reflected in applications across the network:  

• Business objects  

• Business rules  

• Modes of processing  

• Hardware and database  

• EnterpriseOne platform-neutral business specifications, or middleware, that comprise a 
common set of Application Program Interfaces (APIs) that integrate multiple-vendor, 
multiple-protocol differences. This integration insulates developers from the need to program 
to a specific platform. 

• Support for Internet technology, such as a browser interface.  

Flexible, Leveraged Technology  
You create your applications using tools that do not require a designer to master a programming 
language. EnterpriseOne tools conceal the code and allow the designer to concentrate on creating 
applications that are specific to current business needs and accommodate changes to business rules 
without reprogramming the application source code.  

EnterpriseOne is object-based and event-driven to provide you with more efficient business 
processes. Developers can reuse objects between applications for different purposes. This reusability 
provides consistency throughout all EnterpriseOne applications.  

EnterpriseOne does not rely on one command or keystroke to process information; rather, it processes 
information at strategic moments during the use of an application. For example, when a user moves 
among fields on a form, the system processes the information at the moment when the cursor leaves 
the field. EnterpriseOne immediately notes any errors and hides processing, such as an update of files 
that might also store information for the field, when the user moves to the next field on a form.  

In addition, EnterpriseOne provides a common interface between applications. When you move from 
form to form, you see the same general setup.  

Worldwide Business Support  
EnterpriseOne provides support for mixed currency and languages. Also, you can run EnterpriseOne 
on platforms from servers to laptops. This scalability allows a traveling consultant to interface with 
the system and enter records. The consultant can then send these updated records over the Internet to 
keep files as current as possible.  
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Note 

As of the ERP 8.0 release of EnterpriseOne software, EnterpriseOne no longer coexists with 
WorldSoftware. Contact PeopleSoft for more information about migrating from WorldSoftware A73 
to EnterpriseOne.  

 

Custom Solutions without Consequences  
You can make custom solutions to business applications with few or no consequences when you 
upgrade to a new release of EnterpriseOne. The EnterpriseOne toolset acts as an "idea enabler" by 
allowing you to transform a concept into a viable business solution. You maintain consistency across 
your enterprise, retain flexibility to adapt to changing business requirements, and minimize the time 
required to implement upgrades. The following list provides examples of areas in EnterpriseOne that 
you can customize without consequences during an upgrade: 

• Vocabulary overrides  

• User overrides  

• Versions  

• Processing options  

• Code generator options  

Configurable Network Computing Fundamentals  
The fundamentals of the Configurable Network Computing architecture consist of the following 
items: 

• Object storage 

• Central objects 

• Replicated objects 

• Environments 

• Path codes 

• Object Configuration Manager (OCM) 

• Data Sources 

Object Storage  
EnterpriseOne provides two general storage formats, central objects and replicated objects, to 
accommodate several functions in EnterpriseOne.  
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Central Objects  

You store objects in a central location to allow for the following:  

• Deployment  

• Redeployment  

• Development  

Central objects consist of object specifications for each EnterpriseOne object and C components for 
code-generated objects. Store your central object specifications in a relational database on either a 
deployment server or an enterprise server, depending on available resources. Store C components for 
code-generated objects in directories on the deployment server.  

To deploy objects out to the enterprise, you define a package that EnterpriseOne creates from central 
objects. Each package contains a copy of the central objects. This copy consists of object 
specifications, and linked and compiled C components. EnterpriseOne converts the copied object 
specifications to a format for storage in a directory. Workstations and enterprise logic servers receive 
packages and store them in local directories.  

Replicated Objects  

You create replicated objects from central objects. You store a set of replicated objects in a directory 
on each workstation, enterprise logic server, or both. At runtime, EnterpriseOne requires the 
specifications of the object that the workstation or enterprise logic server processes. For example, to 
execute the Address Book application on a workstation, the workstation needs the object 
specifications and the compiled dynamic link library for the Address Book application and for any 
object that the application uses, such as data dictionary items, tables, and business views. You must 
store a set of objects describing the physical table in a directory on your workstation or enterprise 
logic server to run an application because the physical table that contains the actual data exists in a 
database on another platform.  

On a EnterpriseOne workstation or enterprise logic server, you can store one set of replicated objects 
for each set of central objects. For example, your enterprise might use separate sets of central objects 
for a development environment and a production environment. A separate development environment 
provides easy distribution of custom modifications and maintains the integrity of objects in use by 
other environments within your enterprise.  
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The following illustration shows the relationship between central objects and replicated objects:  

 

 

Environments  
A EnterpriseOne environment is a collection of pointers indicating the location of data and 
EnterpriseOne software objects. An environment answers the following questions: 

• Where is my data?  

• What machine will process my logic?  

• What directory contains the object being processed?  
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EnterpriseOne provides an environment as a pointer to data and logic objects. For example, in the 
Purchase Order application the answers are as follows: 

Where is my data?  A user clicks the Find button to locate a Purchase Order. The environment 
determines in which database the table resides.  

What machine will 
process my logic?  

When finished entering an order, the user clicks OK. The environment 
determines where the logic (a master business function) necessary to record the 
transaction will process and where the transaction tables reside to enter the 
order.  

What directory 
contains the object 
being processed?  

After entering a user ID and password, a user must choose the environment to 
log on to. If you have multiple sets of objects, selecting the environment 
determines which objects that EnterpriseOne executes (the directory in which 
they reside). This location is called a path code, and EnterpriseOne defines it in 
the Library List Master File (F0094) table. 

Path Codes 
A path code can refer to the central development objects on the deployment server or to replicated 
objects on a workstation or logic server. A path code exists for each unique set of central objects. For 
example, you might have a set of objects reserved for software updates that you can deploy to users 
and a set of objects that you reserve for major enhancements.  

A set of objects or the path code can reside in the following locations:  

Central 
Server  

Contains the central set of development objects specifications. All development 
occurs in this location. The path code connects the specifications and the C 
components on the deployment server.  

Workstation  Contains a replicated set of objects that EnterpriseOne uses at run time.  

Logic Server  Contains a replicated set of objects that EnterpriseOne uses to process logic on these 
servers.  

The Library List Master File (F0094) table contains path codes that track a set of objects and their 
location within EnterpriseOne.  

Object Configuration Manager 
The Object Configuration Manager is a tool that configures distributed processing and distributed 
data at runtime without requiring programming. Using the Object Map table, the Object 
Configuration Manager points to the correct data, batch process, or business function for a given 
environment and user. The Object Configuration Manager is the control center for your runtime 
architecture. EnterpriseOne always uses the Object Configuration Manager to locate the data and 
platform needed to execute the distributed logic.  
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The following illustration shows how the Object Configuration Manager might connect data and logic 
for processing:  

 

 

Every environment has an associated set of Object Configuration Manager mappings that indicate the 
distributed data and distributed processing locations for that environment.  

The following equation represents the relationship among the Object Configuration Manager, a path 
code, and an environment:  

ENVIRONMENT = PATH CODE + OCM MAPPINGS  

The path code answers the following question:  

• What directory contains the object being processed?  

The OCM mappings answer the following questions:  

• What database stores my data?  

• Where should the logic object execute?  
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The following illustration shows how EnterpriseOne uses the relationship between OCM mappings 
and path codes to create an environment:  

 

 

Data Sources  
A data source is the specific location of data or distributed processing. EnterpriseOne data sources 
can be:  

• An entire database in a specific location, regardless of the type of database, such as a 
Microsoft Access database located in a specific directory or a library in DB2/400  

• A specific machine in the enterprise that processes logic  

The platform and data sources work together. You must define both the server that processes the logic 
and the databases that store the data. If multiple databases within one database management system 
(DBMS) reside on a machine, you must define each database to EnterpriseOne.  

Do not confuse Microsoft open database connectivity (ODBC) data sources with EnterpriseOne data 
sources. The ODBC data source defines databases to various third-party communication products 
such as Client Access, Rumba, SQL Server, and Access. EnterpriseOne data sources define both 
databases and logic servers to EnterpriseOne.  
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The following list describes EnterpriseOne data sources that you might use in your configuration:  

Oracle DBMS A EnterpriseOne data source for an Oracle DBMS points to an Oracle Connect 
String and a Table Owner.  

SQL Server 
DBMS  

A EnterpriseOne data source for a SQL Server DBMS points to a SQL Server 
Database (ODBC data source) and a Table Owner.  

DB2/400 DBMS  A EnterpriseOne data source for a DB2/400 DBMS points to a RDB directory 
entry and a Library (ODBC data source).  

MSDE DBMS A EnterpriseOne data source for a Microsoft Data Engine (MSDE) DBMS points 
to a MSDE database (OLEDB data source).  

Object Deployment 
Deploy EnterpriseOne to your workstations and servers using any of the following methods:  

• Initial installation, for workstations and servers  

• Workstation installation, for workstations  

• Application installation, for workstations  

• Just-in-time installation, for workstations  

Initial Installation  

The installation process is based on a centralized deployment server model. The deployment server 
installation program copies EnterpriseOne installation software from the CD-ROM to the deployment 
server. From the deployment server, you redistribute the software to the enterprise servers and 
workstations.  

Workstation Installation  

The workstation installation program retrieves software from the package that you request. A package 
contains instructions that describe where to find the necessary components that the workstation 
installation program deploys to the local computer.  
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Each package represents a record of your central objects at a point in time. Once you build and test a 
package, you can safely modify central objects because users will not receive those objects until you 
build another package and make it available to them. Building a package involves copying the central 
objects to the package itself. The package then contains replicated objects, which EnterpriseOne can 
read at runtime.  

Application Installation  

Application installation can be used to quickly deploy changes to an individual application. The 
workstation initiates the application installation, and the deployment server responds by gathering and 
delivering all objects that are necessary to run the application.  

Advantages of application installation are:  

• Users do not have to install a complete set of objects but only those objects that are necessary 
to capture the changed application.  

• You do not need to build a new package and perform a global build before deploying the 
application change.  

• Developers and testers can use application installation to load changes that were recently 
checked into the central objects onto their machine.  

Just-in-Time Installation  

Just-in-time installation installs applications to your workstation the first time you use them. For 
example, when you deploy a custom menu that contains a new application to a workstation, the object 
automatically installs on the workstation when a user clicks the menu option for the application.  
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Hot Keys  

Menu options and buttons throughout the system include key combinations, or hot keys, that perform 
the same functions as using the mouse. All of the standard push buttons in the system have hot keys 
associated with them.  

You can recognize hot keys by the underline on a control or menu. For example, the "i" on the Find 
button is underlined. Press Alt + i to use this control.  

The hot keys work in both the Windows client and Web client of EnterpriseOne software, except 
where noted. 

Note 

In the Web client, all hot key combinations that use the Alt key only work with the left Alt key. The 
right Alt key is used for typing special characters for foreign languages. 

 

Selecting Text 
Hot Keys Action 

Shift + J Highlight text one character to the right 

Shift + I Highlight text one character to the left 

Shift + Ctrl + J Highlight text to the end of a word 

Shift + Ctrl + I Highlight text to the beginning of a word 

Shift + End Highlight text to the end of a line 

Shift + Home Highlight text to the beginning of a line 

Shift + K Choose multiple lines, one line up 

Shift + L Choose multiple lines, one line down 

Shift (click) Highlight a range of text: Click at the beginning of the 
text, hold down the Shift key, then click at the end of the 
text. 
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Keyboard Shortcuts  
Hot Keys Action 

F1 Access field help 

Ctrl + Backspace Delete one word to the left of the insertion point 

Ctrl + Delete Delete one word to the right of the insertion point 

Ctrl + X Cut or delete selected text 

Ctrl + V Paste cut or copied text to the new area 

Ctrl + Y Repeat previous action 

Ctrl + C Copy selected text 

Ctrl + Z Undo last action 

Ctrl + S Save work 

Alt + M Open Form menu 

Alt + R Open Row menu 

Alt + P (Web client only) Open Report menu  

Alt + O (Windows client only) Open Report menu 

Alt + L Open Tools menu 

Ctrl + S (Web client only) Launch Search button (visual assist) from the current 
control 

Ctrl + F10 (Windows client only) Launch Search button (visual assist) from the current 
control 

Moving Around  
Hot Keys Action 

Tab Move to the next field or button. 

Ctrl + Tab (Windows client only) Move from the query by example line to the grid and 
from the grid to the next field or button. 

Shift + Tab Return to the previous field or button. 

Shift + Ctrl + Tab (Windows client only) Move backward into the grid or from the grid to the 
Query by Example line. 

I or J (Windows client only) Move the grid display one column to the left or to the 
right. 

K or L Move the grid display up or down one row. 

Page Up or Page Down (Windows client only) Move up or down one screen. 

Ctrl + I Move one word to the left. 
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Ctrl + J Move one word to the right. 

Ctrl + Q Set focus on the first enabled cell in the Query by 
Example row. 

Ctrl + G On editable grids, set focus or activate the first editable 
cell in the grid. 
On non-editable grids, set focus on the row selector for 
the first row in the grid. 

Buttons  
Hot Keys Action 

Alt + A Add 

Alt + C Close or Cancel 

Alt + F4 (Windows client only) Close or Cancel 

Alt + D Delete 

Alt + F Find 

Alt + O OK 

Alt + S Select 

Keyboard Shortcuts for the Calendar Tool  
Hot Keys Action 

Page Up Move to previous month. 

Ctrl + I (Windows client only) Move to previous month. 

Page Down Move to next month. 

Ctrl + J Move to next month. 

Home (Web client only) Move to previous year. 

End (Web client only) Move to the next year. 

K or L Move through weeks. 

Enter (Web client only) Close the Calendar and set the current value to the input 
field with visual assist (OK action). 

Escape (Web client only) Close the Calendar and return to the input field with 
visual assist (Cancel action). 
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Web Client Keyboard Shortcuts for the Calculator Tool  
Hot Keys Action 

Backspace Remove one digit from calculator display. 

F9 Change the sign of the number on calculator 
display. 

= or Enter Evaluate and display the result. 

Escape Clear the calculator display. 

Digit Key (0123456789.) Show the number in the display field. 

%, *, +, -, / Perform an operation corresponding to the key 
stroke and display the result. 

@ Perform square root operation. 

R or r 1/X Operation. 

O Close the calculator and set the current value to the 
input field with visual assist (OK action). 

C Close the calculator and return to the input field 
with visual assist (cancel action). 

Keyboard Shortcuts for Media Object Text  
Hot Keys Action 

Ctrl + B Bold the selected text 

Ctrl + I Italicize the selected text 

Ctrl + U Underline the selected text 

Ctrl + Shift + L Create a bullet 

Ctrl + Tab Exit the text edit form and display the next object in the 
tab sequence 
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Moving in the Grid  
Hot Keys Action 

Shift + K or Shift + L (Windows client only) Use to select multiple rows. Available only in grids 
where you cannot enter information. 

Ctrl + Page Up or Home (Windows client only) Move to the first cell in the row. 

Ctrl + Page Down or End (Windows client only) Move to the last cell in the row. 

Ctrl + Home (Windows client only) Activate the cell in the first row and column. 

Tab Move to the next cell. The order is right and then down. 
Available only in grids where you can enter information. 

Shift + Tab Move to the previous cell. The order is left and then up 
(up works in Windows client only). Available only in 
grids where you can enter information. 

Ctrl + Tab (Windows client only) Exit the grid and move to the next control in the form. 

Shift + Ctrl + Tab (Windows client only) Exit the grid to the previous control in the form or to the 
query by example (QBE) line, if one exists. 

F2 (Windows client only) Place the cursor at the end of text in the active cell. 
Available only in grids where you can enter information. 

Ctrl + X Cut the current selection (Windows client only) or data 
in a cell to the Clipboard. 

Ctrl + V Paste the Clipboard data into the current cell location. 

Ctrl + C Copy the current selection or data in a cell to the 
Clipboard. 

Esc (Windows client only) Turn edit mode off (the value of the previous cell 
replaces any changes that you made). Available only in 
grids where you can enter information. 

Shift + spacebar (Windows client only) Select the current row. Available only in grids where 
you can enter information. 

Enter in a grid cell (Web client only) Take the user to the first editable cell of the next row. 

Spacebar on the Grid Selection Checkbox (Web client 
only) 

Select the row that the checkbox represents. A user can 
tab through the controls to set focus on the Grid 
Selection Checkbox. 

Enter in the QBE cell (Web client only) Perform find operation on the form. 

Ctrl + S in grid cell or QBE cell (Web client only) Launch Search button from the current cell. 
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PeopleSoft Software Systems  

The following table lists the PeopleSoft systems:  

Number  System  

00  Foundation Environment  

01  Address Book  

02  Electronic Mail  

03  Accounts Receivable  

0301  Credit Management  

03B  Enhanced Accounts Receivable  

03C  Issue Management System  

04  Accounts Payable  

05  Time Accounting and HRM Base  

05A  OW HR & PR Foundation  

05C  OW HR & PR Foundation Canadian  

05T  Time Entry  

05U  OW HR & PR Foundation US  

06  Do not use  

07  Payroll  

07S  Payroll SUI  

07Y  U.S. Payroll Year End  

08  Human Resources  

08B  Benefits Administration  

08C  OW HR Canadian  

08H  Health and Safety  

08P  Position Control  
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08R  Recruitment Management  

08U  OW HR US  

08W  Wage and Salary  

09  General Accounting  

09E  Expense Reimbursement  

10  Financial Reporting  

10C  Multisite Consolidations  

11  Multicurrency  

11C  Cash Basis  

12  Fixed Assets  

13  Plant/Equipment Management  

14  Modeling, Planning & Budgeting  

15  Property Management  

16  Profit Management (EPS)  

17  Customer Service Management  

17C  Call Management  

18  Resource Scheduling  

19  Utility CIS  

30  Product Data Management  

3010  Process Data Management  

31  Shop Floor Control  

3110  Process Control  

32  Configuration Management  

32C  Custom Works  

33  Capacity Planning  

34  Requirements Planning  
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34A  Advanced Planning & Scheduling  

35  Enterprise Facility Planning  

36  Forecasting  

37  Quality Management  

38  Agreement Management  

39  Advanced Stock Valuation  

40  Inventory/OP Base  

4010  Advanced Price Adjustments  

41  Inventory Management  

41B  Bulk Stock Management  

42  Sales Management  

42A  Sales Force Automation  

42E  ECS Sales Management  

43  Procurement  

44  Subcontract Management  

4401  Homebuilder Management  

44H  Homebuilder Management  

45  Advanced Pricing  

46  Warehouse Management  

47  Electronic Commerce  

48  Work Order Processing  

48S  Service Billing  

49  Transportation Management  

50  Job Cost Base  

51  Job Costing  

52  Contract Billing  
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53  Change Management  

55 - 59  Reserved for Clients  

60 - 69  Reserved for JDE Custom  

70  Multinational Products  

71  Client Server Applications  

72  World Vision  

73  M & D Complementary Products  

74  EMEA Localization  

74H  Hungary  

74I  Ireland  

74L  Portugal  

74N  Nordics  

74P  Poland  

74R  CIS  

74S  Spain  

74T  Turkey  

74Z  Czech Republic  

75  ASEAN Localization  

75H  Thailand  

75I  India  

75K  Korea  

75T  Taiwan  

76  Latin American Localization  

76A  Argentina  

76B Brazil Localization 

76C  Colombia  
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76H  Chile  

76P  Peru  

76V  Venezuela  

77  Payroll (Canadian)  

77Y  Canada Payroll Year End  

79  Translation Tools  

80  Business Intelligence  

81  DREAM Writer  

82  World Writer  

83  Management Reporting - FASTR  

84  Distributive Data Processing  

85  Custom Programming  

86  Electronic Doc. Interchange  

87  JDE Internal  

88  Cautious Purge System  

89  Conversion Programs  

91  Documentation  

92  Computer Assisted Design  

93  Computer Assisted Programming  

94  Security Officer  

95  Sleeper-now in system 96  

96  Computer Operations  

97  Software Installation  

98  Technical Tools  

98E  Electronic Burst and Bind  

98FT  Form Type  
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98SA  Sample Application  

99  Technical Tools - Internal  

99D  Technical Tools - DASD Sizer  

99M  Technical Tools-Masters/Update  

B  LANGUAGE TRANSLATIONS  

B1A  Chinese - Simple  

B1B  Chinese - Complex  

B1E  English  

B1F  French  

B1G  German  

B1I  Italian  

B1J  Japanese  

B1P  Portuguese  

B1S  Spanish  

B2A  Dutch  

B2D  Danish  

B2F  Finnish  

B2N  Norwegian  

B2S  Swedish  

B3C  Czech  

B3H  Hebrew  

B3R  Russian  

BC1  Chinese - Simple  

BC2  Chinese - Complex  

BCR  Czech  

BDN  Danish  
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BDU  Dutch  

BFI  Finnish  

BFR  French  

BGR  German  

BHE  Hebrew  

BIT  Italian  

BJP  Japanese  

BNO  Norwegian  

BPO  Portuguese  

BRU  Russian  

BSP  Spanish  

BSW  Swedish  

D3N  dcLINK (data collection)  

H01  Address Book (inc. ALL Mail)  

H03  Accounts Receivable  

H03B  New Accounts Receivable  

H04  Accounts Payable  

H05  Standalone Time Accounting  

H07  Payroll  

H08  Human Resources  

H09  General Accounting  

H12  Fixed Assets  

H13  Equipment/Plant Management  

H15  Commercial Property Management  

H30  Product Data Management  

H301  Process Data Management  
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H31  Shop Floor Control  

H311  Process Control  

H32  Configuration Management  

H33  Capacity Requirements Planning  

H34  DRP/MRP/MPS  

H35  Enterprise Facility Planning  

H36  Advanced Forecasting  

H40  Inventory/OP Base  

H41  Inventory Management  

H415  Bulk Inventory Management  

H42  Sales Order Processing  

H43  Purchase Order Processing  

H44  Contract Management  

H44H  Homebuilder Management  

H45  Sales Analysis  

H46  Warehouse Management  

H50  Job Cost Base  

H72  Client/Server Base  

H73  CS - A/P Voucher Entry  

H74  CS - Pay Time Entry  

H75  CS - Sales Order Entry  

H76  CS - Training & Development  

H78  CS - Travel Expense Management  

H79  CS - Forecasting  

H90  ONEWORLD TOOLS  

H91  Design Tools  
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H92  Interactive Engine/OL  

H93  Data Base and Communications  

H94  Batch Engine  

H95  Tech Resources/Applications  

H96  Deployment  

H97  Benchmarking/Performance  

H98  Internet  

H99  Product Version Control  

H99P  Technical Tools-OWPVC Internal  

JE42  Sales Order/Pricing  

JE44  Distribution Contracts  

JE48  Automated Gantry Inter.  

KZ1  PC Budget Upload (A3 to A5)  

KZ2  PC Data Entry for AP  

KZ3  PC Data Entry for Payroll  

SY  SYSTEM  

Z101  MTI Electrical Distribution  

Z102  CRES  

Z91  System/ Product Codes  
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EnterpriseOne PeopleBooks Glossary 

“as of” processing A process that is run at a specific point in time to summarize item transactions. 

52 period accounting A method of accounting that uses each week as a separate accounting period. 

account site In the invoice process, the address to which invoices are mailed. Invoices can go 
to a different location or account site from the statement. 

active window The window that contains the document or display that will be affected by current 
cursor movements, commands, and data entry in environments that are capable of 
displaying multiple on-screen windows. 

ActiveX A technology and set of programming tools developed by Microsoft Corporation 
that enable software components written in different languages to interact with 
each another in a network environment or on a web page. The technology, based 
on object linking and embedding, enables Java applet-style functionality for Web 
browsers as well as other applications (Java is limited to Web browsers at this 
time). The ActiveX equivalent of a Java applet is an ActiveX control. These 
controls bring computational, communications, and data manipulation power to 
programs that can “contain” them—for example, certain Web browsers, Microsoft 
Office programs, and anything developed with Visual Basic or Visual C++. 

activity In Advanced Cost Accounting, an aggregation of actions performed within an 
organization that is used in activity-based costing. 

activity driver A measure of the frequency and intensity of the demands that are placed on 
activities by cost objects. An activity driver is used to assign costs to cost objects. 
It represents a line item on the bill of activities for a product or customer. An 
example is the number of part numbers, which is used to measure the 
consumption of material-related activities by each product, material type, or 
component. The number of customer orders measures the consumption of order-
entry activities by each customer. Sometimes an activity driver is used as an 
indicator of the output of an activity, such as the number of purchase orders that 
are prepared by the purchasing activity. See also cost object. 

activity rule The criteria by which an object progresses from a given point to the next in a 
flow. 

actual cost Actual costing uses predetermined cost components, but the costs are 
accumulated at the time that they occur throughout the production process. 

adapter A component that connects two devices or systems, physically or electronically, 
and enables them to work together. 

add mode The condition of a form where a user can enter data into it. 

advanced interactive 
executive 

An open IBM operating system that is based on UNIX. 

agent A program that searches through archives or other repositories of information on 
a topic that is specified by the user. 

aging A classification of accounts by the time elapsed since the billing date or due date. 
Aging is divided into schedules or accounting periods, such as 0-30 days, 31-60 
days, and so on. 
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aging schedule A schedule that is used to determine whether a payment is delinquent and the 
number of days which the payment is delinquent. 

allegato IVA clienti In Italy, the term for the A/R Annual VAT report. 

allegato IVA fornitori In Italy, the term for the A/P Annual VAT report. 

application layer The seventh layer of the Open Systems Interconnection Reference Model, which 
defines standards for interaction at the user or application program level. 

application 
programming 
interface (API) 

A set of routines that is used by an application program to direct the performance 
of procedures by the computer's operating system. 

AS/400 Common A data source that resides on an AS/400 and holds data that is common to the co-
existent library, allowing PeopleSoft EnterpriseOne to share information with 
PeopleSoft World. 

assembly inclusion 
rule 

A logic statement that specifies the conditions for using a part, adjusting the price 
or cost, performing a calculation, or using a routing operation for configured 
items. 

audit trail The detailed, verifiable history of a processed transaction. The history consists of 
the original documents, transaction entries, and posting of records and usually 
concludes with a report. 

automatic return A feature that allows a user to move to the next entry line in a detail area or to the 
first cell in the next row in several applications. 

availability The expression of the inventory amount that can be used for sales orders or 
manufacturing orders.  

available inventory The quantity of product that can be promised for sale or transfer at a particular 
time, considering current on-hand quantities, replenishments in process, and 
anticipated demand. 

back office The set of enterprise software applications that supports the internal business 
functions of a company. 

backhaul The return trip of a vehicle after delivering a load to a specified destination. The 
vehicle can be empty or the backhaul can produce less revenue than the original 
trip. For example, the state of Florida is considered a backhaul for many other 
states—that is, many trucking companies ship products into the state of Florida, 
but most of them cannot fill a load coming out of Florida or they charge less. 
Hence, trucks coming out of Florida are either empty or produce less revenue than 
the original trip. 

balance forward The cumulative total of inventory transactions that is used in the Running Balance 
program. The system does not store this total. You must run this program each 
time that you want to review the cumulative inventory transactions total. 

balance forward 
receipt application 
method 

A receipt application method in which the receipt is applied to the oldest or 
newest invoices in chronological order according to the net due date. 

bank tape (lock box) 
processing 

The receipt of payments directly from a customer’s bank via customer tapes for 
automatic receipt application. 

base location [In package management] The topmost location that is displayed when a user 
launches the Machine Identification application. 
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basket discount A reduction in price that applies to a group or “basket” of products within a sales 
order.  

basket repricing A rule that specifies how to calculate and display discounts for a group of 
products on a sales order. The system can calculate and display the discount as a 
separate sales order detail line, or it can discount the price of each item on a line-
by-line basis within the sales order.  

batch job A job submitted to a system and processed as a single unit with no user 
interaction. 

batch override An instruction that causes a batch process to produce output other than what it 
normally would produce for the current execution only. 

batch process A type of process that runs to completion without user intervention after it has 
been started. 

batch program A program that executes without interacting with the user. 

batch version A version of a report or application that includes a set of user-defined 
specifications, which control how a batch process runs. 

batch/lot tracking The act of identifying where a component from a specific lot is used in the 
production of goods. 

batch/mix A manufacturing process that primarily schedules short production runs of 
products. 

batch-of-one 
processing 

A transaction method that allows a client application to perform work on a client 
workstation, and then submit the work all at once to a server application for 
further processing. As a batch process is running on the server, the client 
application can continue performing other tasks. See also direct connect, store-
and-forward. 

binary large object 
(BLOB) 

A collection of binary data stored as a single entity in a [file]. 

binder clip See paper clip. 

black products Products that are derived from the low or heavy end of the distillation process—
for example, diesel oils and fuel oils. See also white products.  

blend note Document that authorizes a blending activity, and describes both the ingredients 
for the blend and the blending steps that occur. 

blend off Reworking off-specification material by introducing a small percentage back into 
another run of the same product. 

blind execution The mode of execution of a program that does not require the user to review or 
change the processing options set for the program, and does not require user 
intervention after the program has been launched. 

boleto In Brazil, the document requesting payment by a supplier or a bank on behalf of a 
supplier. 

bolla doganale VAT-Only Vouchers for Customs. In Italy, a document issued by the customs 
authority to charge VAT and duties on extra-EU purchasing. 

bookmark A shortcut to a location in a document or a specific place in an application or 
application suite. 
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bordero & cheque In Brazil, bank payment reports. 

broker A program that acts as an intermediary between clients and servers to coordinate 
and manage requests. 

BTL91 In the Netherlands, the ABN/AMRO electronic banking file format that enables 
batches with foreign automatic payment instructions to be delivered. 

budgeted volume A statement of planned volumes (capacity utilization) upon which budgets for the 
period have been set. 

bunkering A rate per ton or a sum of money that is charged for placing fuel on board; can 
also mean the operation itself.  

business function An encapsulated set of business rules and logic that can normally be re-used by 
multiple applications. Business functions can execute a transaction or a subset of 
a transaction (check inventory, issue work orders, and so on). Business functions 
also contain the APIs that allow them to be called from a form, a database trigger, 
or a non-EnterpriseOne application. Business functions can be combined with 
other business functions, forms, event rules, and other components to make up an 
application. Business functions can be created through event rules or third-
generation languages, such as C. Examples of business functions include Credit 
Check and Item Availability. 

business function 
event rule 

Encapsulated, reusable business logic that is created by using through event rules 
rather than C programming. Contrast with embedded event rule. See also event 
rule. 

business object 
library 

[In interoperability] The repository that stores EnterpriseOne business objects, 
which consist of Java or CORBA objects.  

business unit A financial entity that is used to track the costs, revenue, or both, of an 
organization. A business unit can also be defined as a branch/plant in which 
distribution and manufacturing activities occur. Additionally, in manufacturing 
setup, work centers and production lines must be defined as business units; but 
these business unit types do not have profit/loss capability. 

business view Used by EnterpriseOne applications to access data from database tables. A 
business view is a means for selecting specific columns from one or more tables 
with data that will be used in an application or report. It does not select specific 
rows and does not contain any physical data. It is strictly a view through which 
data can be handled. 

business view design 
aid (BDA) 

An EnterpriseOne GUI tool for creating, modifying, copying, and printing 
business views. The tool uses a graphical user interface. 

buy-back crude In foreign producing oil countries, that portion of the host government’s share of 
“participation crude” which it permits the company holding a concession to “buy 
back.”  

CAB In Italy, the bank branch code or branch ID. A five-digit number that identifies 
any agency of a specific bank company in Italy. 

cadastro de pessoas 
físicas 

Cadastro de pessoas físicas. In Brazil, the federal tax ID for a person. 

category code A code that identifies a collection of objects sharing at least one common 
attribute. 
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central object A software component that resides on a central server. 

central objects merge A process that blends a customer’s modifications with the objects in a current 
release with objects in a new release. 

central server A computer that has been designated to contain the originally installed version of 
the software (central objects) for deployment to client computers. 

certificate input See direct input. 

certificate of analysis 
(COA) 

A document that is a record of all of the testing which has been performed against 
an item, lot, or both, plus the test results for that item and lot. 

change management [In software development] A process that aids in controlling and tracking the 
evolution of software components. 

change order In PeopleSoft, an addendum to the original purchase order that reflects changes in 
quantities, dates, or specifications in subcontract-based purchasing. A change 
order is typically accompanied by a formal notification. 

chargeback A receipt application method that generates an invoice for a disputed amount or 
for the difference of an unpaid receipt. 

chart EnterpriseOne term for tables of information that appear on forms in the software. 
See forms. 

check-in location The directory structure location for the package and its set of replicated objects. 
This location is usually \\deploymentserver\release\path_code\ 
package\packagename. The subdirectories under this path are where the central C 
components (source, include, object, library, and DLL file) for business functions 
are stored. 

A computed value that depends on the contents of a block of data, and that is 
transmitted or stored with the data to detect whether errors have occurred in the 
transmission or storage. 

class [In object-oriented programming] A category of objects that share the same 
characteristics. 

clean cargo Term that refers to cargoes of gasoline and other refined products. See also dirty 
cargo. 

client access The ability to access data on a server from a client machine. 

client machine Any machine that is connected to a network and that exchanges data with a 
server. 

client workstation A network computer that runs user application software and is able to request data 
from a server. 

ClieOp03 In the Netherlands, the euro-compliant uniform electronic banking file format that 
enables batches with domestic automatic direct debit instructions and batches 
with domestic payment instructions to be delivered. 

ClieOp2 In the Netherlands, the uniform electronic banking file format that enables 
batches with domestic automatic direct debit instructions and batches with 
domestic payment instructions to be delivered. 

checksum value 
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cluster Two or more computers that are grouped together in such a way that they behave 
like a single computer. 

co-existence A condition where two or more applications or application suites access one or 
more of the same database tables within the same enterprise. 

cold test The temperature at which oil becomes solid. Generally considered to be 5 degrees 
F lower than the pour point. 

commitment The number of items that are reserved to fill demand. 

common object 
request broker 
architecture 

An object request broker standard that is endorsed by the Object Management 
Group. 

compa-ratio An employee’s salary divided by the midpoint amount for the employee’s pay 
grade. 

component changeout See component swap. 

component object 
model (COM) 

A specification developed by Microsoft for building software components that 
can be assembled into programs or add functionality to existing programs running 
on Microsoft Windows platforms. COM components can be written in a variety 
of languages, although most are written in C++, and can be unplugged from a 
program at runtime without having to recompile the program. 

component swap In Equipment/Plant Management, the substitution of an operable component for 
one that requires maintenance. Typically, you swap components to minimize 
equipment downtime while servicing one of the components. A component swap 
can also mean the substitution of one parent or component item for another in its 
associated bill of material. 

conference room pilot 
environment  

An EnterpriseOne environment that is used as a staging environment for 
production data, which includes constants and masters tables such as company 
constants, fiscal date patterns, and item master. Use this environment along with 
the test environment to verify that your configuration works before you release 
changes to end-users. 

configurable network 
computing (CNC) 

An application architecture that allows interactive and batch applications that are 
composed of a single code base to run across a TCP/IP network of multiple server 
platforms and SQL databases. The applications consist of re-usable business 
functions and associated data that can be configured across the network 
dynamically. The overall objective for businesses is to provide a future-proof 
environment that enables them to change organizational structures, business 
processes, and technologies independently of each other. 

configurable 
processing engine 

Handles all “batch” processes, including reporting, Electronic Data Exchange 
(EDIt) transactions, and data duplication and transformation (for data 
warehousing). This ability does not mean that it exists only on the server; it can 
be configured to run on desktop machines (Windows 95 and NT Workstation) as 
well. 

configuration 
management 

A rules-based method of ordering assemble-to-order or make-to-order products in 
which characteristics of the product are defined as part of the Sales Order Entry 
process. Characteristics are edited by using Boolean logic, and then translated 
into the components and routing steps that are required to produce the product. 
The resulting configuration is also priced and costed, based on the defined 
characteristics. 
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configured item 
segment 

A characteristic of a configured item that is defined during sales order entry. For 
example, a customer might specify a type of computer hard drive by stating the 
number of megabytes of the hard drive, rather than a part number. 

consuming location The point in the manufacturing routing where a component or subassembly is 
used in the production process. In kanban processing, the location where the 
kanban container materials are used in the manufacturing process and the kanban 
is checked out for replenishment. 

contra/clearing 
account 

A G/L account used by the system to offset (balance) journal entries. For 
example, you can use a contra/clearing account to balance the entries created by 
allocations. 

contribution to profit Selling price of an item minus its variable costs. 

control table A table that controls the program flow or plays a major part in program control. 

control table 
workbench 

During the Installation Workbench process, Control Table Workbench runs the 
batch applications for the planned merges that update the data dictionary, user 
defined codes, menus, and user overrides tables. 

control tables merge A process that blends a customer’s modifications to the control tables with the 
data that accompanies a new release. 

corrective work order A work order that is used to formally request unscheduled maintenance and 
communicate all of the details pertaining to the requested maintenance task. 

corrective work order A work order that is used to formally request unscheduled maintenance and 
communicate all of the details pertaining to the requested maintenance task. 

cost assignment Allocating resources to activities or cost objects.  

cost component An element of an item’s cost—for example, material, labor, or overhead. 

cost object Any customer, product, service, contract, project, or other work unit for which 
you need a separate cost measurement. 

cost rollup A simulated scenario in which work center rates, material costs, and labor costs 
are used to determine the total cost of an item. 

costing elements The individual classes of added value or conversion costs. These elements are 
typically materials, such as raw and packaging; labor and machine costs; and 
overhead, such as fixed and variable. Each corporation defines the necessary 
detail of product costs by defining and tracking cost categories and subcategories. 

credit memo A negative amount that is used to correct a customer’s statement when he or she 
is overcharged. 

credit notice The physical document that is used to communicate the circumstances and value 
of a credit order. 

credit order A credit order is used to reflect products or equipment that is received or returned 
so that it can be viewed as a sales order with negative amounts. Credit orders 
usually add the product back into inventory. This process is linked with delivery 
confirmation. 

cross segment edit A logic statement that establishes the relationship between configured item 
segments. Cross segment edits are used to prevent ordering of configurations that 
cannot be produced. 
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crude oil assay A procedure for determining the distillation curve and quality characteristics of a 
crude oil.  

cumulative update A version of software that includes fixes and enhancements that have been made 
since the last release or update. 

currency 
relationships 

When converting amounts from one currency to another, the currency relationship 
defines the from currency and the to currency in PeopleSoft software. For 
example, to convert amounts from German marks to the euro, you first define a 
currency relationship between those two currencies. 

currency restatement The process of converting amounts from one currency into another currency, 
generally for reporting purposes. It can be used, for example, when many 
currencies must be restated into a single currency for consolidated reporting. 

current cost The cost that is associated with an item at the time a parts list and routing are 
attached to a work order or rate schedule. Current cost is based on the latest bill of 
material and routing for the item. 

customer pricing 
rules 

In Procurement, the inventory pricing rules that are assigned to a supplier. 

In Sales, inventory pricing rules that are assigned to a customer. 

D.A.S. 2 Reporting 
(DAS 2 or DADS 1) 

In France, the name of the official form on which a business must declare fees 
and other forms of remuneration that were paid during the fiscal year. 

data dictionary A dynamic repository that is used for storing and managing a specific set of data 
item definitions and specifications. 

data source 
workbench 

During the Installation Workbench process, Data Source Workbench copies all of 
the data sources that are defined in the installation plan from the Data Source 
Master and Table and Data Source Sizing tables in the Planner data source to the 
System - release number data source. It also updates the Data Source Plan detail 
record to reflect completion. 

data structure A description of the format of records in a database such as the number of fields, 
valid data types, and so on. 

data types Supplemental information that is attached to a company or business unit. 
Narrative type contains free-form text. Code type contains dates, amounts, and so 
on. 

datagram A self-contained packet of information that is forwarded by routers, based on their 
address and the routing table information. 

date pattern A period of time that is set for each period in standard and 52-period accounting 
and forecasting. 

DCE See distributed computing environment. 

DEB See déclaration d’echange de biens. 

debit memo In Accounts Payable, a voucher that is entered with a negative amount. Enter this 
type of voucher when a supplier sends you a credit so that you can apply the 
amount to open vouchers when you issue payment to the supplier. 

debit memo A form that is issued by a customer, requesting an adjustment of the amount, 
which is owed to the supplier. 
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debit statement A list of debit balances. 

de-blend When blend off does not result in a product that is acceptable to customers. The 
further processing of product to adjust specific physical and chemical properties 
to within specification ranges. See also blend off. 

déclaration d’echange 
de biens (DEB) 

The French term that is used for the Intrastat report. 

delayed billing The invoicing process is delayed until the end of a designated period.  

delta load A batch process that is used to compare and update records between specified 
environments. 

denominated-in 
currency 

The company currency in which financial reports are based. 

deployment server A server that is used to install, maintain, and distribute software to one or more 
enterprise servers and client workstations. 

detail The specific information that makes up a record or transaction. Contrast with 
summary. 

detail information Information that primarily relates to individual lines in a sales or purchase order. 

direct connect A transaction method in which a client application communicates interactively 
and directly with a server application. See also batch-of-one immediate, store-
and-forward. 

direct input The system calculates the net units when you enter gross volume, temperature, 
and gravity or density. This data is generally entered during product receiving 
from the certificate that is prepared by an independent inspector. 

direct ship orders A purchase order that is issued to a third-party supplier who designates the 
destination as the customer. A direct ship sales order is also created for the 
customer. Direct ship orders occur when a product is not available from a 
company-owned or company-operated source, so the system creates an order to 
ship the product from a third-party source directly to the customer. Sometimes 
referred to as a drop ship or third-party supply. 

direct usage Consumption of resources that are attributable to specific production runs because 
the resources were directly issued to the schedule/order.  

director An EnterpriseOne user interface that guides a user interactively through an 
EnterpriseOne process. 

dirty cargo Term that refers to crude oil cargoes or other non-refined petroleum cargoes. See 
also clean cargo. 

dispatch planning Efficient planning and scheduling of product deliveries. Considerations include: 

Dispatch groups 

Scheduled delivery date  

Scheduled delivery time 

Preferred delivery date  

Preferred delivery time 

Average delivery time for that geographical location 
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Available resources 

Special equipment requirements at the product’s source or destination.  

displacement days The number of days that are calculated from today’s date by which you group 
vouchers for payment. For example, if today’s date is March 10 and you specify 
three displacement days, the system includes vouchers with a due date through 
March 13 in the payment group. Contrast with pay-through date. 

display sequence A number that the system uses to re-order a group of records on the form. 

distributed 
computing 
environment (DCE) 

A set of integrated software services that allows software which is running on 
multiple computers to perform seamless and transparently to the end-users. DCE 
provides security, directory, time, remote procedure calls, and files across 
computers running on a network. 

distributed data 
processing 

Processing in which some of the functions are performed across two or more 
linked facilities or systems. 

distributed database 
management system 
(DDBMS) 

A system for distributing a database and its control system across many 
geographically dispersed machines. 

do not translate 
(DNT) 

A type of data source that must exist on the AS/400 because of BLOB 
restrictions. 

double-byte character 
set (DBCS) 

A method of representing some characters by using one byte and other characters 
by using two bytes. Double-byte character sets are necessary to represent some 
characters in the Japanese, Korean, and Chinese languages. 

downgrade profile A statement of the hierarchy of allowable downgrades. Includes substitutions of 
items, and meeting tighter specifications for those products with wider or 
overlapping specification ranges. 

DTA Datenträgeraustausch. A Swiss payment format that is required by Telekurs 
(Payserv). 

dual pricing To provide prices for goods and services in two currencies. During the euro 
transition period, dual pricing between the euro and Economic and Monetary 
Union (EMU) member currencies is encouraged.  

dynamic link library 
(DLL) 

A set of program modules that are designed to be invoked from executable files 
when the executable files are run, without having to be linked to the executable 
files. They typically contain commonly used functions. 

dynamic partitioning The ability to dynamically distribute logic or data to multiple tiers in a 
client/server architecture. 

economy of scale A phenomenon whereby larger volumes of production reduce unit cost by 
distributing fixed costs over a larger quantity. Variable costs are constant; but 
fixed costs per unit are reduced, thereby reducing total unit cost. 

edit mode A processing mode or condition where the user can alter the information in a 
form. 

edit rule A method that is used for formatting user entries, validating user entries, or both, 
against a predefined rule or set of rules. 

embedded event rule An event rule that is specific to a particular table or application. Examples include 
form-to-form calls, hiding a field that is based on a processing option value, or 
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calling a business function. Contrast with business function event rule. See also 
event rule. 

employee work center A central location for sending and receiving all EnterpriseOne messages (system 
and user-generated), regardless of the originating application or user. Each user 
has a mailbox that contains workflow and other messages, including Active 
Messages. With respect to workflow, the Message Center is MAPI compliant and 
supports drag-and-drop work reassignment, escalation, forward and reply, and 
workflow monitoring. All messages from the message center can be viewed 
through EnterpriseOne messages or Microsoft Exchange. 

Emulator An item of software or firmware that allows one device to imitate the functioning 
of another. 

encapsulation The ability to confine access to and manipulation of data within an object to the 
procedures that contribute to the definition of that object. 

engineering change 
order (ECO) 

A work order document that is used to implement and track changes to items and 
resulting assemblies. The document can include changes in design, quantity of 
items required, and the assembly or production process. 

enhanced analysis 
database 

A database containing a subset of operational data. The data on the enhanced 
analysis database performs calculations and provides summary data to speed 
generation of reports and query response times. This solution is appropriate when 
external data must be added to source data, or when historical data is necessary 
for trend analysis or regulatory reporting. See also duplicated database, enterprise 
data warehouse. 

enterprise server A computer containing programs that collectively serve the needs of an enterprise 
rather than a single user, department, or specialized application. 

EnterpriseOne object A re-usable piece of code that is used to build applications. Object types include 
tables, forms, business functions, data dictionary items, batch processes, business 
views, event rules, versions, data structures, and media objects. See also object. 

EnterpriseOne 
process 

Allows EnterpriseOne clients and servers to handle processing requests and 
execute transactions. A client runs one process, and servers can have multiple 
instances of a process. EnterpriseOne processes can also be dedicated to specific 
tasks (for example, workflow messages and data replication) to ensure that critical 
processes do not have to wait if the server is particularly busy. 

EnterpriseOne web 
development 
computer 

A standard EnterpriseOne Windows developer computer with the additional 
components installed: 

Sun’s JDK 1.1. 

JFC (0.5.1). 

Generator Package with Generator.Java and JDECOM.dll. 

R2 with interpretive and application controls/form. 

environment 
workbench 

During the Installation Workbench process, Environment Workbench copies the 
environment information and Object Configuration Manager tables for each 
environment from the Planner data source to the System release number data 
source. It also updates the Environment Plan detail record to reflect completion. 

equivalent fuel A barrel of equivalent fuel supplies six million BTUs of heat. Fuel gas quantities 
are usually calculated as equivalent fuel barrels in economic calculations for 
refinery operations. 
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escalation monitor A batch process that monitors pending requests or activities, and restarts or 
forwards them to the next step or user after they have been inactive for a specified 
amount of time. 

ESR Einzahlungsschein mit Referenznummer. A pay slip with a reference number. 

event rule [In EnterpriseOne] A logic statement that instructs the system to perform one or 
more operations that are based on an activity that can occur in a specific 
application, such as entering a form or exiting a field. 

exit bar [In EnterpriseOne] The tall pane with icons in the left portion of many 
EnterpriseOne program windows.  

facility An entity within a business for which you want to track costs. For example, a 
facility might be a warehouse location, job, project, work center, or branch/plant. 
Sometimes referred to as a business unit. 

fast path [In EnterpriseOne] A command prompt that allows the user to move quickly 
among menus and applications by using specific commands. 

file handle A temporary reference (typically a number) that is assigned to a file which has 
been opened by the operating system and is used throughout the session to access 
the file. 

file server A computer that stores files to be accessed by other computers on the network. 

find/browse A type of form used to: 

Search, view, and select multiple records in a detail area.  

Delete records.  

Exit to another form.  

Serve as an entry point for most applications.  

firm planned order 
(FPO) 

A work order that has reached a user defined status. When this status is entered in 
the processing options for the various manufacturing programs, messages for 
those orders are not exploded to the components. 

fiscal date pattern A representation of the beginning date for the fiscal year and the ending date for 
each period in that year. 

fix/inspect A type of form used to view, add, or modify existing records. A fix/inspect form 
has no detail area. 

fixed quantity A term that indicates the bill of material relationship between a parent item and its 
components or ingredients. When a bill of material component has a fixed 
quantity relationship to its parent, the amount of the component does not change 
when the software calculates parts list requirements for different work order 
quantities. Contrast with variable quantity. 

flexible account 
numbers 

The format of account numbers for journal entries. The format that you set up 
must be the three segments: 

Business unit. 

Object. 

Subsidiary. 
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form design aid 
(FDA) 

The EnterpriseOne GUI development tool for building interactive applications 
and forms. 

form exit [In EnterpriseOne] An option that is available as a button on the Form Exit bar or 
as a selection in the Form menu. It allows users to open an interconnected form.  

form interconnection Allows one form to access and pass data to another form. Form interconnections 
can be attached to any event; however, they are normally used when a button is 
clicked. 

form type The following form types are available in EnterpriseOne: 

Find/browse.  

Fix/inspect.  

Header detail.  

Headerless detail.  

Message.  

Parent/child.  

Search/select. 

form-to-form call A request by a form for data or functionality from one of the connected forms. 

framework [In object-oriented systems] A set of object classes that provide a collection of 
related functions for a user or piece of software.  

frozen cost The cost of an item, operation, or process after the frozen update program is run; 
used by the Manufacturing Accounting system.  

frozen update 
program 

A program that freezes the current simulated costs, thereby finalizing them for use 
by the Manufacturing Accounting system. 

globally unique 
identifier (GUI) 

A 16-byte code in the Component Object Model that identifies an interface to an 
object across all computers and networks. 

handle [In programming] A pointer that contains the address of another pointer, which, in 
turn, contains the address of the desired object. 

hard commitment The number of items that are reserved for a sales order, work order, or both, from 
a specific location, lot, or both. 

hard error An error that cannot be corrected by a given error detection and correction 
system. 

header Information at the beginning of a table or form. Header information is used to 
identify or provide control information for the group of records that follows. 

header information Information that pertains to the entire order. 

hover help A help function that provides contextual information or instructions when a 
cursor moves over a particular part of the interface element for a predefined 
amount of time.  

ICMS Imposto sobre circulação de mercadoria e servicos. In Brazil, a state tax that is 
applied to the movement of merchandise and some services. 

ICMS Substituto Imposto sobre circulacao de mercadoria e servicos substituto. In Brazil, the ICMS 
tax that is charged on interstate transactions, or on special products and clients. 
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ICMS Substituto-
Markup 

See imposto sobre circulação de mercadoria e servicos substituto-markup. 

imposto de renda (IR) Brazilian income tax. 

imposto sobre 
produtos 
industrializados 

In Brazil, a federal tax that applies to manufactured goods (domestic and 
imported). 

imposto sobre 
services (ISS) 

In Brazil, tax on services. 

inbound document A document that is received from a trading partner using Electronic Data 
Interface (EDI). This document is also referred to as an inbound transaction. 

indented tracing Tracking all lot numbers of intermediates and ingredients that are consumed in 
the manufacture of a given lot of product, down through all levels of the bill of 
material, recipe, or formula. 

indexed allocations A procedure that allocates or distributes expenses, budgets, adjustments, and so 
on, among business units, based on a fixed percentage. 

indirect measurement Determining the quantity on-hand by:  

Measuring the storage vessels and calculating the content’s balance quantity.  

or 

Theoretically calculating consumption of ingredients and deducting them from 
the on-hand balance.  

indirect usage Determining what should have been used by multiplying receipt quantity of the 
parent times the quantity per statement in the formula, recipe, or bill of material. 
This transaction typically affects both consumption on schedule as well as issue 
from on-hand balances. 

in-process rework Recycling a semi processed product that does not meet acceptable standards. 
Further processing takes the product out of a given operation and sends it back to 
the beginning of that operation or a previous operation (for example, unreacted 
materials).  

Rework that is detected prior to receipt of finished goods and corrected during the 
same schedule run. 

INPS withholding tax Instituto Nazionale di Previdenza Sociale withholding tax. In Italy, a 12% social 
security withholding tax that is imposed on payments to certain types of 
contractors. This tax is paid directly to the Italian social security office. 

inscrição estadual ICMS tax ID. In Brazil, the state tax ID. 

inscrição municipal ISS tax ID. In Brazil, the municipal tax ID. 

integrated toolset Unique to EnterpriseOne is an industrial-strength toolset that is embedded in the 
already comprehensive business applications. This toolset is the same toolset that 
is used by PeopleSoft to build EnterpriseOne interactive and batch applications. 
Much more than a development environment, however, the EnterpriseOne 
integrated toolset handles reporting and other batch processes, change 
management, and basic data warehousing facilities. 

integrity test A process that is used to supplement a company’s internal balancing procedures 
by locating and reporting balancing problems and data inconsistencies. 
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interbranch sales 
order 

A sales order that is used for transactions between branch/plants other than the 
selling branch/plant. 

Interoperability The ability of different computer systems, networks, operating systems, and 
applications to work together and share information. 

inventory pricing rule A discount method that is used for purchases from suppliers and sales to 
customers. The method is based on effectivity dates, up-to quantities, and a factor 
by which you can mark up or discount the price or cost. 

inventory turn The number of times that the inventory cycles, or turns over, during the year. A 
frequently used method to compute inventory turnover is to divide the annual 
costs of sales by the average inventory level. 

invoice An itemized list of goods that are shipped or services that are rendered, stating 
quantities, prices, fees, shipping charges, and so on. Companies often have their 
invoices mailed to a different address than where they ship products. In such 
cases, the bill-to address differs from the ship-to address. 

IP See imposto sobre produtos industrializados. 

IR See imposto de renda. 

IServer Service Developed by PeopleSoft, this Internet server service resides on the Web server 
and is used to speed up delivery of the Java class files from the database to the 
client. 

ISS See imposto sobre servicos. 

jargon An alternate data dictionary item description that EnterpriseOne or PeopleSoft 
World displays, based on the product code of the current object. 

java application 
server 

A component-based server that resides in the middle-tier of a server-centric 
architecture and provides middleware services for security and state maintenance, 
along with data access and persistence. 

JDBNET A database driver that allows heterogeneous servers to access each other’s data. 

jde.ini A PeopleSoft file (or member for AS/400) that provides the runtime settings that 
are required for EnterpriseOne initialization. Specific versions of the file or 
member must reside on every machine that is running EnterpriseOne, including 
workstations and servers. 

JDE.LOG The main diagnostic log file of EnterpriseOne. Always located in the root 
directory on the primary drive. Contains status and error messages from the 
startup and operation of EnterpriseOne. 

JDEBASE Database 
Middleware 

PeopleSoft proprietary database middleware package that provides two primary 
benefits: 

1. Platform-independent APIs for multidatabase access. These APIs are 
used in two ways: 

a. By the interactive and batch engines to dynamically generate platform-
specific SQL, depending on the data source request. 

b. As open APIs for advanced C business function writing. These APIs are 
then used by the engines to dynamically generate platform-specific SQL. 

2. Client-to-server and server-to-server database access. To accomplish this 
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access, EnterpriseOne is integrated with a variety of third-party database drivers, 
such as Client Access 400 and open database connectivity (ODBC). 

JDECallObject An application programming interface that is used by business functions to 
invoke other business functions. 

JDEIPC Communications programming tools that are used by server code to regulate 
access to the same data in multiprocess environments, communicate and 
coordinate between processes, and create new processes. 

JDENET PeopleSoft proprietary middleware software. JDENET is a messaging software 
package. 

JDENET 
communications 
middleware 

PeopleSoft proprietary communications middleware package for EnterpriseOne. 
It is a peer-to-peer, message-based, socket-based, multiprocess communications 
middleware solution. It handles client-to-server and server-to-server 
communications for all EnterpriseOne supported platforms. 

just in time 
installation (JITI) 

EnterpriseOne’s method of dynamically replicating objects from the central 
object location to a workstation. 

just in time 
replication (JITR) 

EnterpriseOne’s method of replicating data to individual workstations. 
EnterpriseOne replicates new records (inserts) only at the time that the user needs 
the data. Changes, deletes, and updates must be replicated using Pull Replication. 

Kagami In Japan, summarized invoices that are created monthly (in most cases) to reduce 
the number of payment transactions. 

latitude The X coordinate of the location of an item in the warehouse. The system can use 
latitude, longitude, and height when suggesting locations for putaway, 
replenishment, and picking. 

laytime (or layhours) The amount of time that is allotted to a tanker at berth to complete loading or 
discharging cargo. This time is usually expressed in running hours, and is fixed 
by prior agreement between the vessel owner and the company that is chartering 
the vessel. Laytime is stipulated in the charter, which states exactly the total of 
number of hours that are granted at both loading and unloading ports, and 
indicates whether such time is reversible. A statement of “Seventy-Two Hours, 
Reversible” means that a total of 72 hours is granted overall at both ports, and any 
time saved at one port can be applied as a credit at the other port.  

For example, if the vessel uses only 32 hours instead of 36 hours to load cargo, it 
can apply an additional four hours to the 36 hours allotted at the discharge port. 
Such considerations are important for purposes of computing demurrage. 

leading zeros A series of zeros that certain facilities in PeopleSoft systems place in front of a 
value that is entered. This situation normally occurs when you enter a value that is 
smaller than the specified length of the field. For example, if you enter 4567 in a 
field that accommodates eight numbers, the facility places four zeros in front of 
the four numbers that you enter. The result appears as 00004567. 

ledger type A code that designates a ledger which is used by the system for a particular 
purpose. For example, all transactions are recorded in the AA (actual amounts) 
ledger type in their domestic currency. The same transactions can also be stored 
in the CA (foreign currency) ledger type. 

level break The position in a report or text where a group of similar types of information ends 
and another one begins. 
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libro IVA Monthly VAT report. In Italy, the term for the report that contains the detail of 
invoices and vouchers that were registered during each month. 

line of business A description of the nature of a company’s work; also a tool to control the 
relationship with that customer, including product pricing. 

linked service type A service type that is associated with a primary service type. Linked service types 
can be cancelled, and the maintenance tasks are performed when the primary 
service type to which they are linked comes due. You can specify whether the 
system generates work orders for linked service types, as well as the status that 
the system assigns to work orders that have already been generated. Sometimes 
referred to as associated service types. See also primary service type and service 
type. 

livro razao In Brazil, a general ledger report. 

load balancing The act of distributing the number of processes proportionally to all servers in a 
group to maximize overall performance. 

location workbench During the Installation Workbench process, Location Workbench copies all 
locations that are defined in the installation plan from the Location Master table 
in the Planner data source to the System data source. 

log files Files that track operations for a process or application. Reviewing log files is 
helpful for troubleshooting problems. The file extension for log files is .LOG. 

logic data source Any code that provides data during runtime. 

logical compartment One of two ways that is identified in the transportation constants to display 
compartments on vehicles. Logical display numbers the compartments 
sequentially.  

For example, if two vehicles are on a trip and each vehicle has three 
compartments, the logical display is 1,2,3,4,5,6. 

logical file A set of keys or indices that is used for direct access or ordered access to the 
records in a physical file. Several logical files can have different accesses to a 
physical. 

logical shelf A logical, not physical, location for inventory that is used to track inventory 
transactions in loan/borrow, or exchange agreements with other companies. See 
also logical warehouse. 

logical warehouse Not a physical warehouse containing actual inventory, but a means for storing and 
tracking information for inventory transactions in loan/borrow, or exchange 
agreements with other companies. 

longitude The Y coordinate of the location of an item in the warehouse. The system can use 
latitude, longitude, and height when suggesting locations for putaway, 
replenishment, and picking. 

LSV Lastschriftverfahren. A Swiss auto debit format that is required by Telekurs 
(Payserv). 

mail merge A mass-mail facility that takes names, addresses, and (sometimes) pertinent facts 
about recipients and merges the information into a form letter or a similarly basic 
document. 
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mailmerge 
workbench 

[In EnterpriseOne] An application that merges Microsoft Word 6.0 (or higher) 
word-processing documents with EnterpriseOne records to automatically print 
business documents. 

main fuels Usually refers to bulk fuel products, but sometimes includes packaged products. 

maintenance loop See maintenance route. 

A method of performing PMs for multiple pieces of equipment from a single 
preventive maintenance work order. A maintenance route includes pieces of 
equipment that share one or more identical maintenance tasks which can be 
performed at the same time for each piece of equipment. Sometimes referred to as 
maintenance loop. 

maintenance work 
order 

In PeopleSoft EnterpriseOne systems, a term that is used to distinguish work 
orders created for the performance of equipment and plant maintenance from 
other work orders, such as manufacturing work orders, utility work orders, and 
engineering change orders. 

manufacturing and 
distribution planning 

Planning that includes resource and capacity planning, and material planning 
operations. Resource and capacity planning allows you to prepare a feasible 
production schedule that reflects your demand forecasts and production 
capability. Material Planning Operations provides a short-range plan to cover 
material requirements that are needed to make a product. 

mapping A set of instructions that describes how one data structure passes data to another. 

master business 
function 

An interactive master file that serves as a central location for adding, changing, 
and updating information in a database. 

master business 
function 

A central system location for standard business rules about entering documents, 
such as vouchers, invoices, and journal entries. Master business functions ensure 
uniform processing according to guidelines that you establish. 

master table A database table that is used to store data and information that is permanent and 
necessary to the system’s operation. Master tables might contain data such as paid 
tax amounts, supplier names, addresses, employee information, and job 
information. 

matching document A document that is associated with an original document to complete or change a 
transaction. For example, a receipt is the matching document of an invoice. 

media object An electronic or digital representation of an object.  

media storage objects Files that use one of the following naming conventions that are not organized into 
table format: Gxxx, xxxGT, or GTxxx. 

memory violation An error that occurs as the result of a memory leak. 

menu selection An option on a menu that initiates a software function directly.  

message center A central location for sending and receiving all EnterpriseOne messages (system- 
and user-generated), regardless of the originating application or user. 

messaging application 
programming 
interface (MAPI) 

An architecture that defines the components of a messaging system and how they 
behave. It also defines the interface between the messaging system and the 
components. 

maintenance route 
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metal content A series of properties of a blended product that help to determine its suitability for 
a prescribed purpose. 

metals management The process of maintaining information about the location and status of durable 
product containers such as liquid petroleum gas (LPG) cylinders. 

mobile inventory Inventory that is transferred from a depot to a barge or truck for milk-run 
deliveries. 

modal A restrictive or limiting interaction that is created by a given condition of 
operation. Modal often describes a secondary window that restricts a user’s 
interaction with other windows. A secondary window can be modal with respect 
to its primary window or to the entire system. A modal dialog box must be closed 
by the user before the application continues. 

model work order For scheduled preventive maintenance or for a condition-based alert, a model 
work order functions as a template for the creation of other work orders. You can 
assign model work orders to service types and condition-based alerts. When the 
service type comes due or the alert is generated, the system automatically 
generates a work order that is based on information from the model work order. 

modeless Not restricting or limiting interaction. Modeless often describes a secondary 
window that does not restrict a user’s interaction with other windows. A modeless 
dialog box stays on the screen and is available for use at any time, but also 
permits other user activities. 

multiple stocking 
locations 

Authorized storage locations for the same item number at locations, in addition to 
the primary stocking location. 

multitier architecture A client/server architecture that allows multiple levels of processing. A tier 
defines the number of computers that can be used to complete some defined task. 

named event rules 
(NER) 

Also called business function event rules. Encapsulated, re-usable business logic 
that is created by using event rules, rather than C programming. 

national language 
support (NLS) 

Mechanisms that are provided to facilitate internationalization of both system and 
application user interfaces. 

natureza da operação Transaction nature. In Brazil, a code that classifies the type of commercial 
transaction to conform to the fiscal legislation. 

negative pay item An entry in an account that indicates a prepayment. For example, you might 
prepay a supplier before goods are sent or prepay an employee’s forecasted 
expenses for a business trip. The system stores these pending entries, assigning 
them a minus quantity as debit amounts in a designated expense account. After 
the prepaid goods are received or the employee submits an expense report, 
entering the actual voucher clears all of the negative pay items by processing 
them as regular pay items. Note that a negative pay item can also result from 
entering a debit memo (A/P) or a credit memo (A/R). 

net added cost The cost to manufacture an item at the current level in the bill of material. Thus, 
for manufactured parts, the net added cost includes labor, outside operations, and 
cost extras applicable to this level in the bill of material, but not materials (lower-
level items). For purchased parts, the net added cost also includes the cost of 
materials. 

next status The next step in the payment process for payment control groups. The next status 
can be either WRT (write) or UPD (update). 
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node A termination point for two or more communications links. A node can serve as 
the control location for forwarding data among the elements of a network or 
multiple networks, as well as performing other networking and, in some cases, 
local processing. 

non-inventory items See non-stock items. 

non-list price A price for bulk products that is determined by its own algorithms, such as a 
rolling average or commodity price plus. 

non-prime product A manufactured product with revenue potential that is less than the product 
planned for, or scheduled to be produced. 

non-stock items Items that the system does not account for as part of the inventory. For example, 
office supplies, or packaging materials can be non-stock items. 

nota fiscal In Brazil, a legal document that must accompany all commercial transactions. 

nota fiscal fatura In Brazil, a nota fiscal and invoice information. 

notula In Italy, the process whereby a business does not recognize value added tax until 
the payment of a voucher. 

object configuration 
manager (OCM) 

EnterpriseOne’s object request broker and the control center for the runtime 
environment. It keeps track of the runtime locations for business functions, data, 
and batch applications. When one of these objects is called, the Object 
Configuration Manager directs access to it by using defaults and overrides for a 
given environment and user. 

object embedding When an object is embedded in another document, an association is maintained 
between the object and the application that created it; however, any changes made 
to the object are also only kept in the compound document. See also object 
linking. 

object librarian A repository of all versions, applications, and business functions that are re-
usable in building applications. 

object linking When an object is linked to another document, a reference is created with the file 
in which the object is stored, as well as with the application that created it. When 
the object is modified, either from the compound document or directly through 
the file in which it is saved, the change is reflected in that application as well as 
anywhere it has been linked. See also object embedding. 

object linking and 
embedding (OLE) 

A technology for transferring and sharing information among applications by 
allowing the integration of objects from diverse applications, such as graphics, 
charts, spreadsheets, text, or an audio clip from a sound program. OLE is a 
compound document standard that was developed by Microsoft Corporation. It 
enables you to create objects with one application, and then link or embed them in 
a second application. Embedded objects retain their original format and links to 
the application that created them. See also object embedding, object linking. 

object management 
workbench (OMW) 

The change management system that is used for EnterpriseOne development. 

object-based 
technology (OBT) 

A technology that supports some of the main principles of object-oriented 
technology:  

Classes. 
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Polymorphism.I 

Inheritance. 

Encapsulation. 

object-oriented 
technology (OOT) 

Brings software development past procedural programming into a world of re-
usable programming that simplifies development of applications. Object 
orientation is based on the following principles:  

Classes. 

Polymorphism.I 

Inheritance. 

Encapsulation. 

offsetting account An account that reduces the amount of another account to provide a net balance. 
For example, a credit of 200 to a cash account might have an offsetting entry of 
200 to an A/P Trade (liability) account. 

open database 
connectivity (ODBC) 

Defines a standard interface for different technologies to process data between 
applications and different data sources. The ODBC interface comprises set of 
function calls, methods of connectivity, and representation of data types that 
define access to data sources. 

open systems 
interconnection (OSI) 

The OSI model was developed by the International Standards Organization (ISO) 
in the early 1980s. It defines protocols and standards for the interconnection of 
computers and network equipment. 

order detail line A part of an order that contains transaction information about a service or item 
being purchased or sold, such as quantity, cost, price, and so on. 

order hold A flag that stops the processing of an order because it has exceeded the credit or 
budget limit, or has another problem. 

order-based pricing Pricing strategy that grants reductions in price to a customer. It is based upon the 
contents and relative size (volume or value) of the order as a whole. 

outbound document A document that is sent to a trading partner using EDI. This term is also referred 
to as an outbound transaction. 

outturn The quantity of oil that is actually received into a buyer’s storage tanks when a 
vessel is unloaded. For various reasons (vaporization, clingage to vessel tank 
walls, and so on), the amount of a product pumped into shore tankage at 
unloading is often less than the quantity originally loaded onto the vessel, as 
certified by the Bill of Lading. Under a delivered or CIF outturn transaction, the 
buyer pays only for the barrels actually “turned out” by the vessel into storage.  

When a buyer is paying CIF Bill of Lading figures, a loss of 0.5% of total cargo 
volume is considered normal. Losses in excess of 0.5%, however, are either 
chargeable to the seller or are covered by specialized insurance that covers partial, 
as well as total, loss of the cargo. 

overhead In the distillation process, that portion of the charge that leaves the top of the 
distillation column as vapor. This definition is strictly as it relates to ECS. 

override conversion 
method 

A method of calculating exchange rates that is set up between two specific 
currencies. For those specific currencies, this method overrides the conversion 
method in General Accounting Constants and does not allow inverse rates to be 
used when calculating currency amounts. 
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package / package 
build 

A collection of software that is grouped into a single entity for modular 
installation. EnterpriseOne objects are installed to workstations in packages from 
the deployment server. A package can be compared to a bill of material or kit that 
indicates the necessary objects for that workstation and where the installation 
program can find them on the deployment server. It is a point-in-time “snapshot” 
of the central objects on the deployment server. 

package location The directory structure location for the package and its set of replicated objects. 
This location is usually \\deployment server\release\path_code\package\ package 
name. The replicated objects for the package are placed in the subdirectories 
under this path. This location is also where the package is built or stored. 

package workbench During the Installation Workbench process, Package Workbench transfers the 
package information tables from the Planner data source to the System - release 
number data source. It also updates the Package Plan detail record to reflect 
completion. 

packaged products Products that, by their nature, must be delivered to the customer in containers 
which are suitable for discrete consumption or resale. 

pane/panel A resizable subarea of a window that contains options, components, or other 
related information. 

paper clip An icon that is used to indicate that a media object is attached to a form or record. 

parent/child form A type of form that presents parent/child relationships in an application on one 
form: 

The left portion of the form presents a tree view that displays a visual 
representation of a parent/child relationship.  

The right portion of the form displays a detail area in browse mode. The detail 
area displays the records for the child item in the tree.  

The parent/child form supports drag and drop functionality. 

parent/child 
relationship 

See parent/component relationship. 

parent/component 
relationship 

1. In Capital Asset Management, the hierarchical relationship of a parent piece of 
equipment to its components. For example, a manufacturing line could be a parent 
and the machinery on the line could be components of the line. In addition, each 
piece of machinery could be a parent of still more components.  

2. In Product Data Management, a hierarchical relationship of the components 
and subassemblies of a parent item to that parent item. For example, an 
automobile is a parent item; its components and subassemblies include: engine, 
frame, seats, and windows.  

Sometimes referred to as parent/child relationship. 

partita IVA In Italy, a company fiscal identification number. 

pass-through A process where data is accepted from a source and forwarded directly to a target 
without the system or application performing any data conversion, validation, and 
so on. 

pay on consumption The method of postponing financial liability for component materials until you 
issue that material to its consuming work order or rate schedule. 
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payment group A system-generated group of payments with similar information, such as a bank 
account. The system processes all of the payments in a payment group at the same 
time. 

PeopleSoft database See JDEBASE Database Middleware. 

performance tuning The adjustments that are made for a more efficient, reliable, and fast program. 

persistent object An object that continues to exist and retains its data beyond the duration of the 
process that creates it. 

pervasive device A type of intelligent and portable device that provides a user with the ability to 
receive and gather information anytime, from anywhere. 

planning family A means of grouping end items that have similarity of design or manufacture. 

plug-in A small program that plugs into a larger application to provide added 
functionality or enhance the main application. 

polymorphism A principle of object-oriented technology in which a single mnemonic name can 
be used to perform similar operations on software objects of different types. 

portal A Web site or service that is a starting point and frequent gateway to a broad 
array of on-line resources and services.  

Postfinance A subsidiary of the Swiss postal service. Postfinance provides some banking 
services. 

potency Identifies the percent of an item in a given solution. For example, you can use an 
80% potent solution in a work order that calls for 100% potent solution, but you 
would use 25% more, in terms of quantity, to meet the requirement (100 / 80 = 
1.25). 

preference profile The ability to define default values for specified fields for a user defined 
hierarchy of items, item groups, customers, and customer groups. In Quality 
Management setup, this method links test and specification testing criteria to 
specific items, item groups, customers, or customer groups. 

preflush A work order inventory technique in which you deduct (relieve) materials from 
inventory when the parts list is attached to the work order or rate schedule. 

preventive 
maintenance cycle 

The sequence of events that make up a preventive maintenance task, from its 
definition to its completion. Because most preventive maintenance tasks are 
commonly performed at scheduled intervals, parts of the preventive maintenance 
cycle repeat, based on those intervals. 

preventive 
maintenance schedule 

The combination of service types that apply to a specific piece of equipment, as 
well as the intervals at which each service type is scheduled to be performed. 

primary service type A service type to which you can link related service types. For example, for a 
particular piece of equipment, you might set up a primary service type for a 1000-
hour inspection and a linked service type for a 500-hour inspection. The 1000-
hour inspection includes all of the tasks performed at 500 hours. When a primary 
service type is scheduled to be performed, the system schedules the linked service 
type. See also linked service type. 

pristine environment An EnterpriseOne environment that is used to test unaltered objects with 
PeopleSoft demonstration data or for training classes. You must have this 
environment so you can compare pristine objects that you modify. 
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processing option A data structure that allows users to supply parameters that regulate the execution 
of a batch program or report.  

product data 
management (PDM) 

In PeopleSoft EnterpriseOne software, the system that enables a business to 
organize and maintain information about each item which it manufactures. 
Features of this system, such as bills of material, work centers, and routings, 
define the relationships among parents and components, and how they can be 
combined to manufacture an item. PDM also provides data for other 
manufacturing systems including Manufacturing Accounting, Shop Floor 
Management, and Manufacturing and Distribution Planning. 

product line A group of products with similarity in manufacturing procedures, marketing 
characteristics, or specifications that allow them to be aggregated for planning; 
marketing; and, occasionally, costing.  

product/process 
definition 

A combination of bill of material (recipe, formula, or both) and routing (process 
list). Organized into tasks with a statement of required consumed resources and 
produced resources. 

production 
environment 

An EnterpriseOne environment in which users operate EnterpriseOne software. 

program temporary 
fix (PTF) 

A representation of changes to PeopleSoft software that your organization 
receives on magnetic tapes or diskettes. 

project [In EnterpriseOne] A virtual container for objects being developed in Object 
Management Workbench. 

projected cost The target expenditure in added value for material, labor, and so on, during 
manufacture. See also standard cost. 

promotion path The designated path for advancing objects or projects in a workflow. 

protocollo See registration number. 

PST Provincial sales tax. A tax that is assessed by individual provinces in Canada. 

published table Also called a “Master” table, this is the central copy to be replicated to other 
machines and resides on the “publisher” machine. The Data Replication Publisher 
Table (F98DRPUB) identifies all of the published tables and their associated 
publishers in the enterprise. 

publisher The server that is responsible for the published table. The Data Replication 
Publisher Table (F98DRPUB) identifies all of the published tables and their 
associated publishers in the enterprise. 

pull replication One of the EnterpriseOne methods for replicating data to individual workstations. 
Such machines are set up as pull subscribers that use EnterpriseOne’s data 
replication tools. The only time that pull subscribers are notified of changes, 
updates, and deletions is when they request such information. The request is in 
the form of a message that is sent, usually at startup, from the pull subscriber to 
the server machine that stores the Data Replication Pending Change Notification 
table (F98DRPCN). 

query by example 
(QBE) 

Located at the top of a detail area, this area is used to search for data to display in 
the detail area. 
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rate scheduling A method of scheduling product or manufacturing families, or both.  

Also a technique to determine run times and quantities of each item within the 
family to produce enough of each individual product to satisfy demand until the 
family can be scheduled again.  

rate type For currency exchange transactions, the rate type distinguishes different types of 
exchange rates. For example, you can use both period average and period-end 
rates, distinguishing them by rate type. 

real-time Pertaining to information processing that returns a result so rapidly that the 
interaction appears to be instantaneous. 

receipt routing A series of steps that is used to track and move items within the receipt process. 
The steps might include in-transit, dock, staging area, inspection, and stock. 

referential integrity Ensures that a parent record cannot be deleted from the database when a child 
record for exists. 

regenerable Source code for EnterpriseOne business functions can be regenerated from 
specifications (business function names). Regeneration occurs whenever an 
application is recompiled, either for a new platform or when new functionality is 
added. 

register types and 
classes 

In Italian VAT Summary Reporting, the classification of VAT transactions. 

relationship Links tables together and facilitates joining business views for use in an 
application or report. Relationships that are created are based on indexes. 

rélevé d’identité 
bancaire (RIB) 

In France, the term that indicates the bank transit code, account number, and 
check digit that are used to validate the bank transit code and account number. 
The bank transit code consists of the bank code and agency code. The account 
number is alphanumeric and can be as many as 11 characters. PeopleSoft supplies 
a validation routine to ensure RIB key correctness. 

remessa In Brazil, the remit process for A/R. 

render To include external data in displayed content through a linking mechanism. 

repasse In Brazil, a discount of the ICMS tax for interstate transactions. It is the 
adjustment between the interstate and the intrastate ICMS tax rates. 

replenishment point The location on or near the production line where additional components or 
subassemblies are to be delivered. 

replication server A server that is responsible for replicating central objects to client machines. 

report design aid 
(RDA) 

The EnterpriseOne GUI tool for operating, modifying, and copying report batch 
applications. 

repost In Sales, the process of clearing all commitments from locations and restoring 
commitments, based on quantities from the Sales Order Detail table (F4211). 

resident Pertaining to computer programs or data while they remain on a particular storage 
device. 

retorno In Brazil, the receipt process for A/R. 
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RIB See rélevé d’identité bancaire. 

ricevute bancarie 
(RiBa) 

In Italy, the term for accounts receivable drafts. 

riepilogo IVA Summary VAT monthly report. In Italy, the term for the report that shows the 
total amount of VAT credit and debit. 

ritenuta d’acconto In Italy, the term for standard withholding tax. 

rollback [In database management] A feature or command that undoes changes in database 
transactions of one or more records. 

rollup See cost rollup. 

row exit [In EnterpriseOne] An application shortcut, available as a button on the Row Exit 
bar or as a menu selection, that allows users to open a form that is related to the 
highlighted grid record. 

runtime The period of time when a program or process is running. 

SAD The German name for a Swiss payment format that is accepted by Postfinance. 

SAR See software action request. 

scalability The ability of software, architecture, hardware, or a network to support software 
as it grows in size or resource requirements. 

scripts A collection of SQL statements that perform a specific task. 

scrub To remove unnecessary or unwanted characters from a string. 

search/select A type of form that is used to search for a value and return it to the calling field. 

selection Found on PeopleSoft menus, selections represent functions that you can access 
from a menu. To make a selection, type the associated number in the Selection 
field and press Enter. 

serialize To convert a software object into a stream of bytes to store on a disk or transfer 
across a network.  

server map The server view of the object configuration mapping. 

server workbench During the Installation Workbench process, Server Workbench copies the server 
configuration files from the Planner data source to the System release number 
data source. It also updates the Server Plan detail record to reflect completion. 

service interval The frequency at which a service type is to be performed. Service intervals can be 
based on dates, periods, or statistical units that are user defined. Examples of 
statistical units are hours, miles, and fuel consumption. 

service type An individual preventive maintenance task or procedure, such as an inspection, 
lubrication, or overhaul. Service types can apply to a specific piece of equipment 
or to a class of equipment. You can specify that service types come due based on 
a predetermined service interval, or whenever the task that is represented by the 
service type becomes necessary. 

servlet A [small] program that extends the functionality of a Web server by generating 
dynamic content and interacting with Web clients by using a request-response 
paradigm. 
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share path The network node under which one or more servers or objects reside. 

shop floor 
management 

A system that uses data from multiple system codes to help develop, execute, and 
manage work orders and rate schedules in the enterprise.  

silent mode A method for installing or running a program that does not require any user 
intervention. 

silent post A type of post that occurs in the background without the knowledge of the user. 

simulated cost After a cost rollup, the cost of an item, operation, or process according to the 
current cost scenario. This cost can be finalized by running the frozen update 
program. You can create simulated costs for a number of cost methods—for 
example, standard, future, and simulated current costs. See also cost rollup. 

single-byte character 
set (SBCS) 

An encoding scheme in which each alphabetic character is represented by one 
byte. Most Western languages, such as English, can be represented by using a 
single-byte character set. 

single-level tracking Finding all immediate parents where a specific lot has been used (consumed).  

single-voyage (spot) 
charter 

An agreement for a single voyage between two ports. The payment is made on the 
basis of tons of product delivered. The owner of the vessel is responsible for all 
expenses. 

slimer A script that changes data in a table directly without going through a regular 
database interface. 

smart field A data dictionary item with an attached business function for use in the Report 
Design Aid application. 

SOC The Italian term for a Swiss payment format that is accepted by Postfinance. 

soft commitment The number of items that is reserved for sales orders or work orders in the 
primary units of measure. 

soft error An error from which an operating system or program is able to recover. 

software action 
request (SAR) 

An entry in the AS/400 database that is used for requesting modifications to 
PeopleSoft software. 

SOG The French term for a Swiss payment format that is accepted by Postfinance. 

source directory The path code to the business function source files belonging to the shared library 
that is created on the enterprise server. 

special period/year The date that determines the source balances for an allocation. 

specification merge The Specification merge is comprised of three merges:  

Object Librarian merge (via the Object Management Workbench). 

Versions List merge. 

Central Objects merge.  

The merges blend customer modifications with data that accompanies a new 
release. 

specification table 
merge workbench 

During the Installation Workbench process, Specification Table Merge 
Workbench runs the batch applications that update the specification tables. 
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specifications A complete description of an EnterpriseOne object. Each object has its own 
specification, or name, which is used to build applications. 

spot charter See single-voyage charter. 

spot rates An exchange rate that is entered at the transaction level. Spot rates are not used on 
transactions between two EMU member currencies because exchange rates are 
irrevocably fixed to the euro.  

stamp tax In Japan, a tax that is imposed on drafts payable, receipts over 30000 Japanese 
yen, and all contracts. The party that issues any of the above documents is 
responsible for this tax. 

standalone Operating or capable of operating independently of certain other components of a 
computer system. 

standard cost The expected, or target cost of an item, operation, or process. Standard costs 
represent only one cost method in the Product Costing system. You can also 
calculate, for example, future costs or current costs. However, the Manufacturing 
Accounting system uses only standard frozen costs. 

standard costing A costing method that uses cost units that are determined before production. For 
management control purposes, the system compares standard costs to actual costs 
and computes variances. 

subprocess A process that is triggered by and is part of a larger process, and that generally 
consists of activities. 

subscriber table The Subscriber table (F98DRSUB), which is stored on the Publisher Server with 
the Data Replication Publisher table (F98DRPUB), that identifies all of the 
subscriber machines for each published table. 

summary The presentation of data or information in a cumulative or totaled manner in 
which most of the details have been removed. Many systems offer forms and 
reports that summarize information which is stored in certain tables. Contrast with 
detail. 

super backflush To create backflush transactions for material, labor, or both, against a work order 
at predefined pay points in the routing. By doing so, you can relieve inventory 
and account for labor amounts at strategic points throughout the manufacturing 
process.  

supersession Specification that a new product is replacing an active product on a specified 
effective date. 

supplemental data Additional types of data for customers and suppliers. You can enter supplemental 
data for information such as notes, comments, plans, or other information that you 
want in a customer or supplier record. The system maintains this data in generic 
databases, separate from the standard master tables (Customer Master, Supplier 
Master, and Address Book Master). 

supplying location The location from which inventory is transferred once quantities of the item on 
the production line have been depleted. In kanban processing, the supplying 
location is the inventory location from which materials are transferred to the 
consuming location when the containers are replenished. 

system code A numeric or alphanumeric designation that identifies a specific system in 
EnterpriseOne software. 
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system function [In EnterpriseOne] A named set of pre-packaged, re-usable instructions that can 
be called from event rules. 

table access 
management (TAM) 

The EnterpriseOne component that handles the storage and retrieval of user 
defined data. TAM stores information such as data dictionary definitions; 
application and report specifications; event rules; table definitions; business 
function input parameters and library information; and data structure definitions 
for running applications, reports, and business functions. 

table conversion 
workbench 

During the Installation Workbench process, Table Conversion Workbench runs 
the table conversions that change the technical and application tables to the 
format for the new release of EnterpriseOne. It also updates the Table 
Conversions and Controls detail records to reflect completion. 

table design aid 
(TDA) 

An EnterpriseOne GUI tool for creating, modifying, copying, and printing 
database tables. 

table event rules Use table event rules to attach database triggers (or programs) that automatically 
run whenever an action occurs against the table. An action against a table is 
referred to as an event. When you create an EnterpriseOne database trigger, you 
must first determine which event will activate the trigger. Then, use Event Rules 
Design to create the trigger. Although EnterpriseOne allows event rules to be 
attached to application events, this functionality is application-specific. Table 
event rules provide embedded logic at the table level. 

table handle A pointer into a table that indicates a particular row. 

table space [In relational database management systems] An abstract collection of containers 
in which database objects are stored. 

task [In Solution Explorer and EnterpriseOne Menu] A user defined object that can 
initiate an activity, process, or procedure. 

task view A group of tasks in Solution Explorer or EnterpriseOne Menu that are arranged in 
a tree structure. 

termo de abertura In Brazil, opening terms for the transaction journal. 

termo de 
encerramento 

In Brazil, closing terms for the transaction journal. 

three-tier processing The task of entering, reviewing, approving, and posting batches of transactions. 

three-way voucher 
match 

The process of comparing receipt information to supplier’s invoices to create 
vouchers. In a three-way match, you use the receipt records, the purchase order, 
and the invoice to create vouchers. 

threshold percentage In Capital Asset Management, the percentage of a service interval that you define 
as the trigger for maintenance to be scheduled. For example, you might set up a 
service type to be scheduled every 100 hours with a threshold percentage of 90 
percent. When the equipment accumulates 90 hours, the system schedules the 
maintenance. 

throughput 
agreement 

A service agreement in which a business partner agrees to store and manage 
product for another business partner for a specified time period. The second 
partner actually owns the stock that is stored in the first partner’s depot, although 
the first partner monitors the stock level; suggests replenishments; and unloads, 
stores, and delivers product to the partner or its customers. The first partner 
charges a fee for storing and managing the product. 
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throughput 
reconciliation 

Reconcile confirmed sales figures in a given period with the measured 
throughput, based on the meter readings. This process is designed to catch 
discrepancies that are due to transactions not being entered, theft, faulty meters, or 
some combination of these factors. This reconciliation is the first stage. See also 
operational reconciliation. 

token [In Object Management Workbench] A flag that is associated with each object 
which indicates whether you can check out the object. 

tolerance range The amount by which the taxes that you enter manually can vary from the tax that 
is calculated by the system. 

TP monitor Transaction Processing monitor. A monitor that controls data transfer between 
local and remote terminals and the applications that originated them. TP monitors 
also protect data integrity in the distributed environment and can include 
programs that validate data and format terminal screens. 

tracing The act of researching a lot by going backward, to discover its origin. 

tracking The act of researching a lot by going forward, to discover where it is used. 

transaction set An electronic business transaction (EDI Standard document) composed of 
segments.  

transclude To include the external data in the displayed content through a linking 
mechanism. 

transfer order An order that is used to ship inventory between branch/plants within your 
company and to maintain an accurate on-hand inventory amount. An interbranch 
transfer order creates a purchase order for the shipping location and a sales order 
for the receiving location. 

translation 
adjustment account 

An optional G/L account used in currency balance restatement to record the total 
adjustments at a company level. 

translator software The software that converts data from an application table format to an EDI 
Standard Format, and from EDI Standard Format to application table format. The 
data is exchanged in an EDI Standard, such as ANSI ASC X12, EDIFACT, UCS, 
or WINS. 

tree structure A type of graphical user interface that displays objects in a hierarchy. 

trigger Allows you to attach default processing to a data item in the data dictionary. 
When that data item is used on an application or report, the trigger is invoked by 
an event which is associated with the data item. EnterpriseOne also has three 
visual assist triggers:  

Calculator. 

Calendar.  

Search form. 

two-way voucher 
match 

The process of comparing purchase order detail lines to the suppliers’ invoices to 
create vouchers. You do not record receipt information. 

universal batch 
engine (UBE) 

[In EnterpriseOne] A type of application that runs a noninteractive process. 

unnormalized Data that is a random collection of data elements with repeating record groups 
scattered throughout. Also see Normalized. 
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user overrides merge The User Overrides merge adds new user override records into a customer’s user 
override table. 

user-defined code 
(UDC) 

A value that a user has assigned as being a valid entry for a given or specific field. 

utility A small program that provides an addition to the capabilities which are provided 
by an operating system. 

variable numerator 
allocations 

A procedure that allocates or distributes expenses, budgets, adjustments, and so 
on, among business units, based on a variable. 

variable quantity A term that indicates the bill of material relationship between a parent item and its 
components or ingredients. When a bill of material component has a variable 
quantity relationship to its parent, the amount of the component changes when the 
software calculates parts list requirements for different work order quantities. 
Contrast with fixed quantity. 

variance 1. In Product Costing and Manufacturing Accounting, the difference between the 
frozen standard cost, the current cost, the planned cost, and the actual cost. For 
example, the difference between the frozen standard cost and the current cost is 
an engineering variance. Frozen standard costs come from the Cost Components 
table, and the current costs are calculated by using the current bill of material, 
routing, and overhead rates.  

2. In Capital Asset Management, the difference between revenue that is generated 
by a piece of equipment and costs that are incurred by the equipment. 

versions list merge The Versions List merge preserves any non-XJDE and non-ZJDE version 
specifications for objects that are valid in the new release as well as their 
processing options data. 

VESR Verfahren Einzahlungsschein mit Referenznummer. The processing of an ESR 
pay slip with reference line through accounts receivable and accounts payable. 

visual assist Forms that can be invoked from a control to assist the user in determining what 
data belongs in the control. 

voucher logging The process of entering vouchers without distributing amounts to specific G/L 
accounts. The system initially distributes the total amount of each voucher to a 
G/L suspense account, where it is held until you redistribute it to the correct G/L 
account. 

wareki date format In Japan, a calendar format, such as Showa or Heisei. When a new emperor 
begins to reign, the government chooses the title of the date format and the year 
starts over at one. For instance, January 1, 1998, is equal to Heisei 10, January 
1st. 

wash down A minor cleanup between similar product runs. Sometimes used in reference to 
the sanitation process of a food plant. 

wchar_t An internal type of a wide character. Used for writing portable programs for 
international markets. 

web server A server that sends information as requested by a browser and uses the TCP/IP set 
of protocols. 

work order life cycle In Capital Asset Management, the sequence of events through which a work order 
must pass to accurately communicate the progress of the maintenance tasks that it 
represents. 
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workfile A system-generated file that is used for temporary data processing. 

workflow According to the Workflow Management Coalition, worlflow means “the 
automation of a business process, in whole or part, during which documents, 
information, or tasks are passed from one participant to another for action, 
according to a set of procedural rules.”  

workgroup server A network server usually containing subsets of data that are replicated from a 
master network server. 

WorldSoftware 
architecture 

The broad spectrum of application design and programming technology that 
PeopleSoft uses to achieve uniformity, consistency, and complete integration 
throughout its software. 

write payment A step in processing payments. Writing payments includes printing checks, drafts, 
and creating a bank tape table. 

write-off A method for getting rid of inconsequential differences between amounts. For 
example, you can apply a receipt to an invoice and write off the difference. You 
can write off both overpayments and underpayments. 

Z file For store and forward (network disconnected) user, EnterpriseOne store-and-
forward applications perform edits on static data and other critical information 
that must be valid to process an order. After the initial edits are complete, 
EnterpriseOne stores the transactions in work tables on the workstation. These 
work table are called Z files. When a network connection is established, Z files 
are uploaded to the enterprise server; and the transactions are edited again by a 
master business function. The master business function then updates the records 
in your transaction files. 

z-process A process that converts inbound data from an external system into an 
EnterpriseOne software table or converts outbound data into an interface table for 
an external system to access. 

zusammenfassende 
melding 

In Germany, the term for the EU Sales Listing. 
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